Thank You for Choosing Ross

You've made a great choice. We expect you will be very happy with your purchase of Ross Technology. Our mission is to:

1. Provide a Superior Customer Experience  
   • offer the best product quality and support
2. Make Cool Practical Technology  
   • develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and empowers our employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to us at solutions@rossvideo.com.

David Ross  
CEO, Ross Video  
dross@rossvideo.com

Ross Video Code of Ethics

Any company is the sum total of the people that make things happen. At Ross, our employees are a special group. Our employees truly care about doing a great job and delivering a high quality customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our behavior:

1. We will always act in our customers' best interest.
2. We will do our best to understand our customers' requirements.
3. We will not ship crap.
4. We will be great to work with.
5. We will do something extra for our customers, as an apology, when something big goes wrong and it's our fault.
6. We will keep our promises.
7. We will treat the competition with respect.
8. We will cooperate with and help other friendly companies.
9. We will go above and beyond in times of crisis. *If there’s no one to authorize the required action in times of company or customer crisis - do what you know in your heart is right. (You may rent helicopters if necessary.)*
XPression · User Guide

- Ross Part Number: 3500DR-001-5.5
- Software Issue: 5.5

The information contained in this Guide is subject to change without notice or obligation.

Copyright

©2014 Ross Video Limited, Ross®, and any related marks are trademarks or registered trademarks of Ross Video Limited. All other trademarks are the property of their respective companies. PATENTS ISSUED and PENDING. All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, mechanical, photocopying, recording or otherwise, without the prior written permission of Ross Video. While every precaution has been taken in the preparation of this document, Ross Video assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting from the use of the information contained herein.

Patents

Patent numbers 4,205,346; 5,115,314; 5,280,346; 5,561,404; 7,034,886; 7,508,455; 7,602,446; 7,834,886; 7,914,332; 8307284, 2039277; 1237518; 1127289 and other patents pending.

Notice

The material in this manual is furnished for informational use only. It is subject to change without notice and should not be construed as commitment by Ross Video Limited. Ross Video Limited assumes no responsibility or liability for errors or inaccuracies that may appear in this manual.
Important Regulatory and Safety Notices to Service Personnel

Before using this product and any associated equipment, read all the Important Safety Instructions listed below so as to avoid personal injury and to prevent product damage.

Products may require specific equipment, and /or installation procedures be carried out to satisfy certain regulatory compliance requirements. Notices have been included in this publication to call attention to these Specific requirements.

Symbol Meanings

**Protective Earth** — This symbol identifies a Protective Earth (PE) terminal, which is provided for connection of the supply system’s protective earth (green or green/yellow) conductor.

The exclamation point within an equilateral triangle is intended to alert the user to the presence of important operating and maintenance (servicing) instructions in the literature accompanying the product. Failure to heed this information may present a risk of damage or injury to persons or equipment.

**Warning** — The symbol with the word "Warning" within the equipment manual indicates a potentially hazardous situation, which if not avoided, could result in death or serious injury.

**Caution** — The symbol with the word "Caution" within the equipment manual indicates a potentially hazardous situation, which if not avoided, may result in minor or moderate injury. It may also be used to alert against unsafe practices.

**Notice** — The symbol with the word "Notice" within the equipment manual indicates a situation, which if not avoided, may result in major or minor equipment damage or a situation, which could place the equipment in a non-compliant operating state.

**Warning Hazardous Voltages** — The lightning flash with arrowhead symbol within an equilateral triangle is intended to alert the user to the presence of uninsulated "dangerous voltage" within the product's enclosure that may be of sufficient magnitude to constitute a risk of shock to persons.

**ESD Susceptibility** — This symbol is used to alert the user that an electrical or electronic device or assembly is susceptible to damage from an ESD event.
Important Safety Instructions

1) Read these instructions.
2) Follow all instructions and heed all warning.
3) Refer all servicing to qualified service personnel.
4) The equipment's AC appliance inlets are the means to disconnect the product from the AC Mains and must remain readily operable for this purpose.
5) Parts of the equipment's power supplies can still present a safety hazard even when the product is in the "OFF" state. To avoid the risk of electrical shock and to completely disconnect the apparatus from the AC Mains, remove all power supply cords from the product's AC appliance inlets prior to servicing.
6) The product chassis is to be rack mounted only. To ensure safe operation and maintain long-term system reliability, proper installation requires that the front and back area of the chassis remain clear of obstructions so as not to restrict airflow.

**Warning**
7) Indoor Use: To reduce the risk of fire or electric shock, do not expose this apparatus to rain or moisture.

**Warning**
8) This apparatus when equipped with multiple power supplies can generate high leakage currents. To reduce the risk of electric shock to operator and service personnel the following requirements must be met:
   a) The equipment is to be installed in a restricted access area.
      A restricted access area is one where access can only be gained by SERVICE PERSONS or by USERS who have been instructed about the reasons for the restrictions applied to the location and about any precautions that shall be taken; and access is through the use of a TOOL or lock and key, or other means of security, and is controlled by the authority responsible for the location
   b) the building installation shall provide a means for connection to protective earth and;
   c) the product's protective earth terminal is connect to facility's protective earth using a 1.5mm2 (14AWG) conductor and a #8 1.5mm2 ring terminal and;
   d) a SERVICE PERSON shall check whether or not the socket-outlet from which the equipment is to be powered provides a connection to the building protective earth.

**Caution**
9) This apparatus contains a Lithium battery, which if replaced incorrectly, or with an incorrect type, may cause an explosion. Replace only with the same type recommended by the manufacturer. Dispose of used batteries according to the manufacturer's instruction by qualified service personnel.

EMC Notices

**US**

**FCC Part 15**

This equipment has been tested and found to comply with the limits for a class A Digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a Commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

**Notice** Changes or modifications to this equipment not expressly approved by Ross Video Ltd. could void the user’s authority to operate this equipment.
CANADA

This Class “A” digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe “A” est conforme à la norme NMB-003 du Canada.

EUROPE

This equipment is in compliance with the essential requirements and other relevant provisions of CE Directive 93/68/EEC.

INTERNATIONAL

This equipment has been tested to CISPR 22:1997 along with amendments A1:2000 and A2:2002 and found to comply with the limits for a Class A Digital device.

Notice

This is a Class A product. In domestic environments, this product may cause radio interference, in which case the user may have to take adequate measures.

Warranty and Repair Policy

Ross Video Limited (Ross) warrants its XPression systems to be free from defects under normal use and service for the following time periods from the date of shipment:

- **XPression Server** — 12 months
- **XPression Software Upgrades** — 12 months free of charge
- **System and Media hard drives** — 12 months

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages (including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

Extended Warranty

For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the standard warranty period by one year increments. For more information about an extended warranty for your XPression system, contact your regional sales manager.
Environmental Information

The equipment that you purchased required the extraction and use of natural resources for its production. It may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste administration.

You can also contact Ross Video for more information on the environmental performances of our products.

Company Address

<table>
<thead>
<tr>
<th>Ross Video Limited</th>
<th>Ross Video Incorporated</th>
<th>Ross Video Europe</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 John Street</td>
<td>P.O. Box 880</td>
<td>Sumatralaan 45</td>
</tr>
<tr>
<td>Iroquois, Ontario</td>
<td>Ogdensburg, New York</td>
<td>Gateway D</td>
</tr>
<tr>
<td>Canada, K0E 1K0</td>
<td>USA 13669-0880</td>
<td>Hilversum, Noord-Holland 1217 GP</td>
</tr>
</tbody>
</table>

General Business Office: (+1) 613 • 652 • 4886

Fax: (+1) 613 • 652 • 4425

Technical Support: (+1) 613 • 652 • 4886

After Hours Emergency: (+1) 613 • 349 • 0006

E-mail for Technical Support: techsupport@rossvideo.com

E-mail for General Information: solutions@rossvideo.com

Website: http://www.rossvideo.com
Contents

Introduction 1
About This Guide1-1
Documentation Conventions1-1
Getting Help1-1
Contacting Technical Support1-2

User Interface Overview 2
The Layout Interface2-2
The Sequencer Interface2-3

System Setup 3
Set Preferences3-2
Configure an AJA Video FrameBuffer3-13
Configure a Black Magic Design FrameBuffer3-17
Configure a Matrox FrameBuffer3-20
Configure an XPression AVI Recorder3-23
Configure an XPression RossLinq Connector3-25
Configure the XPression Tile Mapper3-27
Configure an XPression Virtual Input3-29
Configure an XPression Virtual Output3-30
Change the Order of Video Inputs / Outputs3-32
Delete a Video Input / Output3-33
Configure an Audio Device3-34
Delete an Audio Device3-36
Configure Video Preview and Audio Monitor3-37
Configure RS232 CTS/DSR GPI for Contact Closures3-38
Configure a 25-Pin GPIO Port3-40
Configure Smart GPI / RossTalk3-42
Configure PBus Interface3-44
Configure Camera Tracking3-46

Scenes 4
Create a Project4-2
Create a Scene4-4
Create a Custom Size Scene4-6
Duplicate a Scene4-8
Delete a Scene4-10
Create a Scene Group4-11
Duplicate a Scene Group4-13
Delete a Scene Group4-15
Create a Roll/Crawl from a Scene Group4-16
Customize a Scene Group Roll/Crawl4-19

Base Objects 5
Create a Text Object5-2
Use Tabs in a Text Object5-4
Align Text Objects to Build a Table5-6
Apply a Material to a Text Object5-10
Apply Word Wrap to a Text Object5-12
Create a Background Object5-14

Mesh Objects 6
Import a 3D or OBJ Model into a Scene6-2

Primitives 7
Create a Quad Object7-2
Create a Sphere Object7-5
Create a Cube Object7-8
Set the Culling Mode for a Cube Object7-11
Create a Cylinder Object7-12
Create a Torus Object7-15

Lights 8
Add a Directional Light Source to a Scene8-2
Add a Point Light Source to a Scene8-4
Add a Spot Light Source to a Scene8-7

Cameras 9
Add a Perspective Camera to a Scene9-2
Add an Orthographic Camera to a Scene9-5

Layers 10
Add a Layer Object to a Scene10-2
Add a Camera Layer Object to a Scene10-4

Markers 11
Add an Event Marker to a Scene11-2

Miscellaneous Objects 12
Group Scene Objects12-2
Position an Object12-3
Publish Template Links12-5

Materials 13
Create a Texture Material13-2
Create a Video Material13-4
Create a Live Source Material13-7
Create a Window Capture Material13-9

Fonts 14
Add a Private Font to a Project14-2
Apply a Material to a Font14-4

Animations 15
Add Continuous Animation to an Object15-2
Add Keyframe Animation to an Object15-5
Trigger Clips and Audio15-7
Create Animation with Multiple Controllers15-9
Copy Keyframes to Animate an Object15-11
Copy and Paste Animation Controllers15-15

Stagger Animations 16
Add Stagger Animation to a Text or Group Object 16-2

Widgets 17
Add a Realtime Clock Display to a Scene17-2
Customize the Time Format of a Widget17-4
Rename a Widget17-6
Add a Timer Display to a Scene17-7
Add a Counter Display to a Scene17-11
Customize the Counter Format of a Widget17-13
Add a Text List to a Scene17-16

Effects 18
Add an Effect or Transition to an Object or Scene 18-2

DataLinq™ 19
Start the DataLinq Server19-2
Connect XPression to a DataLinq Server19-13
Link a Text Object to a DataLinq Data Source19-14
Link a Quad Object to a DataLinq Source19-16
Link a Cube Object to a DataLinq Source19-18
Using DataLinq Keys with an ADODB DataLinq 19-20
Using DataLinq Keys with an XML DataLinq19-23
Using SQL Queries19-26
Using a Macro with a DataLinq Key19-29
Create a Data Page19-31

Sequences 20
Create a Sequence20-2
Modify Template Content20-3
Control Sequence Playout20-6
Playout a Sequence in Manual Mode20-8
Playout a Sequence in Automatic Mode20-9
Create a Roll/Crawl from a Take Item Group20-11
Customize a Take Item Group Roll/Crawl20-13

Output 21
Preview Output in a Virtual Output21-2
Render Output to an AVI File21-3

Project Server 22
Setup Project Server22-2
Publish a Project to Project Server22-3
Deploy a Project from Project Server22-7

Keyboard and GPI Mapping 23
Create a Custom Keyboard Map23-2
Assign a Project Shortcut23-3
Assign a Global Shortcut23-4
Assign a Local Shortcut23-8
Create a Custom GPI Map23-9
Use the Quick Menu23-12

Project Manager 24
Create a Category24-2
Add a Scene or Scene Group to a Category24-3
Delete a Category24-5
Open Multiple Projects in the Project Manager24-6
Activate a Project from a Project Group24-7
Remove a Project from a Project Group24-8

Appendix A: Keyboard Shortcuts A
Menu ShortcutsA-2
Toolbar ShortcutsA-2
Scene Manager ShortcutsA-2
Object Manager ShortcutsA-3
Text Objects ShortcutsA-3
Keyframe Editor ShortcutsA-5
Sequencer ShortcutsA-5
Material Manager ShortcutsA-6
Introduction

XPRESSion is a full featured broadcast graphics application with the necessary tools to create stunning graphics and animations that will meet the requirements set by today's graphics and animation designers.

About This Guide

This user guide describes the two main sections of XPRESSion: an editor section and a sequencer section. The toolbar contains two buttons to switch between these sections. The layout section serves to create scenes with graphics and animations. The sequence section serves to set scenes in a sequence list and to play out the scenes. Both sections contain a number of dockable and non-dockable windows; to be used in the process of creating scenes, templates, and animations.

If, at any time, you have a question pertaining to the installation or operation of XPRESSion, please contact us at the numbers listed in the section “Contacting Technical Support” on page 1–2. Our technical staff are always available for consultation, training or service.

For More Information on...

• XPRESSion system hardware, refer to the Maintenance Guide.

Documentation Conventions

Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a sequence of menus and submenus that must be followed to reach a particular command.

**Bold text**

Bold text is used to identify a user interface element such as a dialog box, menu item, or button.

For example:
In the **3D Model Files** section, use the **Mode** list to select the folder used to store 3D model files.

**Courier text**

Courier text is used to identify text that a user must enter.

For example:

Enter **localhost** when the DataLinq server is running of the same computer as XPRESSion.

> Menu arrows are used in procedures to identify a sequence of menu items that you must follow.

For example, if a step reads “**Display > Widgets**,” you would click the **Display** menu and then click **Widgets**.

Getting Help

The XPRESSion Online Help system is accessed by selecting **Help Topics** from the **Help** menu in any component of XPRESSion. Online Help opens in a Help Viewer window.

The Online Help system contains the following navigation tabs to locate information contained in Online Help topics and the **User Guide**:

• **Contents** — table of contents
• **Index** — keyword reference
• **Search** — full text search
• **Favorites** — preferred information storage and access
The XPression Online Help system displays, by default, the Contents pane. To access the Index or Search panes, click the Index or Search button on the top toolbar in the Online Help system.

The XPression Maintenance Guide and XPression User Guide are also supplied as print-ready PDF files. Locate the guides in the C:\Archive folder to open a guide PDF in Adobe® Reader® for viewing or printing.

Contacting Technical Support

At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as the nearest telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. After-sales service and technical support is provided directly by Ross Video personnel. During business hours (eastern time), technical support personnel are available by telephone any time. After hours and on weekends, a direct emergency technical support phone line is available. If the technical support person who is on call does not answer this line immediately, a voice message can be left and the call will be returned shortly. This team of highly trained staff is available to react to any problem and to do whatever is necessary to ensure customer satisfaction.

- Technical Support: (+1) 613-652-4886
- After Hours Emergency: (+1) 613-349-0006
- E-mail: techsupport@rossvideo.com
- Website: http://www.rossvideo.com
User Interface Overview

The XPression interface is made up of two sections: a layout section, and a sequencer section. Both sections contain specific windows, as well as common windows. The layout section is the interface used to create and edit graphics and animations. The sequencer section is used to output graphics and animations placed on a sequence list.

The following topics are discussed in this section:

• The Layout Interface
• The Sequencer Interface
The Layout Interface

The following screen capture displays the main elements of the XPression Layout section user interface. Descriptions of individual elements are contained in the legend below the diagram.

1) **Menu Bar** — use this menu bar to access the File, Edit, Windows, Projects, Animation, Display, Tools, and Help menus.

2) **Toolbar** — use this toolbar to quickly access XPression tools.

3) **Position** — this section displays various position values related to the Main viewport.

4) **Project Manager** — use this window to view and manage the projects and project groups.

5) **Scene Manager** — use this window to view and manage the scenes and scene groups contained in a project.

6) **Main Viewport** — use this window as an editor to design scenes using objects from the Object Library.

7) **Material Manager** — use this window to view, apply, and manage the materials in a project.

8) **Object Library** — use this window to select the objects with which to build scenes.

9) **Scene Director** — use this window to create and manage tracks for animation controllers and audio files.

10) **Output Monitors** — use this window to select the output framebuffer. Each output framebuffer contains an infinite number of layers, and each layer can contain a scene. The hierarchical order for scene visibility runs from +# to -#, with positive layers being the top layers and negative layers being the lower layers.

11) **Object Manager** — use this window to view and manage the objects contained in a scene.

12) **Object Inspector** — use this window to edit the properties of a selected object. The tabs displayed in this window depend on the type of object selected.

13) **Animation Controller** — use the controller in this window to playback individual animations.
The Sequencer Interface

The following screen capture displays the main elements of the XPression Sequence section user interface. Descriptions of individual elements are contained in the legend below the diagram.

1) **Menu Bar** — use this menu bar to access the File, Edit, Windows, Projects, Animation, Display, Tools, and Help menus.

2) **Toolbar** — use this toolbar to quickly access XPression tools.

3) **Position** — this section displays various position values related to the Main viewport.

4) **Project Manager** — use this window to view and manage the projects and project groups.

5) **Scene Manager** — use this window to view and manage the scenes and scene groups contained in a project.

6) **Sequencer** — use this window to view and control a list of scenes or scene groups to be played in the order from top to bottom. A list is built by adding scenes from the Scene Manager.

7) **Sequencer Playlist** — use this window to view a list of all scenes and/or scene groups in the sequencer.

8) **Output Monitors** — use this window to select the output framebuffer. Each output framebuffer contains an infinite number of layers, and each layer can contain a scene. The hierarchical order for scene visibility runs from +# to -#, with positive layers being the top layers and negative layers being the lower layers.

9) **Take Inspector** — use this window to edit the properties of a selected group or take item.

10) **Preview** — use this window to preview a selected take item from the sequencer.
System Setup

Before you start using XPression to create projects, XPression needs to be configured for your environment. In addition to describing how to set preferences for XPression, this section also describes how to configure GPIs, video framebuffers, audio devices, video preview, and audio monitor.

The following topics are discussed in this section:

- Set Preferences
- Configure an AJA Video FrameBuffer
- Configure a Black Magic Design FrameBuffer
- Configure a Matrox FrameBuffer
- Configure an XPression AVI Recorder
- Configure an XPression RossLinq Connector
- Configure the XPression Tile Mapper
- Configure an XPression Virtual Input
- Configure an XPression Virtual Output
- Change the Order of Video Inputs / Outputs
- Delete a Video Input / Output
- Configure an Audio Device
- Delete an Audio Device
- Configure Video Preview and Audio Monitor
- Configure a 25-Pin GPIO Port
- Configure RS232 CTS/DSR GPI for Contact Closures
- Configure Smart GPI / RossTalk
- Configure PBus Interface
Set Preferences

1. In XPRESSion, use the Edit menu to select Preferences.
   The Preferences dialog box opens.

2. Click the Editor panel to set project preferences for the Editor section of XPRESSion.

   ![Preferences dialog box]

   a. In the On Startup section, select the Load Most Recent Project check box to automatically load the last opened project after starting XPRESSion.

   b. In the On Startup section, select the Switch To Sequencer Mode check box to automatically display the Sequencer layout after starting XPRESSion.

   c. In the Confirmation section, select the On Object Deletion check box to display a Confirmation dialog box and request confirmation when deleting an object from a project.

   d. In the Confirmation section, select the On Object Has Children check box to display a Confirmation dialog box and request confirmation when child objects belong to the object selected for deletion.

   e. In the Settings section, use the Default Animation Controller Length box to enter or select the default frame length of the animation controller.

   f. In the Settings section, use the Default Text Object Rendering Priority list to set the default rendering priority for text objects. The available options are as follows:

      • Normal — new text objects display in front of other objects.
      • Text On Top — text objects always display in front of other objects.

   ✴ Deleting an object also deletes any related child objects.
3. Click the **Hardware Renderer** panel to select the graphics device used by XPression to render scenes to output framebuffers.

   ![Hardware Renderer Panel]

   **a.** Use the **Adapter** list to select the graphics device installed in the XPression computer.

   **b.** Use the **Anti-Alias** list to select the Multi-sampling value used to control the visual quality of rendered output.

   The higher the multi-sampling value, the smoother the rendered graphic edges. The <none> option is equal to 1x multi-sampling. For most situations, set the multi-sampling value according to the best quality/performance ratio, usually around 8x.

4. Click the **Viewports** panel to set the visual quality of scenes rendered to XPression viewports.

   ![Viewports Panel]

   **a.** Select the **Render Using Anti-Alias** check box to use the multi-sampling value selected from the **Anti-Alias** list in the **Hardware Renderer** panel to control the visual quality of scenes rendered to viewports. The higher the Multi-sampling value, the smoother graphic edges are rendered in a viewport.

   This check box is only available when the multi-sampling value set in the Hardware Renderer panel is higher than <none>. 
5. Click the **Path Persistence** panel to set the folder locations used by XPression to search for and store XPression resources and files.

   ![Path Persistence Panel]

   - **a.** In the **Project Files** section, use the **Mode** list to select the folder to open after selecting **Open** from the File menu. The available options are as follows:
     - **Last Used** — open the folder last used to save an XPression project file.
     - **Fixed** — open the folder specified in **Fixed** box.
       Enter the full path to the project folder in the **Fixed** box, or click **Browse (...)** to the right of the box to use the **Browse for Folder** dialog box to select the project folder.

   - **b.** In the **Image Files** section, use the **Mode** list to select the folder used to store image files. The available options are as follows:
     - **Project | Last Used** — first search for image files in the folder set as the project folder, and if no image files are found, then look in the folder lasted used by XPression.
     - **Last Used** — search for image files in the folder that was last used by XPression.
     - **Fixed** — search for image files in the folder specified in **Fixed** box.
       Enter the full path to the image folder in the **Fixed** box, or click **Browse (...)** to the right of the box to use the **Browse for Folder** dialog box to select the image folder.

   - **c.** In the **Video Files** section, use the **Mode** list to select the folder used to store video files. The available options are as follows:
     - **Project | Last Used** — first search for video files in the folder set as the project folder, and if no video files are found, then look in the folder lasted used by XPression.
     - **Last Used** — search for video files in the folder that was last used by XPression.
     - **Fixed** — search for video files in specified in **Fixed** box.
       Enter the full path to the video folder in the **Fixed** box, or click **Browse (...)** to the right of the box to use the **Browse for Folder** dialog box to select the video folder.

   - **d.** In the **Audio Files** section, use the **Mode** list to select the folder used to store audio files. The available options are as follows:
     - **Project | Last Used** — first search for audio files in the folder set as the project folder, and if no audio files are found, then look in the folder last used by XPression.
     - **Last Used** — search for audio files in the folder that was last used by XPression.
• **Fixed** — open the folder specified in **Fixed** box.
  Enter the full path to the audio folder in the **Fixed** box, or click **Browse (...)** to the right of the box to use the **Browse for Folder** dialog box to select the audio folder.

• **Project** — always return to the project folder for audio files.

e. In the **3D Model Files** section, use the **Mode** list to select the folder used to store 3D model files. The available options are as follows:
  - **Project | Last Used** — first search for 3D model files in the folder set as the project folder, and if no 3D model files are found, then look in the folder last used by XPression.
  - **Last Used** — search for 3D model files in the folder that was last used by XPression.
  - **Fixed** — open the folder specified in **Fixed** box.

  Enter the full path to the 3D model folder in the **Fixed** box, or click **Browse (...)** to the right of the box to use the **Browse for Folder** dialog box to select the 3D model folder.

  - **Project** — always return to the project folder for 3D model files.

6. Click the **Folders** panel to set the folder used by XPression to store files created by the Input Grabber.

   ![Folders panel]

6. Enter the full path to the folder in which to save files created using the Input Grabber in the **Path** box, or click **Browse (...)** to the right of the box to use the **Browse for Folder** dialog box to select the grab folder.

7. Click the **In Memory Cache** panel to set the folder locations used by XPression to store cache files in memory.

   ![In Memory Cache panel]
a. In the **Texture & Image Cache** section, select the **Limit allocated memory pool to** check box to limit the total size of texture and image files stored in the cache folder.

Use the **MB** box to enter or select the size limit in MB for the total of all the cache files stored in the cache folder.

Use the **Items** box to enter or select the size limit according to item amount in case of a high count of small images and/or textures.

b. Select the **Start caching on project load** check box to start caching texture and image files when a project starts loading.

8. Click the **On Disk Cache** panel to set the folder locations used by XPression to store cache files on disk.

![On Disk Cache panel](image)

a. In the **Shader Objects** section, use the **Path** box to enter the full path to the folder in which to cache shader object files or click **Browse (...)** to the right of the box to use the **Browse for Folder** dialog box to select the cache folder.

b. In the **Max Size** box, enter or select the size limit in MB for the total of all the cache files stored in the cache folder.

c. In the **MipMap Objects** section, use the **Path** box to enter the full path to the folder in which to cache MipMap object files or click **Browse (...)** to the right of the box to use the **Browse for Folder** dialog box to select the cache folder.

d. Select the **Limit Size** check box to limit the total size of MipMap object files stored in the cache folder.

In the **Max Size** box, enter or select the size limit in MB for the total of all the cache files stored in the cache folder.

e. In the **Script Engine** section, use the **Path** box to enter the full path to the folder in which to cache script engine files or click **Browse (...)** to the right of the box to use the **Browse for Folder** dialog box to select the cache folder.

f. In the **Max Size** box, enter or select the size limit in MB for the total of all the cache files stored in the cache folder.
9. Click the **Sequencer** panel to control sequence lists.

   ![Sequencer panel]

   a. In the **Take Item List** section, select the **Loop at end** check box to automatically loop a sequence list when the end is reached manually.

   b. Select the **Center online in view** check box to position the active scene in a sequence list in the middle of the view, provided the sequence list extends the size of the view.

   c. Select the **Enable sorting by clicking column headers** check box to sort the information in the columns of the sequencer by heading.

   d. Select the **Assign new Take IDs starting from the Scene’s ID** check box to assign newly created take items an ID starting from the ID of the template scene.

   e. In the **Fast Recall** section, select the **Fast Recall enabled on startup** check box to automatically enable fast recall in the sequencer on startup.

   f. Select the **Disable Fast Recall Input Timeout** check box to turn off the user entered input timeout for Take IDs in the sequencer.

   g. Select the **Expand sequence groups when selecting an item with Fast Recall** check box to expand the parent group of an item when it is selected using Fast Recall.

   h. In the **Pauses** section, select the **Pause events can be resumed before they have been reached** check box to resume play of pause events before the take item has reached the pause.

   i. Select the **Don’t move to the next take item until all pause events are taken** check box to play all pause events before moving to the next take item in the sequencer.

   j. In the **Advanced** section, select the **Disable thumbnail rendering for take items created by automation** check box to disable displaying scene thumbnails in the Sequencer Playlist.

   k. Select the **Save MOS created items to the project** check box to save MOS items in the sequencer.
10. Click the XML Take Item List panel to configure the path and settings for XML Take Items.

![XML Take Item List Panel]

a. In the XML Take Item List Watch Folder section, select the Enabled check box to use XML Take Items from a folder.

b. Select the Delete source file after parsing check box to delete XML Take Items after they are parsed from the selected folder.

c. Enter the full path to the folder in the Folder box, or click Browse (...) to the right of the box to use the Browse for Folder dialog box to select the folder.

d. In the XML Take Item List Importer section, select the Allow deletion of online items check box to enable the removal of take items that are currently active on an output.

e. Use the After import sort items on list to sort the imported take items. The available options are as follows:
   • <do not sort> — do not sort the take items.
   • take item id — sort the take items by ID.
   • take item state — sort the take items by state.
   • take item scene name — sort the take items by scene name.
   • take item name — sort the take items by name.
   • take item layer — sort the take items by layer.
   • take item framebuffer — sort the take items by framebuffer.

f. Select the Include groups when sorting check box to import the XML Take Items according to the groups that the items have been assigned.
11. Click the **Fonts** panel to control gamma correction, sharpness correction, and anti-aliasing for fonts.

   ![Font Panel](image)

   a. Select the **Gamma Correction** check box to apply gamma correction when changing the font factor.

   Gamma correction influences the degree of transparency used to anti-alias font edge steps. Changes to this factor are visible after re-rendering characters (e.g. changing font size).

   b. In the **Factor** box, enter or select the gamma correction value.

   c. Select the **Sharpness Correction** check box to apply sharpness correction when changing the font sharpness level.

   The sharpness correction value influences the degree of the combination between the resolution and acutance of the font. Changes to this factor are visible after re-rendering characters (e.g. changing font size).

   d. In the **Level** box, enter or select the sharpness correction level.

   e. In the **Anti-Aliasing** section, use the **Steps** list to select the anti-alias size step to use when rendering fonts.

   An anti-alias step size of 256 is the recommended setting.

12. Click the **Remote Server** panel to configure the TCP server and the CII settings.

   ![Remote Server Panel](image)

   a. In the **TCP Server** section, enter or select the port number for the remote server.

   b. In the **CII Page Recall** section, select the **Use Unique Gateway ID instead of Take Item ID** check box to recall CII pages using a Unique Gateway ID.
c. In the CII section, select the **Create All Take Items in Group** check box to create the CII Take Items in a specific group.

d. Enter a group name for the CII Take Items in the **Group Name** box.

e. Use the **After create sort items by** list to sort the imported take items. The available options are as follows:
   - **<do not sort>** — do not sort the take items.
   - **take item id** — sort the take items by ID.
   - **take item state** — sort the take items by state.
   - **take item scene name** — sort the take items by scene name.
   - **take item name** — sort the take items by name.
   - **take item layer** — sort the take items by layer.
   - **take item framebuffer** — sort the take items by framebuffer.

f. Select the **Set Take Items Offline when Overwritten** check box to take the original take item offline when it is overwritten.

g. Select the **Move Sequencer Focus to Recalled Item** check box to move the sequencer focus to a recalled graphic when the graphic is recalled through CII.

h. In the **Automation** section, select the **Show Automation Properties** check box to display the **Automation** tab in the Object Inspector when a scene or scene group is selected in the Object Manager.

13. Click the **Video Engine** panel to configure the cache size and select the CPU core of the video clients.

![Video Engine Panel](image)

a. In the **Maximum Cache Size Per Video Client** section, enter or select the maximum cache size in MB per video client.

b. In the **Video Decoder Engine CPU Affinity** section, select the CPU core of the video client.
14. Click the OpenMAM panel to configure the cache settings for items retrieved from remote asset management systems.

![OpenMAM panel](image)

- In the Local Cache Settings section, enter the full path to the folder in the Path box, or click Browse (...) to the right of the box to use the Browse for Folder dialog box to select the folder.
- In the Max Size box, enter or select the maximum size limit in MB for the total of all the cache files stored in the cache folder.

15. Click the Advanced panel to manage screen settings.

![Advanced panel](image)

- In the XPression Process section, use the Priority list to select the CPU usage priority for XPression. The available CPU usage priorities are as follows:
  - Normal — evenly distribute the CPU time between system processes with the similar priority.
  - High — give XPression preference and allocate the majority of the CPU time to XPression.
  - Real-Time — allocate all CPU time to XPression.

  Use the Real-Time CPU usage priority with caution, as this priority may cause other applications running on the XPression computer to freeze.

- Select the Allow Monitor Power Saving check box to allow the monitor to run into sleep mode.
- Select the Allow Screen Saver check box to allow the screen saver to run. A screen saver may compromise output performance. For maximum performance, clear this check box to stop the screen saver from running on the XPression computer.
d. Select the **Disable Initialization of Human Interface Devices** check box to ignore a 3Dconnexion 3D mouse connected to an XPression system.

e. Use the **Override User Locale** list to select a place to override the local settings.

f. Select the **Use Right To Left Reading Order** check box to default certain XPression components to right-to-left mode for Arabic language users.

g. Select the **Enable EUDC Character Lookups** check box to enable end user defined character lookups.

16. Click **OK**.

   The **Preferences** dialog box closes.
Configure an AJA Video FrameBuffer

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.
2. Click the Inputs / Outputs tab.

3. Click the Add.
   The Add New FrameBuffer Board dialog box opens.

4. Select AJA Video from the Brand list.
5. Click OK.
   The AJA Video - Framebuffer Setup dialog box opens.
6. Click the Board tab to configure hardware and genlock settings.
a. In the **Hardware** section, use the **Board** list to select the installed board. This menu is automatically populated based on installed hardware.

b. In the **GenLock** section, use the Source list to select the source of the genlock signal with which to synchronize XPression. The available genlock signal sources are as follows:

   - **External Reference** — Synchronize with a genlock signal received from an external application through the GenLock In port of the XPression computer. Ross Video recommends using an external reference for the genlock signal source.
   - **Input 1** — Sync to Video In 1 source signal.
   - **Input 2** — Sync to Video In 2 source signal.
   - **Free Running** — Do not synchronize XPression with an external source.

7. Click the **Output** tab to configure output settings.

   ![Output Configuration](image)

   a. In the **Video Mode** section, use the **Standard** list to select the video format in which to output an XPression project. The available video formats are as follows:

      - **<from project>** — automatically switch to the output video format to the video format of the currently loaded project.
        The project video format is ignored when a specific output video format is selected, and the selected video format is used to playout scenes.
      - **PAL, 720x576, 25 frames/second**
      - **NTSC, 720x486, 29.97 frames/second**
      - **HD 1080i, 1920x1080, 25 frames/second**
      - **HD 1080i, 1920x1080, 29.97 frames/second**
      - **HD 1080p, 1920x1080, 23.976 frames/second**
      - **HD 1080p, 1920x1080, 50 frames/second**
      - **HD 1080p, 1920x1080, 59.94 frames/second**
      - **HD 1080p, 1920x1080, 60 frames/second**
      - **HD 720p, 1280x720, 50 frames/second**
      - **HD 720p, 1280x720, 59.94 frames/second**

   b. In the **Keying** section, use the **Mode** list to select how graphics are output to a video stream. The available modes are as follows:

      - **External** — Output the key and fill graphics as separate video signals. Graphics mixing occurs in an external keyer/mixer.
• **Internal** — Key and fill graphics are mixed internally and output as a single video signal from the framebuffer. In this mode the framebuffer functions as the keyer/mixer.

c. When **External** is selected in the **Mode** list, use the **Fill** list to select the method used to process fill graphics before output. The available processing methods are as follows:

  • **Shaped (premultiplied)** — Multiply/shape the fill signal color information by the luminance information in the key signal.
  • **Unshaped** — Output fill and key signals “as is”.

d. In the **Hardware Buffers** section, use the **Queue Size** box to enter or select the number of frames to buffer in memory before sending to the output.

  Use this setting to avoid buffer under runs, which may cause frame skipping. Larger queue sizes ensure smooth playout of generated graphics, but add delay to the output.

e. In the **Up/Down Conversion** section, use the **Conversion** list to enable or disable output conversion to a predefined signal.

f. Use the **Path** list to select the source display on the output.

g. Use the **Up** list to select the format for up converted output. The available output formats are as follows:

  • **Anamorphic** — Display a full-screen image.
  • **Pillar box 4:3** — Display a 4:3 image in the center of the screen with black sidebars.
  • **Zoom 14:9** — Display a 4:3 image zoomed to fill a 14:9 image with black sidebars.
  • **Letterbox** — Display an image zoomed to fill full screen.
  • **Zoom Wide** — Display an image zoomed and horizontally stretched to fill full screen.

h. Use the **Down** list to select the format for down converted output. The available output formats are as follows:

  • **Letterbox** — Display a reduce image with black bars added to the top and bottom of the image area with the aspect ratio preserved.
  • **Crop** — Crop the image to fit the new screen size.
  • **Anamorphic** — Display a 16:9 image in a 4:3 box.

8. Click the **Input** tab to configure input settings.

   a. In the **Video Mode** section, use the **Standard** list to select the analog video format in which to receive video.

   b. In the **Hardware Buffers** section, use the **Queue Size** box to enter or select the number of frames to buffer in memory before sending to XPression.
9. Click the Misc tab to configure analog, timing, startup, shutdown, and audio settings.

   ![Misc tab configuration]

   a. In the Analog Output Mode section, use the Mode list to select the video format in which to output an analog video signal.

   b. In the Digital Output Timing Offset section, use the Horizontal box to enter or select the number of nanoseconds for horizontal timing offset with regards an external reference.

   c. In the Vertical box, enter or select the number of lines for vertical delay timing offset with regards an external reference.

   d. In the Initialization / Finalization section, use the Startup list to select the video state at startup. The available states are as follows:

      - Retain Current State — Retain resources to use once again.
      - Clear Framebuffers — Clear all framebuffers from the output framebuffer.

   e. Use the Shutdown list to select the video state at shutdown. The available states are as follows:

      - Retain Current State — Retain resources to use once again.
      - Clear Framebuffers — Clear all framebuffers from the output framebuffer.

   f. In the Audio section, select the Audio Loop Through check box to enable embedded audio loop through.

10. Click OK.

    The configured AJA Video framebuffer board is added to the Inputs / Outputs tab of the Hardware Setup dialog box.

11. In the Hardware Setup dialog box, click Close.

    The Hardware Setup dialog box closes.
Configure a Black Magic Design FrameBuffer

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.
2. Click the Inputs / Outputs tab.

3. Click the Add.
   The Add New FrameBuffer Board dialog box opens.

4. Select Blackmagic Design from the Brand list.
5. Click OK.
   The Blackmagic Design - Framebuffer Setup dialog box opens.
6. Click the Board tab to configure hardware settings.
a. In the **Hardware** section, use the **Board** list to select the installed DeckLink Studio card to configure.

b. In the **Input / Output Options** section, use the **Output** list to select when to activate video output from the Blackmagic Design framebuffer. The options are as follows:
   - **Always active** — Always output video.
   - **Active on use only** — Only output video when the card is in use.

c. Use the **Input** list to select when to activate video input through the Blackmagic Design framebuffer. The available options are as follows:
   - **Will deactivate the output when activated** — automatically deactivate the output when the input is activated.
   - **Can only be activated when the output is not active** — input can only be activated when the output is not active.
   - **Always disabled** — disable the input to prevent it from deleting other inputs.
   - **Always enabled (output will always be disabled)** — enable the input and disable the output at all times.

   > Input grabbing may compromise output performance.

7. Click the **Output** tab to configure output settings.

![Output settings](image)

a. In the **Video Mode** section, use the **Standard** list to select the video format in which to output an XPression project.

b. In the **Keying** section, use the **Mode** list to select how graphics are output to a video stream. The modes are as follows:
   - **External** — Output the key and fill as separate video signals. Graphics and video mixing occurs in an external keyer/mixer.
   - **Internal** — Key and fill are mixed internally. Graphics and video are output as a single video signal from the framebuffer. In this mode the framebuffer functions as the keyer/mixer.
   - **Off** — Only output a video signal. In this mode, graphics are excluded from the output.

c. When **External** is selected in the **Mode** list, use the **Fill** list to select the method used to process fill graphics before output. The available processing methods are as follows:
   - **Shaped (premultiplied)** — Multiply/shape the fill signal color information by the luminance information in the key signal.
   - **Unshaped** — Output fill and key signals “as is”.

d. In the **Software Buffers** section, use the **Queue Size** box to enter or select the number of frames to buffer in memory before sending to the output.
Use this setting to avoid buffer underruns, which may cause frame skipping. Larger queue sizes ensure smooth playout of generated graphics, but add delay to the output.

e. In the **Analog Output** section, use the **Mode** list to select the type of analog video signal to output. The available output video signals are as follows:

- **Composite** — output a single video signal that combines luminance and chroma.
- **Component** — output three channels (Y, R-Y, and B-Y).
- **S-Video** — output a video signal that carries the video data as two separate signals (brightness and color), unlike composite video which carries the entire set of signals through a signal line.

f. When **Component** is selected in the **Mode** list, use the **Component Level** list to select the output component analog level. The available levels are as follows:

- **SMPTE** — use this level for monitoring component analog video.
- **Betacam** — use this level for output to Sony Betacam SP decks.

g. Use the **Black Level** list to select the default black level analog video signal. The available levels are as follows:

- **7.5 IRE (USA)** — standard black level for all NTSC countries except Japan.
- **0.0 IRE (Japan)** — standard black level for Japan.

8. Click the **Input** tab to configure input settings.

   ![Input Settings](image)

a. In the **Video Mode** section, use the **Standard** list to select the analog video format in which to receive video.

9. Click **OK**.

   The configured Blackmagic Design framebuffer board is added to the **Inputs / Outputs** tab of the **Hardware Setup** dialog box.

10. In the **Hardware Setup** dialog box, click **Close**.

   The **Hardware Setup** dialog box closes.
Configure a Matrox FrameBuffer

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.

2. Click the Inputs / Outputs tab.

3. Click the Add.
   The Add New FrameBuffer Board dialog box opens.

4. Select Matrox from the Brand list.
5. Click OK.
   The Matrox XMIO - Framebuffer Setup dialog box opens.
6. Select the Board tab to choose and configure an installed X.mio2 card.
a. In the **Hardware** section, use the **Board** list to select the installed X.mio2 card to configure.

b. In the **GenLock** section, use the **Source** list to select the source of the genlock signal with which to synchronize XPression. The available genlock signal sources are as follows:
   - **Internal** — generate internal sync on the video card for all output channels.
   - **Blackburst** — sync to analog black.
   - **SDI Input 1** — sync to SDI Input 1 source signal.
   - **SDI Input 2** — sync to SDI Input 2 source signal.
   - **SDI Input 3** — sync to SDI Input 3 source signal.
   - **SDI Input 4** — sync to SDI Input 4 source signal.

c. Use the **Standard** list to select the format of the incoming genlock signal.

d. In the **Timing Offset** section, use the **Horizontal** box to enter or select the number of nanoseconds for horizontal timing offset with regards an external reference.

e. In the **Vertical** box, enter or select the number of lines for vertical delay timing offset with regards an external reference.

7. Select an **Output** tab to configure the parameters of the selected output.

![Image](image.png)

a. In the **Video Mode** section, use the **Standard** list to select the video format for the output.

b. In the **Keying** section, use the **Mode** list to select a keying mode for the output. The available modes are as follows:
   - **External** — select to output video and alpha channels.
   - **Internal** — select to key XPression scenes to the associated input.

c. Use the **Fill** list to select the fill mode. The available fill options are as follows:
   - **Shaped (premultiplied)** — select to use an additive key to cut precise holes for the fill.
   - **Unshaped** — select to use a multiplicative key based on the gradient values of the alpha.

d. In the **Watchdog** section, select the **Route Input To Output On Application Failure & System Reboot** check box to route the input to an output in the event of application failure or a system reboot.

e. Use the **Key Channel** list to select a transparent or opaque key channel. The available key channels are as follows:
   - **On Failure Set to 0% Key (transparent)** — select to set the key channel to transparent in the event of failure.
   - **On Failure Set to 100% Key (opaque)** — select to set the key channel to opaque in the event of failure.
f. In the Hardware Frame Buffer Queue section, use the Queue Size box to enter or select the framebuffer queue size. The framebuffer queue size can be between two and seven.

g. Use the Pre Queue box to enter or select the pre-queue size. The pre-queue size can be between one and six.

h. In the Horizontal Timing Offset (ns) section, use the Fill Offset box to enter or select the offset of the fill.

i. Use the Key Offset box to enter or select the offset of the key.

j. In the Misc section, select the Clip Chroma Levels check box to limit the chroma levels in the output.

k. Select the Allow Super Black check box to enable Super Black in the output.

8. Select an Input tab to configure the parameters of the selected input.

![Input Configuration GUI]

- In the Video Mode section, use the Standard list to select the video format for the input.
- In the Audio Channel Mapping section, use the Capture list to select the audio type for the input.
- In the AES/EBU Pair Mapping area, use the Pair lists to define the mapping of the AES/EBU inputs.
- In the Ancillary Data section, select the Pass VANC data from Input 1 to Output 1 check box to pass vertical ancillary data from Input 1 to Output 1 when using a Live Source shader in the scene and a Matrox board.

* Requires Matrox DSX version 7.5.2.457.

9. Click OK.

The configured Matrox framebuffer board is added to the Inputs / Outputs tab of the Hardware Setup dialog box.

10. In the Hardware Setup dialog box, click Close.

The Hardware Setup dialog box closes.

Note:
- A maximum of two inputs and two outputs can be configured for the Matrox framebuffer.
Configure an XPression AVI Recorder

The XPression AVI Recorder is used to render scenes or scene groups and save the output as an AVI file. Before using this functionality, the AVI Recorder must be configured as a video output in the Hardware Setup dialog box.

1. In XPression, use the Edit menu to select Hardware Setup.
   
   The Hardware Setup dialog box opens.

2. Click the Inputs / Outputs tab.

3. Click the Add.
   
   The Add New FrameBuffer Board dialog box opens.

4. Select XPression AVI Recorder from the Brand list.
5. Click OK.
   
   The AVI Recorder - Setup dialog box opens.

6. Use the Fill Mode list to select the method used to process fill graphics before output. The available processing methods are as follows:
   
   • Unshaped Video — Output fill and key signals “as is”.
   
   • Shaped Video (premultiplied fill) — Multiply/shape the fill signal color information by the luminance information in the key signal.

7. Click OK.
   
   An XPression Virtual Output is added to the Inputs / Outputs tab of the Hardware Setup dialog box.
8. In the Hardware Setup dialog box, click Close.

The Hardware Setup dialog box closes.

For More Information on...

- rendering output to an AVI file, refer to the procedure “Render Output to an AVI File” on page 21–3.
Configure an XPression RossLinq Connector

The RossLinq feature allows you to connect XPression directly to the media-store channels of CrossOver over ethernet. Have XPression render images and graphics into the media-store channels of CrossOver without using any of the video input BNC on CrossOver.

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.

2. Click the Inputs / Outputs tab.

3. Click Add.
   The Add New FrameBuffer Board dialog box opens.

4. In the Brand list, select XPression RossLinq Connector from the Brand list.

5. Click OK.
   The RossLinq - Setup dialog box opens.

6. Enter the IP address of the CrossOver switcher in the Host box.
7. In the Channel box, enter the Media-Store channel (1 or 2) on CrossOver that you want to upload images to. Media-Store channels 3 and 4 are for alpha channels only. If you load an image or animation with an embedded alpha channel, the switcher automatically places the alpha channel in the paired Media-Store channel.

8. Check the Passive Connection box to establish a passive FTP connection.

9. Check the Override Login box to override the username and password for the connection.

10. In the User box, enter a username for the connection to the CrossOver switcher.

11. In the Password box, enter a password for the connection to the CrossOver switcher.

12. In the Output Mode section, use the Frame Size menu to select the resolution of the images rendered and sent to the RossLinq device. The available options are as follows:
   - <from project> — select this to use the same format as the project.
   - PAL, 720x576
   - NTSC, 720x486
   - HD 720p, 1280x720
   - HD 1080i, 1920x1080
   - HD 1080p, 1920x1080

13. Click OK.
Configure the XPression Tile Mapper

The XPression Tile Mapper enables XPression to create an output framebuffer to simultaneously render a scene through multiple outputs for videowall applications.

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.
2. Click the Inputs / Outputs tab.

3. Click the Add.
   The Add New FrameBuffer Board dialog box opens.

4. Select XPression Tile Mapper from the Brand list.
5. Click OK.
   The Tile Mapper dialog box opens.

6. In the Tile Mapper dialog box, use the Tiles section to configure the number and position of the tiles used to render the scene.
a. Use the **Horizontal** box to enter or select the amount of horizontal tiles used to render a scene.

b. Use the **Vertical** box to enter or select the amount of vertical tiles used to render a scene.

7. In the **Tile to Framebuffer Mapping** table, use the list in the **Framebuffer** column to select the output for each tile number.

* Virtual outputs can not be used for the Tile Mapper framebuffer.

8. Click **OK**.

The configured Tile Mapper framebuffer board is added to the **Inputs / Outputs** tab of the **Hardware Setup** dialog box.

9. In the **Hardware Setup** dialog box, click **Close**.

The **Hardware Setup** dialog box closes.
Configure an XPression Virtual Input

The XPression Virtual Input enables XPression to create Live Source materials without a physical input card installed in the XPression computer.

1. In XPression, use the Edit menu to select Hardware Setup.

   The Hardware Setup dialog box opens.

2. Click the Inputs / Outputs tab.

3. Click the Add.

   The Add New FrameBuffer Board dialog box opens.

4. Select XPression Virtual Input from the Brand list.

5. Click OK.

   The Virtual Input Settings dialog box opens

6. Use the Test Pattern list to select a test signal for the virtual input. The options are:
   - Black
   - White
   - Color Bars

7. Click OK.

   An XPression Virtual Input is added to the Inputs / Outputs tab of the Hardware Setup dialog box.

8. In the Hardware Setup dialog box, click Close.

   The Hardware Setup dialog box closes.
Configure an XPression Virtual Output

The XPression Virtual Output enables XPression software to run without any framebuffer cards installed in the XPression computer. In this case, the Virtual Output is used to display output in a window on the XPression computer.

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.
2. Click the Inputs / Outputs tab.
3. Click the Add.
   The Add New FrameBuffer Board dialog box opens.
4. Select XPression Virtual Output from the Brand list.
5. Click OK.
   The Virtual Output Settings dialog box opens.
6. In the Description box, enter a name or brief description for the virtual output.
7. In the Options section, configure the following:
   - **Show On Startup** — select this check box to have the virtual output open when XPression is launched.
   - **Fullscreen** — select this check box to make the virtual output window fullscreen.
   - **Stay On Top** — select this command to always display the virtual output on top of all other open and/or active windows on the screen.
   - **Vertical Sync** — currently not implemented.
   - **Render at Monitor Refresh Rate** — currently not implemented.

8. Click OK.
   An XPRESSion Virtual Output is added to the Inputs / Outputs tab of the Hardware Setup dialog box.

9. In the Hardware Setup dialog box, click Close.
   The Hardware Setup dialog box closes.
Change the Order of Video Inputs / Outputs

1. In XPression, use the Edit menu to select Hardware Setup. The Hardware Setup dialog box opens.

2. Click the Inputs / Outputs tab.

3. In the Inputs / Outputs list, select the Framebuffer Board, Virtual Output, or AVI Recorder to move in the list.

4. At the bottom of the dialog box, click Move Down to move the selected device down one position in the Inputs / Outputs list, or Move Up to move up one position in the list.

   The Move Up button is not available when the selected device is positioned at the top of the list. The Move Down button is not available when the selected device is positioned at the bottom of the list.

5. Click Close.

   The Hardware Setup dialog box closes.
Delete a Video Input / Output

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.

2. Click the Inputs / Outputs tab.

![Hardware Setup dialog box](image)

3. In the Inputs / Outputs list, select the Framebuffer Board, Virtual Output, or AVI Recorder to delete.

![Inputs / Outputs list](image)

4. Click Delete at the bottom of the dialog box.
   A Warning dialog box opens.

5. Click Yes.
   The selected video device is deleted from Inputs / Outputs list.

6. Click Close.
   The Hardware Setup dialog box closes.
Configure an Audio Device

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.

2. Click the Audio Devices tab.

   ![Hardware Setup Dialog Box](image1)

3. Click the Add.
   The Add Audio Device dialog box opens.

   ![Add Audio Device Dialog Box](image2)

4. Use the Engine list to select engine used to produce audio.

5. Use the Device list to select the sound card to output audio.

6. Click OK.
   The Audio Engine Setup dialog box opens.

   ![Audio Engine Setup Dialog Box](image3)

7. In the Configuration section, use the Sample Rate list to select the sample rate for the audio signal.
   The selected sample rate defines the number of samples per second taken from analog signal to make a digital signal. A sample rate of 48 kHz is the recommended setting, but 44.1 kHz can also be used.

8. In the Delay (frames) box, enter or select the number of frames to delay the audio signal.
   XPression delays video 6 frames when used as material.
9. Click OK.
   The configured audio device is added to the Audio Devices tab of the Hardware Setup dialog box.

10. In the Hardware Setup dialog box, click Close.
    The Hardware Setup dialog box closes.

Note:
   • Adding an audio device is not required to output embedded or AES audio.
Delete an Audio Device

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.

2. Click the Audio Devices tab.

3. In the Audio Devices list, select the Audio Device to delete.

4. Click Delete at the bottom of the dialog box.
   A Warning dialog box opens.

5. Click Yes.
   The selected audio device is deleted from Audio Devices list.

6. Click Close.
   The Hardware Setup dialog box closes.
Configure Video Preview and Audio Monitor

1. In XPression, use the Edit menu to select Hardware Setup.

   The Hardware Setup dialog box opens.

2. Click the Preview & Monitor tab.

   ![Hardware Setup Dialog Box]

3. In the Preview Output section, use the Output list to select the video output device on which to preview video. All framebuffers can be used to preview video.

   When <none selected> is the selected preview output, video preview is only possible within XPression.

   ✤ If a configured framebuffer from the Inputs / Outputs tab is used as a preview output, the Hardware Setup dialog box must be closed and reopened before the configured framebuffer is available in the Output list.

4. In the Audio Monitor section, use the Device list to select the audio output device from which to monitor audio.

5. Click Close.

   The Hardware Setup dialog box closes.
Configure RS232 CTS/DSR GPI for Contact Closures

1. Ensure that a USB-232 dongle is installed and assigned to a Communication port or that the system has a built-in RS232 port before configuring GPI for RS232.

   ❗ Not all USB to serial converters support contact closures.

2. In XPRESSION, use the Edit menu to select Hardware Setup.

   The Hardware Setup dialog box opens.

3. Click the GPI Boards tab.

   ![GPI Boards Tab](image)

4. Click Add.

   The Add New GPI Board dialog box opens.

   ![Add New GPI Board](image)

5. Use the Brand list to select Serial GPI (CTS/DSR).

   The Serial GPI Setup dialog box opens.

   ![Serial GPI Setup](image)

6. In the RS232 GPI Settings section, select Enabled from the State list. Select Disabled to turn off RS232 GPI.

   When enabled, RS232 GPI (General Purpose Interface) is used to control functions of XPression in sequencer mode. RS232 GPI can trigger the state of the next take of scenes and scene groups from top to bottom of a sequence.

   A standard RS232 serial port can support two GPI signals using the CTS and DSR pins. Connect Pins 6 and 7 for GPI 1 and connect Pins 7 and 8 for GPI 2.

7. Use the Port list to select the Communication port that receives RS232 GPI signals.
8. In the **Debounce Time** box, enter or select the amount of milliseconds between sequential GPI pulses.

When using a contact closure GPI on the CTS/DSR lines, some devices might send GPI signals that are noisy. Connecting the GPI to a mechanical push-button may also exhibit this problem. If the connection is noisy, it could generate multiple triggers that cause the sequence to advance by two or three events at a time. In the **Serial GPI Setup** dialog box, a Debounce Time can be set. This value is the amount of time within which XPression will wait before acting upon a second GPI trigger. A value of around 50-100 milliseconds should be sufficient for filtering out any noise during the GPI trigger.

9. Click **OK**.

The **Serial GPI Setup** dialog box closes and the configuration appears in the GPI Boards tab list.

**For More Information on...**

- configuring and working with GPIs, refer to the *GPI White Paper* available from Ross Video.
Configure a 25-Pin GPIO Port

1. In XPRESSION, use the Edit menu to select Hardware Setup.

   The Hardware Setup dialog box opens.

2. Click the GPI Boards tab.

3. Click Add.

   The Add New GPI Board dialog box opens.

4. Use the Brand list to select Adrienne TC/GPIO Card.

   The Adrienne TC/GPIO card is installed in Ross Video Turnkey systems. The 25 pin GPIO port can be accessed through .NET applications or by using the Keyboard / GPI Mapping dialog box to configure functions.

5. Click OK.

   The Adrienne Setup dialog box opens.

6. In the Polling Frequency box, enter or select a polling frequency in milliseconds for checking the GPI inputs.

7. Click OK.

   The Adrienne TC/GPIO card is displayed in the GPI Board list.

8. Click Close.

   The Hardware Setup dialog box closes.
For More Information on...

- configuring and working with GPIs, refer to the *GPI White Paper* available from Ross Video.
- creating a custom GPI, refer to the section “Create a Custom GPI Map” on page 23-9.
Configure Smart GPI / RossTalk

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.
2. Click the GPI Boards tab.

3. Click Add.
   The Add New GPI Board dialog box opens.

4. Use the Brand list to select Smart GPI / RossTalk.
   Smart GPI/RossTalk is an ASCII based protocol that can be sent over TCP/IP or RS232 that is used to trigger various actions in XPression.
5. Click OK.
   The Smart GPI Setup dialog box opens.

6. In the Settings section, select Enabled from the State list. Select Disabled to turn off Smart GPI/RossTalk.
7. Select a **Mode** for Smart GPI/RossTalk:
   - **Serial RS232** — select to use RS232 to send Smart GPI/RossTalk signals to XPression.
   - **TCP** — select to use TCP/IP to send Smart GPI/RossTalk signals to XPression.
   - **UDP** — select to use UDP sockets to send Smart GPI/RossTalk signals to XPression.

8. Configure the selected GPI mode.

**Serial RS232**
- **a.** Use the **Port** list to select the Communication port that receives GPI signals.
- **b.** Use the **Baudrate** list to select the communication speed for GPI signals.
- **c.** Use the **Data Bits** list to select the number of bits used to represent one character of data for GPI signals.
- **d.** Use the **Parity** list to select the method used to check for lost data in a GPI signal.
- **e.** Use the **Stop Bits** list to select the number of bits used to indicate the end of a byte in a GPI signal.
- **f.** Use the **Flow Control** list to select the data transmission rate controller for a GPI signal.

   When using Smart GPI/RossTalk, the flow control can be set to **Hardware** or **None**, but it must be set the same in both XPression and the transmitting device.

**TCP/IP & UDP**
- **a.** In the **TCP Port/UDP Port** box, enter or select the communication port that receives GPI signals.

9. Click **OK**.

   The Smart GPI/RossTalk is displayed in the GPI Board list.

10. Click **Close**.

    The **Hardware Setup** dialog box closes.

**For More Information on...**
- configuring and working with GPIs, refer to the **GPI White Paper** available from Ross Video.
Configure PBus Interface

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.

2. Click the GPI Boards tab.

3. Click Add.
   The Add New GPI Board dialog box opens.

4. Use the Brand list to select PBus.
   PBus is an industry standard protocol designed to allow production switchers to communicate with external devices.

5. Click OK.
   The PBus Setup dialog box opens.

6. In the Settings section, select Enabled from the State list. Select Disabled to turn off PBus.
7. Select a Mode for PBus:
   • Serial RS232 — select to use RS232 to send PBus signals to XPression.
   • TCP — select to use TCP/IP to send PBus signals to XPression.
   • UDP — select to use UDP sockets to send PBus signals to XPression.

8. Configure the selected mode.

Serial RS232
   a. Use the Port list to select the Communication port that receives the signals.
   b. Use the Baudrate list to select the communication speed for the signals.
   c. Use the Data Bits list to select the number of bits used to represent one character of data for the signals.
   d. Use the Parity list to select the method used to check for lost data in a signal.
   e. Use the Stop Bits list to select the number of bits used to indicate the end of a byte in a signal.
   f. Use the Flow Control list to select the data transmission rate controller for a signal.
      The flow control can be set to Hardware or None, but it must be set the same in both XPression and the transmitting device.

TCP/IP & UDP
   a. In the TCP Port/UDP Port box, enter or select the communication port that receives the signals.

PBus
   a. In the PBus Settings section, use the Device ID box to enter or select the device identification number of the connected switcher or component.
   b. In the PBus Options section, select the Clear layer on recall check box to have XPression clear the assigned channel and layer of a recalled take item after the signal has been received.
   c. Select the Move sequencer focus on recall check box to move the sequencer focus to the recalled take item.

9. Click OK.

   The PBus interface is displayed in the GPI Board list.

10. Click Close.

   The Hardware Setup dialog box closes.

For More Information on...
   • using PBus, refer to the PBus On XPression application note available from Ross Video.
   • configuring and working with GPIs, refer to the GPI White Paper available from Ross Video.
Configure Camera Tracking

1. In XPression, use the Edit menu to select Hardware Setup.

   The Hardware Setup dialog box opens.

2. Click the Camera Tracking tab.

3. Click Add.

   The Select Tracker Source dialog box opens.

4. Use the Brand list to select TrackMen.

   The Tracker Setup dialog box opens.

5. In the Network Settings section, use the UDP Port box to enter or select the UDP communication port that receives the camera tracking source information.

   Select the Enabled check box to use the camera tracking source. Deselect it to turn off the camera tracking source.

6. Select the Generate and send test data check box to compile and send information about the camera tracking source.

7. Click OK.

   The Tracker Setup dialog box closes and the camera tracking source appears in the Camera Tracking tab list.

   Use the Latency Offset box in the Camera Tracking tab to enter or select the latency offset in frames to match video and rendering delay.
Scenes

Within in an XPression project, scenes are the containers that hold all of the objects and animations you build to form your graphical creation.

The following topics are discussed in this section:

• Create a Project
• Create a Scene
• Create a Custom Size Scene
• Duplicate a Scene
• Delete a Scene
• Create a Scene Group
• Duplicate a Scene Group
• Delete a Scene Group
• Create a Roll/Crawl from a Scene Group
• Customize a Scene Group Roll/Crawl
Create a Project

1. In XPression, use the File menu to select New.
   The Confirm dialog box opens.

2. Select one of the following options for the current project:
   - Yes — save changes to the current project, then close the project.
   - No — close the project without saving changes.
   - Cancel — continue working on the project.

After selecting Yes or No, the New Project dialog box opens.

3. In the Presets tree view, expand any video format node to view the available settings presets for the selected video format.
   The available settings presets are displayed for the selected video format.

4. Select a setting preset to define video format setting for the new project.
   The settings in the selected preset are displayed in the Settings section.

5. Click Browse to the right of the Location box to select a folder in which save the new project.
   The Browse for Folder dialog box opens.

6. In the Folder tree view, locate and select a folder in which save the new project.
7. Click OK.

In the New Project dialog box, the full pathname of the selected folder is displayed in the Location box.

8. Enter in the Name box a name for the new project.

Project names may only contain letters, numbers, spaces, hyphens, or underscores. Project files are saved with the extension .xpf.

9. Select the Create Project Structure check box to automatically create folders within the project folder to store project items (audio, video, dedicated fonts, images, models, etc.).

10. Click OK.

The new project is saved in the project folder and the New Project dialog box closes.
Create a Scene

1. In the Scene Manager window, select the scene or scene group below which to add a new scene.

2. Click the New Scene button in the toolbar.
   A new scene is added to the Scene Manager window below the scene or scene group selected in the scene list.

3. In the title bar of the new scene, right-click the scene name and select Rename from the shortcut menu.
   The scene name is selected for editing.

4. Enter a new name for the scene.

5. Press the Return key to save the new scene name.
   The scene title bar displays the entered name.
For More Information on...

- adding text objects to a scene, refer to the procedure “Create a Text Object” on page 5–2.
- adding quad objects to a scene, refer to the procedure “Create a Quad Object” on page 7–2.
- adding sphere objects to a scene, refer to the procedure “Create a Sphere Object” on page 7–5.
- adding cube objects to a scene, refer to the procedure “Create a Cube Object” on page 7–8.
- adding 3D models to a scene, refer to the procedure “Import a 3D or OBJ Model into a Scene” on page 6–2.
Create a Custom Size Scene

1. In the Scene Manager window, right-click the scene or scene group below which to add a new scene.
   The shortcut menu opens.

2. Select New > Custom Size Scene from the shortcut menu.

   ![Scene Manager screenshot]

   The New Scene dialog box opens.

3. In the Virtual Dimensions section, use the Width box to enter or select the width in pixels of the new scene.

4. In the Height box, enter or select the height in pixels for the new scene.

5. In the Area Mapping table, enter the coordinates for the new scene.
6. Click **OK** to create a new scene with the defined settings and close the **New Scene** dialog box.
   A new scene is added to the Scene Manager window below the scene or scene group selected in the scene list.

7. In the title bar of the new scene, right-click the scene name and select **Rename** from the shortcut menu.
   The scene name is selected for editing.
8. Enter a new name for the scene.
9. Press the **Return** key to save the new scene name.
   The scene title bar displays the entered name.
Duplicate a Scene

1. In the **Scene Manager** window, right-click the scene to duplicate.
   The shortcut menu opens.

2. Select **Duplicate** from the shortcut menu.

   ![Scene Manager window with shortcut menu](image)

   A new scene is added to the **Scene Manager** window below the scene selected to duplicate.

3. In the title bar of the new scene, right-click the scene name and select **Rename** from the shortcut menu.
   The scene name is selected for editing.

4. Enter a new name for the scene.
5. Press the **Return** key to save the new scene name.

   The scene title bar displays the entered name.
Delete a Scene

1. In the **Scene Manager** window, right-click the scene to delete.
   
The shortcut menu opens.

2. Select **Delete** from the shortcut menu.
   
The **Warning** dialog box opens

3. Click **Yes**.
   
The selected scene is deleted from the **Scene Manager** window.

Deleting a scene also deletes all of the objects contained in the scene.
Create a Scene Group

A scene group is a collection of scenes that when played out, displays a vertical rolling credits effect or a horizontal crawling ticker effect.

1. In the **Scene Manager** window, select the scene or scene group above which to add a new scene group.

2. Click the **New Scene Group** button in the toolbar.

   A new scene group is added to the **Scene Manager** window below the scene or scene group selected in the scene list.

3. In the title bar of the new scene group, right-click the scene group name and select **Rename** from the shortcut menu.

   The scene group name is selected for editing.
4. Enter a new name for the scene group.

5. Press the **Return** key to save the new scene group name.

   The scene group title bar displays the entered name.

**For More Information on...**

- rendering output to an AVI file, refer to the procedure “Create a Roll/Crawl from a Scene Group” on page 4–16.
Duplicate a Scene Group

1. In the **Scene Manager** window, right-click the scene group to duplicate.
   
   The shortcut menu opens.

2. Select **Duplicate** from the shortcut menu.
   
   A new scene group is added to the **Scene Manager** window below the scene group selected to duplicate. All of the scenes contained in the original scene group are duplicated in the new scene group.

3. In the title bar of the new scene group, right-click the scene group name and select **Rename** from the shortcut menu.
   
   The scene group name is selected for editing.

4. Enter a new name for the scene group.
5. Press the **Return** key to save the new scene group name.
   The scene group title bar displays the entered name.
Delete a Scene Group

1. In the Scene Manager window, right-click the scene group to delete.
   The shortcut menu opens.

   ![Scene Manager window with a scene group selected](image)

2. Select Delete from the shortcut menu.
   The Warning dialog box opens
   * Deleting a scene group also deletes all of the scenes contained in the scene group.

3. Click Yes.
   The selected scene group is deleted from the Scene Manager window.
Create a Roll/Crawl from a Scene Group

1. Create a new XPression project or open an existing XPression project to add a roll/crawl effect.

2. In the Scene Manager window, select the scene or scene group above which to add a new scene group.

3. Click the New Scene Group button in the toolbar.

   A new scene group is added to the Scene Manager window below the selected scene or scene group. By default, new scene groups are configured to play a Roll (top to bottom) effect.
4. Add objects to the scene group scene that need to be seen for the entire duration of the roll/crawl effect. For example, add objects to the scene group scene that comprise the background for a roll/crawl effect.

5. Click the New Scene button in the toolbar to add the first scene for the roll/crawl effect. A new scene is added below the scene group.

6. On the new scene, click and hold the left mouse button.

7. Drag the selected scene on top of the scene group scene.
8. Release the left mouse button.

The new scene is added to the scene group. Scenes contained in a scene group are indented and connected to the scene group by a leader line.

9. Add objects to the scene that are to move as part of the roll/crawl effect.

   For example, add a text object to the scene to represent the first line of text for a set of credits played by the roll/crawl effect.

10. Add additional scenes to the scene group as required.

   Duplicating the first scene added to a scene group is a quick way to add the scenes required for a roll/crawl effect. Scene duplication enables object reuse and object alignment to be maintained between scenes.

11. Add objects to and/or edit existing objects in the scenes that were added to the scene group.

   For example, each scene could contain a text object that represents one line of text in a set of credits played by the roll/crawl effect.

12. If the position of a scene in the scene group needs to be changed, click on the scene and drag it to the required position in the scene group.

13. Double-click the scene group to play out the defined roll/crawl effect.

   The selected scene group is sent to the default output.

14. Press the **Spacebar** to start the scene group playout.

   The defined roll/crawl effect plays out through the default output.

**For More Information on...**
- duplicating scenes, refer to the procedure **Duplicate a Scene** on page 4–8
- customizing a scene group roll/crawl effect, refer to the procedure **Customize a Scene Group Roll/Crawl** on page 4–19 or the Online Help for the **Scene Group** tab of the **Object Inspector**.
Customize a Scene Group Roll/Crawl

1. In the **Scene Manager** window, select the scene group to customize.
   The selected scene group and the objects contained in it are listed in the **Object Manager** window.

2. In the **Object Inspector - Scene Object** window, click the **Scene Group** tab.
   The **Scene Group** tab opens with the properties for the selected scene group.

3. Use the properties in the **Group** section to set roll/crawl effect properties for a scene group.
   **Properties**
   - **Effect** — use this list to select the roll/crawl effect with which to playout scenes in a scene group. The available effects are as follows:
     - **Roll** — move scene objects vertically.
     - **Crawl** — move scene objects horizontally.
   - **Direction** — use this list to select the direction for the selected roll/crawl effect. The available directions depend on the selected **Effect**, and are as follows:
     - **Roll Effect**
       - **Bottom To Top**
       - **Top To Bottom**
     - **Crawl Effect**
       - **Right To Left**
       - **Left To Right**
4. Use the properties in the **Duration** section to set the playout duration for the selected roll/crawl effect.

   **Properties**
   - **Speed** — select this option to define the roll/crawl effect playout duration in pixels per second. Use the box to the right of this option to enter or select the number of pixels per second to playout a roll/crawl effect.
   - **Seconds** — select this option to define the roll/crawl effect playout duration in seconds. Use the box to the right of this option to enter or select the number of seconds in which to playout a roll/crawl effect.
   - **Frames** — select this option to define the roll/crawl effect playout duration in frames. Use the box to the right of this option to enter or select the number of frames in which to playout a roll/crawl effect.

5. Use the properties in the **Global Margins** section to set the spacing between scenes displayed in a roll/crawl effect.

   **Properties**
   - **Top** — in this box, enter or select the size in pixels of the margin placed above objects in a scene. This margin is used to control vertical spacing between consecutive scenes played out in a roll effect. This box is only available when **Roll** is selected from the **Effect** list.
   - **Bottom** — in this box, enter or select the size in pixels of the margin placed below objects in a scene. This margin is used to control vertical spacing between consecutive scenes played out in a roll effect.
   - **Left** — in this box, enter or select the size in pixels of the margin placed to the left of objects in a scene. This margin is used to control horizontal spacing between consecutive scenes played out in a crawl effect.
   - **Right** — in this box, enter or select the size in pixels of the margin placed to the right of objects in a scene. This margin is used to control horizontal spacing between consecutive scenes played out in a crawl effect. This box is only available when **Crawl** is selected from the **Effect** list.

6. Use the properties in the **Loop** section to set the number of times to playout a roll/crawl effect.

   **Properties**
   - **Enable Looping** — select this check box to loop the playout of a roll/crawl effect. Clear this check box to only playout the roll/crawl effect one time.
   - **Number of Shows Per Scene** — in this box, enter or select the number of times to loop the playout of a roll/crawl effect. Enter 0 to infinitely loop the playout. This box is only available when the **Enable Looping** check box is selected.

7. Use the properties in the **Header/Footer** section to set the type of page with which to start and end a roll/crawl effect.

   **Properties**
   - **Blank Page on Start** — select this check box to start the roll/crawl effect with a blank page before displaying the scenes in the roll/crawl effect. Clear this check box to start the roll/crawl effect with the first scene in the scene group.
   - **Blank Page on End** — select this check box to end the roll/crawl effect with a blank page after displaying the scenes in the roll/crawl effect. Clear this check box to end the roll/crawl effect with the last scene in the scene group.
   - **Treat Last Page as Full** — select this check box to display the last scene in a roll/crawl effect as a full page.

8. Use the properties in the **Start/Stop** section to control the start and end playout speed of a roll/crawl effect.

   **Properties**
   - **Ease In** — select this check box to slow the playout speed at the start of a roll/crawl effect.
   - **Frames** — in this box, enter or select the number of frames at which to return a roll/crawl effect to normal playout speed.
   - **Ease Out** — select this check box to slow the playout speed at the end of a roll/crawl effect.
Frames — in this box, enter or select the number of frames from the end of a roll/crawl effect at which to slow the playout speed.

9. Use the property in the Rendering section to control lighting for a roll/crawl effect.

Property

Per Scene Lighting — select this check box to use a different lighting source for each scene in a roll/crawl effect. Clear this check box to use the lighting source in the first scene of the scene group for all of the other scenes in the roll/crawl effect.

10. Double-click the scene group to preview the customized roll/crawl effect.

The selected scene group is sent to the default output.

11. Press the Spacebar to start the scene group playout.

The customized roll/crawl effect plays out through the default output.
Base Objects

In XPression, text and backgrounds can be linked to various sources and formatted using defined styles.

The following topics are discussed in this section:

- Create a Text Object
- Use Tabs in a Text Object
- Align Text Objects to Build a Table
- Apply a Material to a Text Object
- Apply Word Wrap to a Text Object
- Create a Background Object
Create a Text Object

1. In the Scene Manager window, select the scene or scene group to add a text object.
   The selected scene or scene group is displayed in the active Viewport.

2. In the Base Objects section of the Object Library window, click the Text \text{Ab} button.
   A new text object is added to the upper left corner of the active Viewport.

   To use right to left text layout, right-click inside the text object and select Text Layout > Right To Left from the shortcut menu. A Text tab is added to the Object Inspector - Text Object window once Right to Left text has been selected. The text must be in Arabic and must be entered using the text editor in the Text tab.

3. In the Object Inspector - Text Object window, click the Scene Fonts tab.
   The Scene Fonts tab opens.

4. Select a font for the text object from the Used or Stock font list.

5. Type the text for the text object.
   The entered text is displayed in the text object.
6. To move the text object to a new position in the **Viewport**, place the cursor on the text object, press the **Ctrl** key, then click and drag the text object to a new position.

The settings on the **Transform** tab of the **Object Inspector - Text Object** window can be used to precisely position a text object.

![Object Inspector - Text Object window](image)

**For More Information on...**
- fonts, refer to the section “**Fonts**” on page 14–1.
Use Tabs in a Text Object

Tab are used to align text at set positions.

★ Word wrap is disabled when tabs are used.

1. Add a text object to a scene.

2. Enter some text in the new text object, then press the Tab key.

   After the entered text, the cursor is positioned at the tab that follows the text. By default, five tabs are set for a text object. In a text object, tab positions are marked by a vertical line with an square on top.

3. To edit the tabs set for a text object, click the Tabs & Options tab in the Object Inspector - Text Object window.

   The Tabs & Options tab opens.

   The Tabs section lists the five default tab positions.

4. Use the Tabs section to edit, add, or delete tabs.
   a. To edit the position of a tab, click in the Position column and enter or select a new tab position in pixels.
      The text associated with the edited tab automatically moves to the new tab position.
   b. To edit the alignment of a tab, click in the Alignment column and select a new text alignment for the tab.
      The text associated with the edited tab automatically move to match the new text alignment set for the tab.
      The first tab sets the justification of a text object when no other tab are used.
   c. To add a new tab, click New.
      The new tab is added to the end of the tab list. Edit the values in the Position and Alignment columns to modify the new tab.
   d. To delete a tab, select the tab to delete in the tab list then click Delete.

      After a tab is deleted, text is reformatted to align with the remaining tabs.

5. Use the Auto Squeeze section to set the size settings of the text object.
   a. Select the Enabled check box to scale the text content within the maximum width of the text object.
   b. In the Max Width box, enter or select the maximum width of the text object.
   c. Click Set To Current to set the maximum width to the current width of the text object.
d. Use the **Scaling** list to select the scaling condition of the auto squeeze. The available scaling options are as follows:
   - **Width Only** — select to apply auto squeeze to the width of the text object.
   - **Height & Width** — select to apply auto squeeze to the height and width of the text object.

6. Use the **Auto Scale** section to set the scaling of the children to the parent text object.

   a. Select the **Enabled** check box to scale children according to the auto squeeze settings of the selected text object.

   b. Use the **Target** list to select the children to scale according to the auto squeeze configuration of the parent text object. The available target options are as follows:
      - **First Child** — scale the first child according to the auto squeeze configuration of the parent text object.
      - **Children** — scale the children according to the auto squeeze configuration of the parent text object.

   c. Use the **Mode** list to select the scaling condition of the auto scale. The available mode options are as follows:
      - **Width & Height** — select to apply auto scale to the width and height of the first child or children.
      - **Width Only** — select to apply auto scale to the width of the first child or children.
      - **Height Only** — select to apply auto scale to the height of the first child or children.

For More Information on...

- adding a text object to a scene, refer to the procedure “Create a Text Object” on page 5–2.
Align Text Objects to Build a Table

1. In the **Scene Manager** window, select the scene or scene group to add a table.
2. Create a text object for each column heading in the table.

3. Position the text object of the first column heading in the scene to set the top left corner of the table.

4. In relation to the first column heading text object, position the text object of the last column heading to set the table width.

5. Use the **Selection** tool to select the text object of the first column heading.
6. Shift-click each of the remaining column heading text objects.
7. Click the **Align Bottom Edges** button in the toolbar.

   The bottom edges of all the column headings are aligned with the first column heading.

8. Click the **Distribute Objects Horizontally** button in the toolbar.

   The column heading text objects are evenly distributed between the first and last column heading.

9. Below the column heading text objects, create a text object for each column value in the first row of the table.

10. Use the **Selection** tool to select the text object of the first column value.

11. Shift-click each of the remaining column value text objects.
12. Click the **Align Bottom Edges** button in the toolbar.

The bottom edges of all the column values are aligned with the first column value.

13. To create additional table rows, repeat steps 9 to 12.

14. Use the **Selection** tool to select the text object of the first column heading.

15. Shift-click each of the remaining text objects in the first column of the table.

16. Click the **Align Left Edges** button in the toolbar.

The left edges of all the text objects in the first column of the table are aligned with the first column heading.
17. Click the **Distribute Objects Vertically** button in the toolbar.

All the text objects in the first column of the table are evenly distributed between the column heading and the last table row.

18. For each of the remaining table columns, repeat steps 14 to 17.

For More Information on...
- creating text objects, refer to the procedure “Create a Text Object” on page 5–2.
Apply a Material to a Text Object

1. Select the characters in the text object to apply a material.

2. Use the Display menu to select Material Manager.
   The Material Manager window opens.

3. In the Face column, select one or more text elements to apply a material.
   After selecting the initial text element, Shift-click another element to select all elements between the two selections or Ctrl-click individual elements to add them to the original selection.

4. Select the thumbnail of the material to apply to the selected text.
5. Double click the thumbnail to apply the selected material to the selected text.
   The selected text elements of the selected text are updated with the selected material. The applied material does not affect the text font style.

6. To remove an applied material from a text element, Right-click the text element name in the **Face** column and select **Unbind** from the shortcut menu.
   The selected text element reverts to the material used by the text font style.

**For More Information on...**
- how to add a text object to a scene, refer to the procedure “Create a Text Object” on page 5–2.
Apply Word Wrap to a Text Object

Word wrap enables the length of a text object to be adjusted so that the text will continue on a new line accordingly.

★ Tabs are disabled when word wrap is enabled.

1. Create a text object or open a scene or scene group that includes a text object.

2. In the **Object Manager**, select the text object from the **Object** list.

3. In the **Object Inspector**, select the **Tabs & Options** tab.
   The **Tabs & Options** tab opens.

4. In the **Word Wrap** section, select the **Enabled** check box to apply word wrap to the text object.
5. Use the Fixed Width box to enter or select an amount to adjust the width of the text object and set the location where the line of text ends before the text continues on a new line.

The width can also be adjusted by clicking and dragging the handle at the end of the text object.

For More Information on...
- how to add a text object to a scene, refer to the procedure “Create a Text Object” on page 5–2.
Create a Background Object

1. In the Scene Manager window, select the scene or scene group to add a background object. The selected scene or scene group is displayed in the active Viewport.

2. In the Base Objects section of the Object Library window, click the Background button. A new background object is added to the active Viewport.

3. In the Object Inspector - Background Object window, click the Background tab. The Background tab opens.

4. In the Background tab, use the Options section to configure the dimensions of the background object.

5. To move the background object to a new position in the Viewport, place the cursor on the background object, press the Ctrl key, then click and drag the background object to a new position.
The settings on the **Transform** tab of the **Object Inspector - Background Object** window can be used to precisely position a background object.

6. In the **Object Inspector - Background Object** window, click the **Materials** tab.
   
The **Materials** tab opens.

7. Double-click the thumbnail of the material to apply to the background.
   
The background is updated with the selected material.

8. To remove an applied material from a background object, right-click the text element name in the **Face** column and select **Unbind** from the shortcut menu.
   
The background object reverts to no applied material.

**For More Information on...**

- adding continuous animation to an object, refer to the section “**Add Continuous Animation to an Object**” on page 15–2.
Mesh Objects

XPression can build a graphic creation using 3D models imported from external 3D applications.
The following topic is discussed in this section:
• Import a 3D or OBJ Model into a Scene
Import a 3D or OBJ Model into a Scene

1. In the **Scene Manager** window, select the scene or scene group to add a 3D or OBJ model object.
   The selected scene or scene group is displayed in the active **Viewport**.

2. In the **Primitives** section of the **Object Library** window, click the **3D Model** button.
   The **Open** dialog box opens.

3. Use the **Open** dialog box to locate and select the 3D or OBJ model file to import into the current scene.
   3D and OBJ model files are created using applications outside of XPression.

4. Click **Open**.
   The **XPression Model Importer** dialog box opens.

5. In the **Node Tree** section, expand the model folder.
   The components of the model are displayed.

6. Clear the check box to the left of each component to not import.

7. Click **Import**.
The model is imported into XPression and placed at the center of the active Viewport.

8. In the Viewport, select the model.
The selected model is highlighted. Depending on how the model was built, clicking on the model selects the entire model or just a component of the model.

9. Use the Display menu to select Material Manager.
The Material Manager window opens.
10. In the **Face** column, select one or more of the elements from the selected model or component to apply a material.

After selecting the initial element, Shift-click another element to select all elements between the two selections or Ctrl-click individual elements to add them to the original selection.

11. Double-click the thumbnail of the material to apply to the model or component.

The selected elements are updated with the selected material.

12. To remove an applied material from an element, Right-click the element name in the **Face** column and select **Unbind** from the shortcut menu.

All material is removed from the selected element.

13. To move the model object to a new position in the **Viewport**, select the main 3D Object in the **Object Manager**, press the Ctrl key, then click and drag the model object to a new position.
To precisely position the model object, use the settings on the **Transform** tab of the **Object Inspector - Model 3D Object** window.
Primitives

The primitives available in XPression to build a graphic creation include quads, spheres, cubes, cylinders, and tori. The following topics are discussed in this section:

- Create a Quad Object
- Create a Sphere Object
- Create a Cube Object
- Set the Culling Mode for a Cube Object
- Create a Cylinder Object
- Create a Torus Object
Create a Quad Object

1. In the Scene Manager window, select the scene or scene group to add a quad object. The selected scene or scene group is displayed in the active Viewport.

2. In the Primitives section of the Object Library window, click the Quad button. A new quad object is added to the center of the active Viewport.

![Quad Object](image)

The new quad object is invisible until a material applied to it.

3. In the Object Inspector - Quad Object window, click the Quad tab.

4. In the Options section, use the Width box to enter or select a value in pixels to set the width of the quad object.

5. In the Height box, enter or select a value in pixels to set the height of the quad object.

   Select the Lock Aspect check box to maintain the aspect ratio between the width and height of a quad object when changing the value in the Width or Height box.

6. In the Tesselation box, enter or select the number of vertices used to construct a quad object.

7. Use the Auto Size menu to select one of the following auto-size options for the quad object:
   - Disabled — select this option to disable auto-sizing of the quad object.
   - On Material Assign Only — select this to automatically resize the dimensions of a quad object to the size of the material applied to the quad object at the time the material is assigned.
   - On Material Resize — select this to automatically resize the dimensions of a quad object when an applied material assigned to the quad object is resized.
8. Use the **Display** menu to select **Material Manager**.

   The **Material Manager** window opens.

![Material Manager Window]

9. Double-click the thumbnail of the material to apply to the quad object.

   The surface of the quad object is covered with the selected material.

![Quad Object with Material Applied]

10. To remove the material from a quad object, Right-click the quad object name in the **Face** column and select **Unbind** from the shortcut menu.

    Without a material, quad objects are displayed as a wire frame mesh.
11. To move the quad object to a new position in the Viewport, place the cursor on the quad object, press the Ctrl key, then click and drag the quad object to a new position.

To precisely position the quad object, use the settings on the Transform tab of the Object Inspector - Quad Object window.
Create a Sphere Object

1. In the **Scene Manager** window, select the scene or scene group to add a sphere object. The selected scene or scene group is displayed in the active **Viewport**.

2. In the **Primitives** section of the **Object Library** window, click the **Sphere** button. A new sphere object is added to the center of the active **Viewport**.

   ![](image1)

   The new sphere object is invisible until a material applied to it.

3. In the **Object Inspector - Quad Sphere** window, click the **Sphere** tab.

   The **Sphere** tab opens.

4. In the **Options** section, use the **Diameter** box to enter or select a value in pixels to set the diameter of the sphere object.

5. In the **Tessellation** box, enter or select the number of vertices used to construct the sphere object.

   The number of vertices used to construct a sphere object is directly related to the quality and smoothness of the sphere object. More vertices equals a higher quality sphere object with a smoother surface, but may compromise output performance.

6. Use the **Display** menu to select **Material Manager**.

   ![](image2)
The Material Manager window opens.

7. Double-click the thumbnail of the material to apply to the sphere object.
   The surface of the sphere object is covered with the selected material.

8. To remove the material from the sphere object, Right-click the sphere object name in the Face column and select Unbind from the shortcut menu.
   Without a material, sphere objects are displayed as a wire frame mesh.
9. To move the sphere object to a new position in the **Viewport**, place the cursor on the sphere object, press the **Ctrl** key, then click and drag the sphere object to a new position.

To precisely position a sphere object, use the settings on the **Transform** tab of the **Object Inspector - Sphere Object** window.
Create a Cube Object

1. In the **Scene Manager** window, select the scene or scene group to add a cube object. The selected scene or scene group is displayed in the active **Viewport**.

2. In the **Primitives** section of the **Object Library** window, click the **Cube** button.

   A new cube object is added to the center of the active **Viewport**.

   ![Cube Object](image)

   The new cube object is invisible until a material applied to it.

3. In the **Object Inspector - Cube Object** window, click the **Cube** tab.

   The **Cube** tab opens.

   ![Object Inspector - Cube Object](image)

4. In the **Options** section, use the **Width** box to enter or select a value in pixels to set the width of the cube object.

5. In the **Height** box, enter or select a value in pixels to set the height of the cube object.

6. In the **Depth** box, enter or select a value in pixels to set the depth of the cube object.

   Select the **Lock Aspect** check box to maintain the aspect ratio between the width, height, and depth of a cube object when changing the value in the **Width**, **Height**, or **Depth** box.

7. Use the **Display** menu to select **Material Manager**.
The **Material Manager** window opens.

8. In the **Face** column, select one or more cube faces to apply a material.
   After selecting the initial cube face, Shift-click another face to select all faces between the two selections or Ctrl-click individual faces to add them to the original selection.

9. Double-click the thumbnail of the material to apply to the cube object.
   The selected cube faces are covered with the selected material.

10. To remove the material from a cube face, Right-click the cube face in the **Face** column and select **Unbind** from the shortcut menu.
    Without a material, cube faces are displayed as a wire frame mesh.
11. To move the cube object to a new position in the Viewport, place the cursor on the cube object, press the Ctrl key, then click and drag the cube object to a new position.

To precisely position a cube object, use the settings on the Transform tab of the Object Inspector - Cube Object window.
Set the Culling Mode for a Cube Object

1. Add a cube object to a scene.

2. Select the new cube object.

3. Click the Rendering tab in the Object Inspector - Cube Object window.

   The Rendering tab opens.

4. Use the Culling Mode list to select the culling mode for the selected cube object. The available culling modes are as follows:
   - None — do not cull back faces of a cube. This mode renders all faces of a cube object, even the faces that are not visible.
   - Clockwise — cull the back faces of a cube object that have clockwise vertices. In this mode, material is applied to the inside of a cube object.
   - Counter Clockwise — cull the back faces of a cube object that have counter clockwise vertices. In this mode, material is applied to the outside of a cube object.

   The Clockwise and Counter Clockwise culling modes decrease the time required to render a scene.

5. Use the Depth Writes list to control whether or not to render the hidden parts of a cube object. The available options are as follows:
   - Enabled — do not display the hidden parts of a cube object.
   - Disabled — display the hidden parts of a cube object.
   - Automatic — use the set rendering method to control determine whether or not to display the hidden parts of a cube object.

6. Select the Depth Testing check box to use depth values to determine whether an object is displayed on top or behind other objects.

7. Clear this check box to disable depth testing and use the render order of an object to determine whether an object is displayed on top or behind other objects.

For More Information on...
- how to add a cube object to a scene, refer to the procedure “Create a Cube Object” on page 7–8.
Create a Cylinder Object

1. In the **Scene Manager** window, select the scene or scene group to add a cylinder object. The selected scene or scene group is displayed in the active **Viewport**.

2. In the **Primitives** section of the **Object Library** window, click the **Cylinder** button. A new cylinder object is added to the center of the active **Viewport**.

3. In the **Object Inspector - Cylinder Object** window, click the **Cylinder** tab.

   The new cylinder object is invisible until a material is applied to it.

4. In the **Options** section, use the **Diameter 1** box and **Diameter 2** box to enter or select a value in pixels to set the diameters of the cylinder object.

   Select the **Lock Aspect** check box to maintain the aspect ratio between the diameters of a cylinder object when changing the value in the **Diameter 1** or **Diameter 2** box.

5. In the **Length** box, enter or select a value in pixels to set the length of the cylinder object.

6. Use the **Start Angle** box and **End** box to enter or select a value in degrees for the start and end of the angle relative to the X axis of the cylinder object.

7. In the **Tesselation** box, enter or select a number of vertices to construct the cylinder object.

8. Select the **End Caps** check box to add a Face to the ends of the cylinder object.

9. Use the **Display** menu to select **Material Manager**.
The Material Manager window opens.

10. In the Face column, select one or more cylinder faces to apply a material. After selecting the initial cylinder face, Shift-click another face to select all faces between the two selections or Ctrl-click individual faces to add them to the original selection.

11. Double-click the thumbnail of the material to apply to the cylinder object. The selected cylinder faces are covered with the selected material.

12. To remove the material from a cylinder face, Right-click the cylinder face in the Face column and select Unbind from the shortcut menu. Without a material, cylinder faces are displayed as a wire frame mesh.
13. To move the cylinder object to a new position in the **Viewport**, place the cursor on the cylinder object, press the **Ctrl** key, then click and drag the cylinder object to a new position.

To precisely position a cylinder object, use the settings on the **Transform** tab of the **Object Inspector - Cylinder Object** window.
Create a Torus Object

1. In the Scene Manager window, select the scene or scene group to add a torus object. The selected scene or scene group is displayed in the active Viewport.

2. In the Primitives section of the Object Library window, click the Torus button. A new torus object is added to the center of the active Viewport.

   The new torus object is invisible until a material applied to it.

3. In the Object Inspector - Torus Object window, click the Torus tab.
   The Torus tab opens.

   ![Torus tab](image)

4. In the Options section, use the Main Diameter box to enter or select a value in pixels to set the diameter of the center of the torus object.

5. In the Tube Diameter box, enter or select a value in pixels to set the diameter of the tube of the torus object.

6. In the Tesselation box, enter or select a number of vertices to construct the torus object.

7. Use the Display menu to select Material Manager.
The **Material Manager** window opens.

![Material Manager window](image)

8. Double-click the thumbnail of the material to apply to the torus object.

   The torus face is covered with the selected material.

![Torus with material](image)

9. To remove the material from a torus face, Right-click the torus face in the **Face** column and select **Unbind** from the shortcut menu.

   Without a material, the torus face is displayed as a wire frame mesh.

![Torus without material](image)
10. To move the torus object to a new position in the Viewport, place the cursor on the torus object, press the Ctrl key, then click and drag the torus object to a new position.

To precisely position a torus object, use the settings on the Transform tab of the Object Inspector - Torus Object window.
Lights

The objects in an XPression scene are made visible by the light emitted by directional, point, and spot light objects.

The following topics are discussed in this section:

- Add a Directional Light Source to a Scene
- Add a Point Light Source to a Scene
- Add a Spot Light Source to a Scene
Add a Directional Light Source to a Scene

1. In the **Scene Manager** window, select the scene or scene group to add a directional light source.
   The selected scene or scene group is displayed in the active **Viewport**.

2. In the **Primitives** section of the **Object Library** window, click the **Directional Light** button.
   A new directional light object (center dot) is added to the center of the active **Viewport**.

   ![Image of a directional light source in a scene]

   Optionally, when adding a light object, hold **Shift** to keep the light object from automatically binding to the current scene objects.

3. In the **Object Inspector - Light Object** window, click the **Directional Light** tab.
   The **Directional Light** tab opens.

4. Click **Diffuse** to set the color of light projected by the directional light object.
   The diffuse color is set using the color controls to the right.

5. Use the **Color Mode** list at the far right to select the color definition mode. The available modes are as follows:
   - **HSL** — define color by setting hue, saturation, and lightness values.
   - **RGB** — define color by setting red, green, and blue values.

6. Use the selected color definition mode to set the diffuse color.
   **HSL Color Selection Mode**
   a. Select the **H** option, then use one of the following methods to set the hue value for the new color:
      - Place the slider along the hue scale to set the hue value.
      - In the box to the right of the **H** option, enter or select the hue value (0 to 359).
      After setting the **H** value, the **S** and **L** color values can be set by clicking a color in the **Color Box**.
   b. Select the **S** option, then use one of the following methods to set the saturation value for the new color:
      - Place the slider along the saturation scale to set the saturation value.
• In the box to the right of the **S** option, enter or select the saturation value (0 to 100).

After setting the **S** value, the **H** and **L** color values can be set by clicking a color in the **Color Box**.

c. Select the **L** option, then use one of the following methods to set the lightness value for the new color:

- Place the slider along the lightness scale to set the lightness value.
- In the box to the right of the **L** option, enter or select the lightness value (0 to 100).

After setting the **L** value, the **S** and **H** color values can be set by clicking a color in the **Color Box**.

To select a color on the screen as the new color, click and drag the eye dropper icon to a color on the screen then release the mouse button. The **H**, **S**, and **L** color values are set to match the color selected from the screen.

**RGB Color Selection Mode**

a. Select the **R** option, then use one of the following methods to set the red value for the new color:

- Place the slider along the red scale to set the red value.
- In the box to the right of the **R** option, enter or select the red value (0 to 255).

After setting the **R** value, the **G** and **B** color values can be set by clicking a color in the **Color Box**.

b. Select the **G** option, then use one of the following methods to set the green value for the new color:

- Place the slider along the green scale to set the green value.
- In the box to the right of the **G** option, enter or select the green value (0 to 255).

After setting the **G** value, the **R** and **B** color values can be set by clicking a color in the **Color Box**.

c. Select the **B** option, then use one of the following methods to set the blue value for the new color:

- Place the slider along the blue scale to set the blue value.
- In the box to the right of the **B** option, enter or select the blue value (0 to 255).

After setting the **B** value, the **R** and **G** color values can be set by clicking a color in the **Color Box**.

To select a color on the screen as the new color, click and drag the **Dropper Tool** to a color on the screen then release the mouse button. The **R**, **G**, and **B** color values are set to match the color selected from the screen.

7. Click **Ambient** to set the color of the light from other sources that blends with the directional light.

Follow steps 5 and 6 to set the ambient color for the directional light object.

8. Click **Specular** to set the color of light emitted by an object on which the directional light shines.

Follow steps 5 and 6 to set the ambient color for the directional light object.

9. To move the directional light to a new position in the **Viewport**, place the cursor on the directional light object, press the **Ctrl** key, then click and drag the directional light object to a new position.

To precisely position the directional light object, use the settings on the **Transform** tab of the **Object Inspector - Light Object** window.
Add a Point Light Source to a Scene

1. In the Scene Manager window, select the scene or scene group to add a point light source. The selected scene or scene group is displayed in the active Viewport.

2. In the Primitives section of the Object Library window, click the Point Light button. A new point light object (center dot) is added to the center of the active Viewport.

Optionally, when adding a light object, hold Shift to keep the light object from automatically binding to the current scene objects.

3. In the Object Inspector - Light Object window, click the Point Light tab. The Point Light tab opens.

4. In the Light section, use the Falloff box to enter or select the intensity of light as it spreads out from the point light object.

5. In the Range box, enter or select the overall size in pixels that is lit by the point light object.

6. In the Attenuation section, use the Constant box to enter or select the constant attenuation factor for the gradual loss in intensity for the point light object. The default value is 1.

7. In the Linear box, enter or select the linear attenuation factor times the distance between the light and the vertex being illuminated. The default value is 0.

8. In the Quadratic box, enter or select the quadratic attenuation factor times the square of the distance between the light and vertex. The default value is 0.

9. In the Color section, click Diffuse to set the color of light projected by the point light object. The diffuse color is set using the color controls to the right.

10. Use the Color Mode list at the far right to select the color definition mode. The available modes are as follows:
   - HSL — define color by setting hue, saturation, and lightness values.
   - RGB — define color by setting red, green, and blue values.
11. Use the selected color definition mode to set the diffuse color.

HSL Color Selection Mode

a. Select the H option, then use one of the following methods to set the hue value for the new color:
   • Place the slider along the hue scale to set the hue value.
   • In the box to the right of the H option, enter or select the hue value (0 to 359).
   After setting the H value, the S and L color values can be set by clicking a color in the Color Box.

b. Select the S option, then use one of the following methods to set the saturation value for the new color:
   • Place the slider along the saturation scale to set the saturation value.
   • In the box to the right of the S option, enter or select the saturation value (0 to 100).
   After setting the S value, the H and L color values can be set by clicking a color in the Color Box.

c. Select the L option, then use one of the following methods to set the lightness value for the new color:
   • Place the slider along the lightness scale to set the lightness value.
   • In the box to the right of the L option, enter or select the lightness value (0 to 100).
   After setting the L value, the S and H color values can be set by clicking a color in the Color Box.

To select a color on the screen as the new color, click and drag the eye dropper icon to a color on the screen then release the mouse button. The H, S, and L color values are set to match the color selected from the screen.

RGB Color Selection Mode

a. Select the R option, then use one of the following methods to set the red value for the new color:
   • Place the slider along the red scale to set the red value.
   • In the box to the right of the R option, enter or select the red value (0 to 255).
   After setting the R value, the G and B color values can be set by clicking a color in the Color Box.

b. Select the G option, then use one of the following methods to set the green value for the new color:
   • Place the slider along the green scale to set the green value.
   • In the box to the right of the G option, enter or select the green value (0 to 255).
   After setting the G value, the R and B color values can be set by clicking a color in the Color Box.

c. Select the B option, then use one of the following methods to set the blue value for the new color:
   • Place the slider along the blue scale to set the blue value.
   • In the box to the right of the B option, enter or select the blue value (0 to 255).
   After setting the B value, the R and G color values can be set by clicking a color in the Color Box.

To select a color on the screen as the new color, click and drag the eye dropper icon to a color on the screen then release the mouse button. The R, G, and B color values are set to match the color selected from the screen.

12. Click Ambient to set the color of the light from other sources that blends with the point light.

   Follow steps 10 and 11 to set the ambient color for the point light object.

13. Click Specular to set the color of light emitted by an object on which the point light shines.

   Follow steps 10 and 11 to set the ambient color for the point light object.

14. To move the point light to a new position in the Viewport, place the cursor on the point light object, press the Ctrl key, then click and drag the point light object to a new position.
To precisely position the point light object, use the settings on the **Transform** tab of the **Object Inspector - Light Object** window.
Add a Spot Light Source to a Scene

1. In the **Scene Manager** window, select the scene or scene group to add a spot light source.
   The selected scene or scene group is displayed in the active **Viewport**.

2. In the **Primitives** section of the **Object Library** window, click the **Spot Light** button.
   A new spot light object (center dot) is added to the center of the active **Viewport**.

   ![Spot Light in Viewport]

   * Optionally, when adding a light object, hold **Shift** to keep the light object from automatically binding to the current scene objects.

3. In the **Object Inspector - Light Object** window, click the **Spot Light** tab.
   The **Spot Light** tab opens.

   ![Object Inspector - Light Object]

4. In the **Light** section, use the **Falloff** box to enter or select the intensity of light as it spreads out from the spot light object.

5. In the **Range** box, enter or select the overall size in pixels that is lit by the spot light object.

6. In the **Spotlight Cone** section, use the **Inner Angle** to enter or select the size in degrees of the inner light (beam) emitted from the spot light object. Inner angle values range from 0 to 180 degrees.

7. In the **Outer Angle** box, enter or select the size in degrees of the outer light (blur light) emitted from the spot light object. Outer angle values range from 0 to 180 degrees.
   In order to display the entire the outer angle, this value must be less than the value set for the Range box in the Light section.

8. In the **Color** section, click **Diffuse** to set the color of light projected by the spot light object.
   The diffuse color is set using the color controls to the right.

9. Use the **Color Mode** list at the far right to select the color definition mode. The available modes are as follows:
   - **HSL** — define color by setting hue, saturation, and lightness values.
   - **RGB** — define color by setting red, green, and blue values.
10. Use the selected color definition mode to set the diffuse color.

HSL Color Selection Mode

a. Select the **H** option, then use one of the following methods to set the hue value for the new color:
   - Place the slider along the hue scale to set the hue value.
   - In the box to the right of the **H** option, enter or select the hue value (0 to 359).

   After setting the **H** value, the **S** and **L** color values can be set by clicking a color in the **Color Box**.

b. Select the **S** option, then use one of the following methods to set the saturation value for the new color:
   - Place the slider along the saturation scale to set the saturation value.
   - In the box to the right of the **S** option, enter or select the saturation value (0 to 100).

   After setting the **S** value, the **H** and **L** color values can be set by clicking a color in the **Color Box**.

c. Select the **L** option, then use one of the following methods to set the lightness value for the new color:
   - Place the slider along the lightness scale to set the lightness value.
   - In the box to the right of the **L** option, enter or select the lightness value (0 to 100).

   After setting the **L** value, the **S** and **H** color values can be set by clicking a color in the **Color Box**.

To select a color on the screen as the new color, click and drag the eye dropper icon to a color on the screen then release the mouse button. The **H**, **S**, and **L** color values are set to match the color selected from the screen.

RGB Color Selection Mode

a. Select the **R** option, then use one of the following methods to set the red value for the new color:
   - Place the slider along the red scale to set the red value.
   - In the box to the right of the **R** option, enter or select the red value (0 to 255).

   After setting the **R** value, the **G** and **B** color values can be set by clicking a color in the **Color Box**.

b. Select the **G** option, then use one of the following methods to set the green value for the new color:
   - Place the slider along the green scale to set the green value.
   - In the box to the right of the **G** option, enter or select the green value (0 to 255).

   After setting the **G** value, the **R** and **B** color values can be set by clicking a color in the **Color Box**.

c. Select the **B** option, then use one of the following methods to set the blue value for the new color:
   - Place the slider along the blue scale to set the blue value.
   - In the box to the right of the **B** option, enter or select the blue value (0 to 255).

   After setting the **B** value, the **R** and **G** color values can be set by clicking a color in the **Color Box**.

To select a color on the screen as the new color, click and drag the eye dropper icon to a color on the screen then release the mouse button. The **R**, **G**, and **B** color values are set to match the color selected from the screen.

11. Click **Ambient** to set the color of the light from other sources that blends with the spot light.

   Follow steps 9 and 10 to set the ambient color for the spot light object.

12. Click **Specular** to set the color of light emitted by an object on which the spot light shines.

   Follow steps 9 and 10 to set the ambient color for the spot light object.

13. To move the spot light to a new position in the **Viewport**, place the cursor on the spot light object, press the **Ctrl** key, then click and drag the spot light object to a new position.
To precisely position the spot light object, use the settings on the Transform tab of the Object Inspector - Light Object window.
Cameras

The point of view for an XPression scene is set by a camera object. The following topic is discussed in this section:

• Add a Perspective Camera to a Scene
• Add an Orthographic Camera to a Scene
Add a Perspective Camera to a Scene

A perspective camera provides the possibility to view the scene from a different angle.

1. In the **Scene Manager** window, select the scene or scene group to add a perspective camera object.
   
The selected scene or scene group is displayed in the active **Viewport**.

2. In the **Cameras** section of the **Object Library** window, click the **Persp. Camera** button.
   
A new perspective camera object is added to the center of the active **Viewport**.

3. In the **Object Inspector - Perspective Camera Object** window, click the **Camera** tab.
   
The **Camera** tab opens.

4. In the **Position** section, enter coordinates in the **X**, **Y**, and **Z** boxes to set the position of the perspective camera object in scene.

5. In the **Direction** section, click one of the following tabs to set the direction of view for the perspective camera object:
   
   - **Direction** — set the direction of view by setting the orientation of the perspective camera object.
   - **Fixed** — set the direction of view by pointing the perspective camera object at a fixed point.
   - **Object** — set the direction of view by pointing the perspective camera object at an object in the scene.

6. Use the selected **Direction** tab to set the direction of view for the perspective camera object.

   **Direction**

   Use the settings in this section to set the direction that the camera observes by orienting the perspective camera object.

   a. In the **Tilt** box, enter or select the degrees to rotate the perspective camera object upwards or downwards, around the X axis. Positive angles point the perspective camera object view upwards, while negative angles point the perspective camera object view downwards.
b. In the **Pan** box, enter or select the degrees to rotate the perspective camera object to the right or left, around the Y axis. Positive angles point the perspective camera object view to the right, while negative angles point the perspective camera object view to the left.

c. In the **Rotate** box, enter or select the degrees to twist the perspective camera object to the right or left, around the Z axis. Positive angles twist the perspective camera object view to the right, while negative angles twist the perspective camera object view to the left.

d. Use the **Rotation Order** list to select the mathematical sequence for the rotation of the object.

**Fixed**

Use the settings in this section to set the fixed point to always face the perspective camera object.

a. In the **X** box, enter or select the X coordinate in pixels of the fixed point to face the perspective camera object.

b. In the **Y** box, enter or select the Y coordinate in pixels of the fixed point to face the perspective camera object.

c. In the **Z** box, enter or select the Z coordinate in pixels of the fixed point to face the perspective camera object.

d. In the **Rotate** box, enter or select the degrees to twist the view of perspective camera object to the right or left, around the Z axis. Positive angles twist the perspective camera object view to the right, while negative angles twist the perspective camera object view to the left.

**Object**

Use this section to select the object to always face the perspective camera object.

a. Use the **Object** list to select the object to face the perspective camera object.

7. In the **Pivot** section, set the pivot point of a perspective camera object.

a. In the **X**, **Y**, and **Z** boxes, enter or select the X, Y, and Z coordinates for the perspective camera object pivot point.

b. Select one of the following:
   - Click the **Center** button to set the pivot point from the center of the X, Y, and Z coordinate.
   - Click the **X** button to pivot from the X axis.
   - Click the **Y** button to pivot from the Y axis.
   - Click the **Z** button to pivot from the Z axis.

8. In the **Lens** section, set the field of view for a perspective camera object.

a. In the **FOV (degr.)** box, enter or select the field of view value in degrees for a perspective camera object. The default value is 45 degrees.

   Click the **Horizontal FOV** button to switch to a horizontal field of vision for the camera object. Vertical field of vision is the default.

b. In the **Aspect** box, enter or select the aspect ratio for the camera. This acts as a multiplier of the current aspect ratio of the project.

c. In the **Near** box, enter or select the distance in pixels from the viewer to the nearest clipping plane. This distance is always positive.

d. In the **Far** box, enter or select the distance in pixels from the viewer to the farthest clipping plane. This distance is always positive.
e. In the **Distortion/Correction** area, select the **Enabled** check box if you want to apply a distortion/correction to the perspective camera object. If applied, configure the following:

- **1st Order** — in this box, enter or select a value to create and adjust a barrel-shaped distortion/correction.
- **2nd Order** — in this box, enter or select a value to create or adjust a pin cushion-shaped distortion/correction.
- **3rd Order** — in this box, enter or select a value to create or adjust a distortion/correction combining the 1st Order in the middle with the 2nd Order around the edges.

f. In the **CCD Chip Size/Offset** area, configure the following settings charge-coupled device settings if needed:

- In the **Width** box, enter or select the width in millimeters of the charge-coupled device chip.
- In the **Height** box, enter or select the height in millimeters of the charge-coupled device chip.
- In the **H Offset** box, enter or select the horizontal charge-coupled device offset in pixels.
- In the **V Offset** box, enter or select the vertical charge-coupled device offset in pixels.

🌟 The CCD size for a perspective camera will be used for calculating the aspect ratio of the camera.

🌟 When the CCD size is not set, the CCD offset will be in pixels and the 3rd order lens correction parameter will be enabled.

9. In the **Flags** section, select the **Active** check box to activate the selected perspective camera object for a scene and use it to view the scene.

The new perspective camera object is set as the active camera object for the scene. Only one camera object can be active in a scene at any time.

The following check boxes can also be applied to the perspective camera object if needed:

- Select the **Show Crosshair** check box to enable a crosshair when setting the CCD offset.
- Select the **Global Camera** check box so that when the camera is active its position is dictated by the coordinates of the global camera.

10. Double-click the scene containing the perspective camera object.

The selected scene is sent to the default output, and displayed using the active perspective camera object.
Add an Orthographic Camera to a Scene

The view from an orthographic camera results in a flat display (no perspective) of the scene.

1. In the **Scene Manager** window, select the scene or scene group to add an orthographic camera object. The selected scene or scene group is displayed in the active **Viewport**.

2. In the **Cameras** section of the **Object Library** window, click the **Ortho. Camera** button. A new orthographic camera object is added to the center of the active **Viewport**.

3. In the **Object Inspector - Orthographic Camera Object** window, click the **Camera** tab. The **Camera** tab opens.

4. In the **Position** section, enter coordinates in the **X**, **Y**, and **Z** boxes to set the position of the orthographic camera object in scene.

5. In the **Direction** section, click one of the following tabs to set the direction of view for the orthographic camera object:
   - **Direction** — set the direction of view by setting the orientation of the orthographic camera object.
   - **Fixed** — set the direction of view by pointing the orthographic camera object at a fixed point.
   - **Object** — set the direction of view by pointing the orthographic camera object at an object in the scene.

6. Use the selected **Direction** tab to set the direction of view for the orthographic camera object.

   **Direction**

   Use the settings in this section to set the direction that the camera observes by orienting the orthographic camera object.

   **a.** In the **Tilt** box, enter or select the degrees to rotate the orthographic camera object upwards or downwards, around the X axis. Positive angles point the orthographic camera object view upwards, while negative angles point the orthographic camera object view downwards.
b. In the Pan box, enter or select the degrees to rotate the orthographic camera object to the right or left, around the Y axis. Positive angles point the orthographic camera object view to the right, while negative angles point the orthographic camera object view to the left.

c. In the Rotate box, enter or select the degrees to twist the orthographic camera object to the right or left, around the Z axis. Positive angles twist the orthographic camera object view to the right, while negative angles twist the orthographic camera object view to the left.

d. Use the Rotation Order list to select the mathematical sequence for the rotation of the object.

Position

Use the settings in this section to set the position to face the orthographic camera object.

a. In the X box, enter or select the X coordinate in pixels of the position to face the orthographic camera object.

b. In the Y box, enter or select the Y coordinate in pixels of the position to face the orthographic camera object.

c. In the Z box, enter or select the Z coordinate in pixels of the position to face the orthographic camera object.

d. In the Rotation box, enter or select the degrees to twist the view of orthographic camera object to the right or left, around the Z axis. Positive angles twist the orthographic camera object view to the right, while negative angles twist the orthographic camera object view to the left.

Object

Use this section to select the object to always face the orthographic camera object.

a. Use the Object list to select the object to face the orthographic camera object.

7. In the Flags section, select the Active check box.

The new orthographic camera object is set as the active camera object for the scene. Only one camera object can be active in a scene at any time.

8. Double-click the scene containing the orthographic camera object.

The selected scene is sent to the default output, and displayed using the active orthographic camera object.
Layers

Layers are used to render a group of objects together but separately from other objects or layers. For example, use layers to mask a group of objects without masking other objects or layers.

The following topic is discussed in this section:

• Add a Layer Object to a Scene
• Add a Camera Layer Object to a Scene
Add a Layer Object to a Scene

Layers are used to render a group of objects together but separately from other objects or layers.

1. In the Scene Manager window, select the scene or scene group to add a layer object.
   The selected scene or scene group is displayed in the active Main Viewport.

2. In the Layers section of the Object Library window, click the Layer Object button.
   A new layer object is added to the scene or scene group in the Object Manager.

3. In the Object Inspector - Layer Object window, click the Rendering tab.
   The Rendering tab opens.

4. In the Depth Sorting section, set the rendering properties for the layer object by selecting one of the following:
   • Automatic — select this radio button to use the Z value to determine the layering.
   • Manual — select this radio button to use the order of the objects in the Object Manager to determine the layering.
   • Back To Front — select this radio button to use the order of the objects from back to front to determine the layering.
   • Front To Back — select this radio button to use the order of the objects from front to back to determine the layering.

5. Add objects to the scene or scene group as needed.

6. In the Object column of the Object Manager window, click and hold the left mouse button on an object to add to the new layer object.

7. Drag the selected object to the new layer object.
8. Release the left mouse button.

The selected object is added to the new layer object. Objects contained in a layer object are indented and connected to the layer object by a leader line.

The **Right** and **Left Arrow** buttons in the toolbar can also be used to move an object into and out of layers.

* If the scene uses more than one layer object, you can order the various layer objects using the **Layer Order** tab in the **Object Inspector - Layer Object** window.

**For More Information on...**
- creating a scene, refer to the procedure “**Create a Scene**” on page 4–4.
- creating a scene group, refer to the procedure “**Create a Scene Group**” on page 4–11.
Add a Camera Layer Object to a Scene

Camera layers are used to view a group of objects together from a different angle but separately from other objects or layers.

1. In the **Scene Manager** window, select the scene or scene group to add a camera layer object.
   The selected scene or scene group is displayed in the active **Main Viewport**.

2. In the **Layers** section of the **Object Library** window, click the **Camera Layer** button.
   A new camera layer object is added to the scene or scene group in the **Object Manager**.

3. In the **Object Inspector - Camera Layer Object** window, click the **Rendering** tab.
   The **Rendering** tab opens.

4. In the **Depth Sorting** section, set the rendering properties for the camera layer by selecting one of the following:
   - **Automatic** — select this radio button to use the Z value to determine the layering.
   - **Manual** — select this radio button to use the order of the objects in the Object Manager to determine the layering.
   - **Back To Front** — select this radio button to use the order of the objects from back to front to determine the layering.
   - **Front To Back** — select this radio button to use the order of the objects from front to back to determine the layering.

5. In the **Default Scene Camera** section, set the camera properties for the camera layer by performing the following:
   - **Mode** — use the menu to select one of the following:
     - **Perspective** — select this to provide the possibility to view the scene from a different angle.
     - **Orthogonal** — select this to view the scene in a flat display (no perspective).
   - **FOV** — in this box, enter or select the field of view value in degrees for the camera layer. The default value is 45 degrees.
   - **Aspect** — in this box, enter or select the aspect ration for the camera.
• **Near** — in this box, enter or select the distance in pixels from the viewer to the nearest clipping plane. This distance is always positive.

• **Far** — in this box, enter or select the distance in pixels from the viewer to the farthest clipping plane. This distance is always positive.

6. Add objects to the scene or scene group as needed.

7. In the **Object** column of the **Object Manager** window, click and hold the left mouse button on an object to add to the new camera layer object.

8. Drag the selected object to the new camera layer object.

9. Release the left mouse button.

   The selected object is added to the new camera layer object. Objects contained in a camera layer object are indented and connected to the camera layer object by a leader line.

   ![Object Manager](image)

   The **Right** and **Left Arrow** buttons in the toolbar can also be used to move an object into and out of layers.

**For More Information on...**

• creating a scene, refer to the procedure “Create a Scene” on page 4–4.

• creating a scene group, refer to the procedure “Create a Scene Group” on page 4–11.
Markers

An event marker object is used to perform an action when the event marker becomes rendered in the scene or is no longer rendered in the scene. It is used to script events or to modify the roll/crawl.

The following topic is discussed in this section:

- Add an Event Marker to a Scene
Add an Event Marker to a Scene

1. In the **Scene Manager** window, select the scene or scene group to add an event marker.
   The selected scene or scene group is displayed in the active **Viewport**.

2. In the **Markers** section of the **Object Library** window, click the **Event Marker** button.
   A new event marker object is added to **Object Manager** window as part of the scene displayed in the active **Viewport**.

3. In the **Object Inspector - Event Marker** window, select the **Event Marker** tab.
   The **Event Marker** tab opens.

4. At the bottom of the **Event Marker** tab, perform one of the following:
   - select the **On Show** tab to configure the settings for the event marker when it is rendered in the scene, or
   - select the **On Hide** tab to configure the settings for the event marker when it is not rendered in the scene.

5. In the **Event Marker** tab, use the **Mode Change** list to select the action of the event marker:
   - <none> — select this to assign no mode change to the event marker.
   - Pause — select this to assign a pause action to the event marker.
   - Start — select this to assign a start action to the event marker.
   - Take Offline — select this to take a scene group offline.

6. Select the **Change Speed** check box to adjust the speed of the roll/crawl or event script when the event marker is rendered or no longer rendered in the scene.
   Use the **Speed** box to enter or select the speed of the roll/crawl or event script.
   Use the **Inertia** box to enter or select the degree to which the roll/crawl or event script speed change accelerates or decelerates.

7. In the **Delayed Action** section, use the **Delay** box to enter or select an amount of frames to delay the selected mode change.
   Select the **Resume playing** check box to resume playing the scene or scene group after the selected mode change occurs.
8. If the **Resume playing** check box is selected, the **Change Speed** check box can be selected to change the speed of the roll/crawl or event script after the delayed action.

   Use the **Speed** box to enter or select the speed of the roll/crawl or event script.

   Use the **Inertia** box to enter or select the degree to which the roll/crawl or event script speed change accelerates or decelerates.

9. To move the event marker object to a new position in the **Viewport**, click and drag the event marker object to a new position.

   The settings on the **Transform** tab of the **Object Inspector - Event Marker Object** window can be used to precisely position an event marker object.
Miscellaneous Objects

Miscellaneous object functions can be performed using XPression, such as grouping objects, positioning objects, or publishing template links.

The following topics are discussed in this section:

- Group Scene Objects
- Position an Object
- Publish Template Links
Group Scene Objects

1. In the **Scene Manager** window, select the scene or scene group to add a group object. The selected scene or scene group is displayed in the active **Viewport**.

2. In the **Misc** section of the **Object Library** window, click the **Group** button. A new group object is added to **Object Manager** window as part of the scene displayed in the active **Viewport**.

3. In the **Object** column of the **Object Manager** window, click and hold the left mouse button on an object to add to the new group object.

4. Drag the selected object to the new group object.

5. Release the left mouse button.

   The selected object is added to the new group object. Objects contained in a group object are indented and connected to the group object by a leader line.

6. To select a group object, click the group object in the **Object** column of the **Object Manager** window. The order of objects in a group is changed by clicking and dragging the object to reorder, or using the **Arrow** buttons in the toolbar to move the object to reorder.

   **For More Information on...**
   - positioning group object in a scene, refer to the procedure “**Create a Text Object**” on page 5–2.
Position an Object

In addition to the Object Inspector Transform tab, the Move Tool and Rotate Tool can be used to position objects.

1. In the Object Manager window, select a group or object group to move or rotate.

2. To move the selected object, click the Move Tool in the Editor window toolbar. The Move Tool axis is displayed at the pivot point of the selected group object.

3. Use the Move Tool as follows to move the selected object:
   - Click and drag the Red (X), Green (Y), or Blue (Z) axis displayed at the object pivot point to move the object along the selected axis.
   - Click and drag the Yellow center of the axis displayed at the object pivot point to move the object horizontally and/or vertically in the scene.

4. To rotate the selected object, click the Rotation Tool in the Editor window toolbar. The Rotation Tool axis is displayed at the pivot point of the selected object.
5. Use the **Rotate Tool** as follows to move the selected group object:
   - Click and drag the **Red** (X), **Green** (Y), or **Blue** (Z) axis ring displayed at the object pivot point to rotate the object around the selected axis.
   - Click and drag the **Yellow** center of the axis rings displayed at the object pivot point to rotate the object about the scene.

6. To precisely position a group object, use the settings on the **Transform** tab of the **Object Inspector - Group Object** window.

For More Information on...
- how to add a group object to a scene, refer to the procedure “**Group Scene Objects**” on page 12–2.
Publish Template Links

1. Add a text object to a scene.

2. Select the new text object.

3. In the Object Inspector - Text Object window, click the Template Links tab.
   
   The Template Links tab opens.

   ![Image of Object Inspector - Text Object window with Template Links tab open]

   The Template Links tab lists the attributes associated with the selected object that can be published to the Template Data section in the Sequencer, where they are used in output mode to replace the template values.

4. In the Template Links section, select the Publish Object check box to publish the selected object.

   The object attribute information available for publishing and automation is listed below the Publish Object check box.

5. Select the check box in the Published column for each object attribute to publish.

   Text objects are published by default. This default can be disabled in the Project Properties.

6. If required, use the ▼ and ▲ button in the Published Object Order section to change the position of a selected object in the publishing hierarchy.

   The publishing hierarchy determines the order in which the published parameters are listed in the Take Inspector - Group window. Objects higher in the hierarchy are displayed higher in the list of published parameters.

For More Information on...

- adding a text object to a scene, refer to the procedure “Create a Text Object” on page 5–2.
- modifying template content for playout, refer to the procedure “Modify Template Content” on page 20–3.
Materials

In XPression, materials are used to define the look and style of objects in a scene.

The following topics are discussed in this section:

• Create a Texture Material
• Create a Video Material
• Create a Live Source Material
• Create a Window Capture Material
Create a Texture Material

1. In XPression, select Display > Material Manager.
   The Material Manager window opens. To prevent the Material Manager window from getting covered by other windows, click the Pin button in the window title bar.

2. In the Material Manager window, click the Create New Material button in the toolbar.
   The Material Editor dialog box opens.

3. Enter in the Name box a name for the new material.
4. In the **Preview** section, select **Texture** from the **Shader** list.
   A Texture shader is added to the material.

5. In the **Tree View**, select the new **Texture** shader.
   The **Texture File** section opens.

6. Enter in the **Filename** box the full path to the image file to use as a texture, or click **Browse** to use the **Texture Explorer** dialog box to select the image file.
   The RGB thumbnail displays the selected image file.

7. Click **OK**.
   The new material is added to the **Material Manager**, and is ready to be applied to text, background, quad, sphere, or cube objects.

   When a texture material is applied to a new quad object, the quad is resized to the texture image of the texture material. When applied to an existing quad, the texture image of the texture material is resized to fit the quad.

**For More Information on...**

- how to apply a material to a text object, refer to the procedure “**Apply a Material to a Text Object**” on page 5–10.
- how to apply a material to a quad object, refer to the procedure “**Create a Quad Object**” on page 7–2
- how to apply a material to a sphere object, refer to the procedure “**Create a Sphere Object**” on page 7–5
- how to apply a material to a cube object, refer to the procedure “**Create a Cube Object**” on page 7–8
Create a Video Material

1. In XPression, select Display > Material Manager.

   The Material Manager window opens. To prevent the Material Manager window from getting covered by other windows, click the Pin button in the window title bar.

2. In the Material Manager window, click the Create New Material button in the toolbar.

   The Material Editor dialog box opens.

3. Enter in the Name box a name for the new material.
4. In the Preview section, select Video from the Shader list.
   A Video shader is added to the material.

5. In the Tree View, select the new Video shader.
   The Video and Run Mode sections open.

6. In the Video section, enter the full path to the video file in the Video File box, or click Browse (...) to use the Open dialog box to select the video file.

7. In the Datalinq box, click Browse (...) to use the Set DataLinq Properties dialog box to select the DataLinq properties.

8. Use the Source Mode list to select the mode used by the video source to define transparency. The available modes are as follows:
   - Shaped Video Source (premultiplied) — the video file uses a shaped key, where the key alpha cuts a hole based on the monochrome value of the alpha. Shades of gray are translated into either white or black, giving the key a hard edge.
   - Unshaped Video Source — the video file uses an unshaped key, where the key alpha cuts a hole based on the gradient values of the alpha. Shades of gray are translated into transparency levels, giving the key a soft edge.

9. In the Run Mode section, use the Mode list to select the play mode for the video file. The available play modes are as follows:
   - Stopped — display the first frame in the video file, but do not play the video file.
   - Play Once — only play the video file once, then display the last frame in the video file.
   - Loop — continuously play the video file from start to finish.
   - Ping Pong — continuously play the video file back and forth.

10. Select the Auto Start check box to enable the video to start immediately when the scene comes on-air.
    The start time of the video file may also be controlled from the Scene Director by dragging the video material to a Scene Director track.

11. Click OK.
    The new material is added the Material Manager, and is ready to be applied to text, background, quad, sphere, or cube objects.
When a video material is applied to a new quad object, the quad is resized to the video file played by the video material. When applied to an existing quad, the video file of the video material is resized to fit the quad.

For More Information on...

- how to apply a material to a text object, refer to the procedure “Apply a Material to a Text Object” on page 5–10.
- how to apply a material to a quad object, refer to the procedure “Create a Quad Object” on page 7–2
- how to apply a material to a sphere object, refer to the procedure “Create a Sphere Object” on page 7–5
- how to apply a material to a cube object, refer to the procedure “Create a Cube Object” on page 7–8
- how to apply a material to a cube object, refer to the procedure “Create a Cube Object” on page 7–8
- controlling Scene Director tracks, refer to the procedure “Add Keyframe Animation to an Object” on page 15–5
Create a Live Source Material

1. In XPression, select **Display > Material Manager**.

   The **Material Manager** window opens. To prevent the **Material Manager** window from getting covered by other windows, click the **Pin** button in the window title bar.

![Material Manager window](image)

2. In the **Material Manager** window, click the **Create New Material** button in the toolbar.

   The **Material Editor** dialog box opens.

![Material Editor dialog box](image)

3. Enter in the **Name** box a name for the new material.
4. In the **Preview** section, select **Live Source** from the **Shader** list. A Live Source shader is added to the material.

5. In the **Tree View**, select the new **LiveSource** shader. The **Video** section opens.

![Image of Video section with LiveSource selected]

6. In the **Video** section, use the **Input Source** list to select the source from which to capture live video.

7. Click **OK**.

   The new material is added the **Material Manager**, and is ready to be applied to text, background, quad, sphere, or cube objects.

   When a live source material is applied to a new quad object, the quad is resized to the input source streamed by the live source material. When applied to an existing quad, the input source of the live source material is resized to fit the quad.

For More Information on...
- how to apply a material to a text object, refer to the procedure “Apply a Material to a Text Object” on page 5–10.
- how to apply a material to a quad object, refer to the procedure “Create a Quad Object” on page 7–2
- how to apply a material to a sphere object, refer to the procedure “Create a Sphere Object” on page 7–5
- how to apply a material to a cube object, refer to the procedure “Create a Cube Object” on page 7–8
Create a Window Capture Material

1. Outside of XPression, start Windows Internet Explorer.

2. Position the **Windows Internet Explorer** window on the screen so that it and the **XPression** window are visible at the same time.

3. In the **Windows Internet Explorer** window, navigate to the web site for the window capture material.

4. In XPression, select **Display > Material Manager**.

   The **Material Manager** window opens. To prevent the **Material Manager** window from getting covered by other windows, click the **Pin** button in the window title bar.

5. In the **Material Manager** window, click the **Create New Material** button in the toolbar.
The **Material Editor** dialog box opens.

6. Enter in the **Name** box a name for the new material.

7. In the **Preview** section, select **Window Capture** from the **Shader** list.
   
   A Window Capture shader is added to the material.

8. In the **Tree View**, select the new **Window Capture** shader.
   
   The **Window Capture** section opens.

9. On the **Preview** thumbnail in the **Window Capture** section, click and hold the left mouse button.
10. Position the mouse pointer over the content in the **Windows Internet Explorer** window to capture for the window capture material.

   A red box highlights the selected content.

11. When the required content is highlighted, release the left mouse button.

   A snapshot of the selected content is displayed in the **Preview** thumbnail.

   ✴️ For objects that use the window capture material to display the selected content, the **Windows Internet Explorer** window containing the selected content must remain open while the objects are online. Closing the **Windows Internet Explorer** window removes the content from the online objects. Also, to not compromise the output, ensure that no other window covers the captured window.

12. Select the **Capture Mouse Pointer** check box to display the mouse pointer along with the content from the captured window.

13. Select the **Disable Warning When Loading Shader** check box to hide the **Warning** dialog box when loading the Window Capture shader.

14. Click **OK**.

   The new material is added the **Material Manager**, and is ready to be applied to text, background, quad, sphere, or cube objects.

   ✴️ When a window capture material is applied to a new quad object, the quad is resized to the window captured by the window capture material. When applied to an existing quad, the captured window of the window capture material is resized to fit the quad.
For More Information on...

- how to apply a material to a text object, refer to the procedure “Apply a Material to a Text Object” on page 5–10.
- how to apply a material to a quad object, refer to the procedure “Create a Quad Object” on page 7–2
- how to apply a material to a sphere object, refer to the procedure “Create a Sphere Object” on page 7–5
- how to apply a material to a cube object, refer to the procedure “Create a Cube Object” on page 7–8
Fonts

In XPression, fonts are used to define the look and style of text objects in a scene.

The following topics are discussed in this section:

• Add a Private Font to a Project
• Apply a Material to a Font
Add a Private Font to a Project

The fonts installed in the Windows system font directory are available to all XPression projects. Private fonts are kept in a Fonts folder within an XPression project folder, and are only available to that project.

1. In XPression, click the Explorer button to open the project folder.
2. In the project folder, create a new folder named Fonts.
3. For each private font to add to the project, copy the associated True Type Font file into the new Fonts folder.

4. In XPression open the project that contains the added private fonts.
5. In the Scene Manager window, select a scene or scene group that contains a text object.

The objects contained in the selected scene or scene group are listed in the Object Manager.

6. In the Object Manager window, select a text object.
7. In the **Object Inspector - Text Object** window, click the **Scene Fonts** tab.
   The **Scene Fonts** tab opens.

8. In the **Fonts** section, click **New**.
   A new font is added to the **Stock** list.

9. Right-click the new font and select **Rename** from the shortcut menu.

10. Enter a name for the new font.
11. Select the **Face** check box.
    The **Font Face** tab opens.

12. Use the **Face** list to select a private font face, indicated by the **(private)** tag following the font face name, for the new font.
    The new font is ready to be applied to text objects.

**For More Information on...**
- how to apply a font to a text object, refer to the procedure “**Create a Text Object**” on page 5–2
Apply a Material to a Font

1. In the **Scene Manager** window, select a scene or scene group that contains a text object.

   ![](image1)

   The objects contained in the selected scene or scene group are listed in the **Object Manager**.

2. In the **Object Manager**, select a text object.

   ![](image2)

3. In the **Object Inspector - Text Object** window, click the **Scene Fonts** tab.

   The **Scene Fonts** tab opens.

   ![](image3)

4. In the **Used** or **Stock** list, select the font to apply a material.

   ![](image4)
5. Select a font attribute to apply a material. Font attributes are as follows

<table>
<thead>
<tr>
<th>2D Fonts</th>
<th>3D fonts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Face</td>
<td>Face</td>
</tr>
<tr>
<td>Border</td>
<td>Bevel</td>
</tr>
<tr>
<td>Stroke</td>
<td>Extrusion</td>
</tr>
<tr>
<td>Neon</td>
<td>Back Bevel</td>
</tr>
<tr>
<td>Shadow</td>
<td>Back Face</td>
</tr>
</tbody>
</table>

6. Click **Edit Material**.

   The **Material Editor** dialog box opens.

7. Use the **Material Editor** to edit the material of the selected font attribute.

8. Click **OK**.

   The edited material is applied to the font attribute to change the style of the selected font. Materials applied to fonts in this manner are not displayed in the **Material Editor**.

   All of the text objects in the project that were created with the edited font are changed to match the new style of the font.

**For More Information on...**

- how to create a 2D texture material to a scene, refer to the procedure “Create a Texture Material” on page 13–2.
- how to create a video material, refer to the procedure “Create a Video Material” on page 13–4.
- how to create a live source material, refer to the procedure “Create a Live Source Material” on page 13–7.
- how to create a window capture material, refer to the procedure “Create a Window Capture Material” on page 13–9.
Animations

Continuous animation and keyframe animation are the methods used in XPression to add movement to objects in a scene.

The following topics are discussed in this section:

• Add Continuous Animation to an Object
• Add Keyframe Animation to an Object
• Trigger Clips and Audio
• Create Animation with Multiple Controllers
• Copy Keyframes to Animate an Object
Add Continuous Animation to an Object

1. In the **Scene Manager** window, select a scene or scene group that contains an object to animate.

   ![Scene Manager](image1)

   The objects contained in the selected scene or scene group are listed in the **Object Manager**.

2. In the **Object Manager** window, select an object to animate.

   ![Object Manager](image2)

3. Click the **Continuous Anim** tab in the **Object Inspector** window.

   The **Continuous Anim** tab opens.

   ![Object Inspector](image3)

4. Click **New Track**.

   A new continuous animation track is added to the **Tracks** table.

   ![Tracks Table](image4)

5. In the **Waveform** column, use the list to select the continuous animation movement for the object. The available movement options are as follows:

   - **Sine**
   - **Cosine**

   ![Waveform Options](image5)
• Triangle — 
• Square — 
• Sawtooth — 
• Random — 

The selected waveform is displayed in the Graph column.

6. In the Mode column, use the list to select the mode used to continue the animation when it reaches the set Amplitude value. The available modes are as follows:
   • Symmetric — the amplitude value is copied after reaching the set value end.
   • Asymmetric — the animation flips over to the starting position after reaching the set amplitude value.

7. In the Channel column, use the list to select the channel to animate. The available channels are as follows:
   • Position X — move the object along the X axis.
   • Position Y — move the object along the Y axis.
   • Position Z — move the object along the Z axis.
   • Rotation X — rotate the object around the X axis.
   • Rotation Y — rotate the object around the Y axis.
   • Rotation Z — rotate the object around the Z axis.
   • Scaling X — scale the object along the X axis.
   • Scaling Y — scale the object along the Y axis.
   • Scaling Z — scale the object along the Z axis.
   • Pivot X — pivot the object along the X axis.
   • Pivot Y — pivot the object along the Y axis.
   • Pivot Z — pivot the object along the Z axis.
   • Alpha — fade the alpha channel of the object in and out. The key fades translucency until it disappears.

8. In the Amplitude column, use the box to enter or select the degree of movement for an object.
   For example, a value of 180 set for Rotation Z rotates an object 180 degrees around the Z axis.

9. In the Amp Offset column, use the box to enter or select the vertical starting point for the Amplitude setting.

10. In the Phase Offset column, use the box to enter or select the horizontal starting point for the Amplitude setting.

11. In the Cycle column, use the box to enter or select the speed of the animation cycle.

12. In the Pause column, use the box to enter or select the amount of frames to pause before the next animation cycle.

13. In the Sync column, use the list to select the method used to start a continuous animation track. The available options are as follows:
   • Reset — start a continuous animation track at the starting point of the animation.
   • Clock — base the start of a continuous animation track on the clock. Select this method to synchronize a continuous animation track with previous animations.

14. In the Enabled column, select the check box to enable the continuous animation track. Clear this check box to turn off the continuous animation track.

15. To add additional continuous animation tracks to an object, repeat steps 4 to 14.
   You can also right-click and copy the continuous animation track of an object and paste it in the Tracks section of the Continuous Anim tab for another object.

16. Double-click the scene containing the animated object.
The selected scene is sent to the default output and the object continuous animation tracks start running to animate object. To preview continuous animations in the active Viewport, click the Show or Hide Continuous Animations and Other Effects button in the Viewport toolbar.
Add Keyframe Animation to an Object

1. In the **Scene Manager** window, select a scene or scene group that contains an object to animate.

   ![Scene Manager Window](image)

   The objects contained in the selected scene or scene group are listed in the **Object Manager** window.

2. In XPression, select **Animation > Scene Director**.

   The **Scene Director** window opens with a default animation controller added for **Track 1**.

   * Multiple scene directors can be added to a scene and managed using the **Scene Directors** window.

3. Click and hold on the animation controller and move it to the position to start at in the **Timeline**.

   ![Scene Director Window](image)

4. In the **Animation Controller** window at the bottom of the **Editor**, use the list at the bottom right of the window to select the animation controller for animating objects in the current scene.

5. Use the **Total Range** box to enter or select the number of key frames in the animation.

6. In the **Working Range Start** box, enter or select the key frame for the start of the key frame scale.
7. In the **Working Range End** box, enter or select the key frame for the end of the key frame scale.

8. In active **Viewport**, position the object to animate at the start position of the animation.

9. Press the **Ctrl** and **K** key at the same time.

   The **Set Keyframe** dialog box opens.

   ![Set Keyframe Dialog Box](image)

   The attributes highlighted in green (Position, Rotation, and Scale) are captured. Red highlighted attributes (Alpha) are not captured.

10. In the **Set Key at Time** box to enter or select the key frame for the start position of the animation.

11. Click **Set & Close**.

   The set key frame is marked by a vertical line on the **Key Frame Scale** in the **Animation** window and in the active animation controller.

12. In active **Viewport**, position the object to animate at the next position in the animation.

13. Press the **Ctrl** and **K** key at the same time.

   The **Set Keyframe** dialog box opens.

14. In the **Set Key at Time** box to enter or select the key frame for the next position in the animation.

15. Click **Set & Close**.

   The set key frame is marked by a vertical line on the **Key Frame Scale** in the **Animation** window.

16. To add object position to the animation, repeat steps 12 to 15.

17. Double-click the scene containing the animated object.

   The selected scene is sent to the default output.

18. Click the **Play** button.

   The defined animation starts playing in the default output.
Trigger Clips and Audio

1. In the **Scene Manager** window, select a scene or scene group that contains an object to animate.

   ![Scene Manager Window](image)

   The objects contained in the selected scene or scene group are listed in the **Object Manager** window.

2. In XPression, select **Animation > Scene Director**.

   The **Scene Director** window opens.

   Multiple scene directors can be added to a scene and managed using the **Scene Directors** window.

3. In the **Editor**, select **Display > Audio Files**.

   The **Audio Files** window opens.

4. In **Audio Files** window, right-click and select **Import File** from the shortcut menu.

   The **Open** dialog box opens.
5. In the **Open** dialog box, locate and select a Waveform Audio File Format (.WAV) audio file to import into the project.

6. Click **Open**.

   The selected .WAV audio file is added the **Audio Files** window.

7. Drag the .WAV audio file from the **Audio Files** window onto an audio track in the **Scene Director**.

8. In **Scene Director**, click and drag the audio track into the required position.

9. Click the **Play** button.

   The defined animation starts playing in the default output.

**For More Information on...**

- creating a keyframe animation for an object, refer to the procedure “**Add Keyframe Animation to an Object**” on page 15–5
Create Animation with Multiple Controllers

1. In the **Scene Manager** window, select a scene or scene group that contains two or more objects to animate.

   ![Scene Manager Window](image)

   The objects contained in the selected scene or scene group are listed in the **Object Manager** window.

2. In XPression, select **Animation > Scene Director**.

   The **Scene Director** window opens with a default animation controller added for **Track 1**.

   Multiple scene directors can be added to a scene and managed using the **Scene Directors** window.

3. Select an object to animate.

4. Use the animation controller to animate the selected object in the current scene.

5. Select a second object to animate.

6. In the **Scene Director**, right-click in an empty track and select **Add Clip > Animation Controller** from the shortcut menu to add an animation controller to the selected track.
An animation controller is added to the selected track.

7. Use the new animation controller to animate the selected object in the current scene.

8. In the two tracks, click and drag the animation controllers to set the relative timing for the associated objects.
   Both objects move at the same time where the two animation controllers overlap on the timeline.

9. Click the **Play** button.
   The defined animations start playing in the default output.

**For More Information on...**

- creating a keyframe animation for an object, refer to the procedure “**Add Keyframe Animation to an Object**” on page 15–5
Copy Keyframes to Animate an Object

1. In the **Scene Manager** window, select a scene or scene group that contains two or more objects to animate.

The objects contained in the selected scene or scene group are listed in the **Object Manager**.

2. In XPression, select **Animation > Scene Director**.

The **Scene Director** window opens.

[Image of Scene Director window]

 Ramirez multiple scene directors can be added to a scene and managed using the **Scene Directors** window.

3. Select an object to animate.

4. In the **Scene Director**, right-click in an empty track and select **Add Clip > Animation Controller** from the shortcut menu to add an animation controller to the selected track.

5. Select the new animation controller.

6. Create a keyframe based animation for selected object.
7. In the Editor, select Animation > Key Graph Editor.

The Key Graph Editor window opens.

8. In the Objects list, double-click the name of the object displayed in bold face type.

The selected object is added to the Channels list.

9. If required, expand the object added to the Channels list.

The object channels are displayed below the expanded object.

10. Select one or more of the object channels displayed in bold face type.

Only the object channels displayed in bold face type can be copied to another object.
11. On the selected object channels, right-click and select **Copy** from the shortcut menu. The values of the selected channels are copied for each keyframe of the select object.

12. Collapse the object in the **Channels** list.

13. In the **Objects** list, double-click the object to which to copy the keyframes and object channels. The selected object is added to the **Channels** list.
14. In the **Channels** list, right-click the new object and select **Paste** from the shortcut menu.

![Image of Channels list with right-click context menu]

The copied keyframes and object channel values are pasted into the selected object. The updated object channels are displayed in **bold** face type.

15. If required, edit the keyframes copied to the object.

   a. In the **Channels** list, select the channel to edit for an object.

   The **Graph** displays the keyframes for the selected object channel. Each white square in the **Graph** represents a keyframe.

   b. In the **Graph**, select the keyframe to edit.

   c. To move the selected keyframe vertically in the **Graph**, hold down the **CTRL** key then click and drag the keyframe up or down. To move the selected keyframe horizontally in the **Graph**, hold down the **CTRL + Shift** keys then click and drag the keyframe to the right or left.

   d. Use the displayed properties to set the required values for the selected keyframe.

   The properties of the selected keyframe are displayed below the **Graph**.

   e. For each keyframe that requires editing, repeat steps b and d.

16. Close the **Key Graph Editor** window.

17. Click the **Play** button.

   The edited animation starts playing in the default output.

**For More Information on...**

- creating a keyframe animation for an object, refer to the procedure “Add Keyframe Animation to an Object” on page 15–5
Copy and Paste Animation Controllers

Animation Controllers can be copied and pasted to the same track in a scene, a different track in the scene, and a different scene altogether. This allows you to quickly and easily apply keyframe animations to other objects within a scene or in a different scene.

1. In XPression, open a project and select a scene that contains keyframe animations.
2. Select Animation > Scene Director.
   The Scene Director window opens.
3. Right-click on the Animation Controller and select Copy.
4. Right-click inside a track in the Scene Director and select Paste.
   The copied animation controller can be pasted onto the same track or a new track in the same scene, or onto tracks in the Scene Director from another scene.
The **Paste Animation Controller** dialog box opens.

![Paste Animation Controller dialog box](image)

5. Do one of the following, if necessary:
   - in the **Destination Object** column, click on individual objects whose name includes a numeric (for example, PerspCamera1) to open a dropdown menu and select a different object increment (for example, PerspCamera2).
   - click the **Increment Destination** button to select the next increment for objects in the **Destination Object** list.

6. Click **OK**.

The **Paste Animation Controller** dialog box closes and the copied animation controller is pasted onto the track in the Scene Director.

The name of the pasted controller will be based on the name of the copied animation controller.

![Scene Director with pasted animation](image)

For More Information on...
- creating a keyframe animation for an object, refer to the procedure “**Add Keyframe Animation to an Object**” on page 15–5
Stagger Animations

Stagger animations are used in XPression to add character effects to text objects and to animate group objects in a scene.

The following topic is discussed in this section:

• Add Stagger Animation to a Text or Group Object
Add Stagger Animation to a Text or Group Object

1. In the Scene Manager window, select a scene or scene group that contains a text or group object to animate.

![Scene Manager](image)

The text or group object contained in the selected scene or scene group are listed in the Object Manager.

2. In the Object Manager window, select the text or group object to animate.

![Object Manager](image)

3. Use the Display menu to select Stagger Animations.

The Stagger Animations window opens.
4. Click New.

The Edit Stagger Animation dialog box opens.

5. In the Name box, enter a name for the stagger animation.

6. In the Description box, enter a brief description to describe the stagger animation.

7. In the Tracks section, right-click and use the shortcut list to select a track, or tracks, to add an animation. The available tracks are as follows:
   - Position.X — move the object along the X axis.
   - Position.Y — move the object along the Y axis.
   - Position.Z — move the object along the Z axis.
   - Rotation.X — rotate the object around the X axis.
   - Rotation.Y — rotate the object around the Y axis.
   - Rotation.Z — rotate the object around the Z axis.
   - Scale.X — scale the object along the X axis.
   - Scale.Y — scale the object along the Y axis.
   - Scale.Z — scale the object along the Z axis.
   - Alpha — fade the alpha channel of the object in and out. The key fades translucency until it disappears.

8. In the Track Animation section, click the Insert Keyframe button to insert a keyframe at the timeframe marker.

9. In the Track Animation graph, click a keyframe to select it.

A keyframe can also be selected by clicking and holding the left mouse button inside the Track Animation graph and dragging the mouse so that a dashed rectangle highlight surrounds the keyframe. Release the left mouse button to select the keyframe.

Keyframes can be deleted from the Track Animation Graph by right-clicking on the selected keyframe and selecting Delete from the shortcut menu.

10. Once a keyframe is selected, use the Key Value box to enter or select a keyframe value.

The selected keyframe can also be moved vertically in the Track Animation graph by holding down the Ctrl key then clicking and dragging the keyframe up or down. To move the selected keyframe horizontally in the
11. In the **Total Duration** section, use the **Frames** box to enter or select the length in frames for the stagger animation.

12. Use the **Timing Offsets** section to offset stagger animations.
   
a. Use the **Character** box to enter or select a value to offset the characters of a text object to the overall framerate of the stagger animation.
   
b. Use the **Word** box to enter or select a value to offset the words of a text object to the overall framerate of the stagger animation.
   
c. Use the **Line** box to enter or select a value to offset the lines of a text object to the overall framerate of the stagger animation.
   
d. Use the **Paragraph** box to enter or select a value to offset the paragraphs of a text object to the overall framerate of the stagger animation.

13. In the **Pivots** section, use the **Mode** list to select a method to pivot an object. The following options are available:
   
   • **Baseline Center** — pivots objects from the base of the object.
   • **Center** — pivots objects from the center of the object.
   • **Origin** — pivots objects from the center of the whole of the objects.

14. Click OK.

   The new stagger animation appears in the list in the **Stagger Animations** window.

15. Click and drag the stagger animation into the **Timeline** area for the text or group object in the **Scene Director**.

   The stagger animation appears in the timeline of the text or group object.

16. Click the **Play** button.

   The defined stagger animation starts playing in the default output.
Widgets

XPression widgets are used to generate clocks, timers, and counters for scenes.

The following topics are discussed in this section:

- Add a Realtime Clock Display to a Scene
- Customize the Time Format of a Widget
- Rename a Widget
- Add a Timer Display to a Scene
- Add a Counter Display to a Scene
- Customize the Counter Format of a Widget
- Add a Text List to a Scene
Add a Realtime Clock Display to a Scene

1. In XPression, use the Display menu to select Widgets.
   The Widgets window opens.

2. In the Widgets window, select New Widget > Clock Timer.
   A realtime clock widget is added to the Widgets window.

3. Add a text object to a scene.

4. In the Object Manager window, select the text object for the realtime clock widget.

5. Click the Data Source tab in the Object Inspector - Text Object window.
   The Data Source tab opens.

6. Select the Widget option.
   A Widget list is displayed below the options.
7. Use the Widget list to select a realtime clock widget, for example ClockTimer1. Since widget names can be modified, the names of realtime clock widgets vary between XPression systems.

   A Warning dialog box opens.

8. Click Yes.

   The text in the selected text object is replaced with the time of day generated by the selected realtime clock widget.

9. Double-click the scene containing the text object linked to the realtime clock widget.

   The selected scene is sent to the default output, and the clock in linked text object starts running.

For More Information on...
- adding a text object to a scene, refer to the procedure “Create a Text Object” on page 5–2.
- customizing the time displayed by a widget, refer to the procedure “Customize the Time Format of a Widget” on page 17–4.
Customize the Time Format of a Widget

1. In a scene, select a text object that is associated with a realtime clock widget.
2. Click the Data Source tab in the Object Inspector - Text Object window.
   The Data Source tab opens.

3. In the Select Data Source section, note the name of the widget associated with the selected text object.
4. From the Display menu, select Widgets.
   The Widgets window opens.

5. In the Widgets window, right-click the widget associated with the selected text object.
   The shortcut menu opens.

6. Select Properties from the shortcut menu.
   The Widget Properties (Realtime Clock, Timer) dialog box opens
7. In the **Format** list, select or type the time format in which to display the current time and/or date. The available time formats are as follows:

- **HH:NN** — 16:35
- **HH:NN:SS** — 16:35:40
- **HH:NN:SS.ZZZ** — 16:35:40.765
- **HH:NN AM/PM** — 04:35 PM
- **HH:NN:SS AM/PM** — 04:35:40 PM
- **HH:NN:SS.ZZZ AM/PM** — 04:35:40.765 PM
- **DD-MM-YY** — 27-11-09
- **DD-MM-YY HH:NN** — 27-11-09 16:35
- **DD-MM-YY HH:NN:SS** — 27-11-09 16:35:40
- **DD/MM/YY** — 11/27/09
- **DD/MM/YY HH:NN** — 11/27/09 16:35
- **DD/MM/YY HH:NN:SS** — 11/27/09 16:35:40

The characters used to separate the date and time strings can be changed for each time format.

8. Use the **Date Sep** list to select the character displayed between the elements of a date string.

9. Use the **Time Sep** list to select the character displayed between the elements of a time string.

10. Use the **Source** list to select the timecode source for the realtime clock widget.

    This menu is populated with the internal clock of the XPression system and the timecode sources that have been configured in the **Timecode Sources** tab of the Hardware Setup dialog box.

11. In the **Time Offset** section, use the **Hours** box to enter or select the number of hours to offset the time displayed by a widget from the current local time.

12. In the **Mins** box, enter or select the number of minutes to offset the time displayed by a widget from the current local time.

13. In the **Secs** box, enter or select the number of seconds to offset the time displayed by a widget from the current local time.

14. In the **MS** box, enter or select the number of milliseconds to offset the time displayed by a widget from the current local time.

15. Click **OK**.

    The new settings are saved, and the **Widget Properties** dialog box closes.

16. Double-click the scene containing the text object linked to the realtime clock widget.

    The selected scene is sent to the default output, and the customized clock in the liked text object starts running.
Rename a Widget

1. From the Display menu, select Widgets.
   The Widgets window opens.

2. In the Widgets window, right-click the widget to rename.
   The shortcut menu opens.

3. Select Rename from the shortcut menu.
   The Rename Widget dialog box opens.

4. In the Name box, enter a new name for the selected widget.
5. Click OK.
   The selected widget is updated with the new name.
Add a Timer Display to a Scene

1. In XPression, use the Display menu to select Widgets.
   The Widgets window opens.

![Widget window with ClockTimer1 and ClockTimer2]

2. In the Widgets window, select New Widget > Clock Timer.
   A clock timer widget is added to the Widgets window.

![Widget window with added ClockTimer2]

3. In the Widgets window, right-click the widget associated with the selected text object.
   The shortcut menu opens.

![Shortcut menu with Properties option]

4. Select Properties from the shortcut menu.
   The Widget Properties (Realtime Clock, Timer) dialog box opens

![Widget Properties dialog box]

5. Use the Mode list to select Timer.
The **Widget Properties** dialog box displays the settings for a timer.

6. In the **Start At** box, enter the hours, minutes, seconds, and hundredths of seconds of the time from which to start the timer.

7. In the **Stop At** box, enter the hours, minutes, seconds, and hundredths of seconds of the time at which to stop the timer.

8. Use the **Direction** list to select the timer direction. The available directions are as follows:
   - **Up** — increase the time value from the time set in the Start At box until the timer is stopped.
   - **Down** — decrease the time value from the time set in the Start At box until the timer is stopped.

9. In the **Format** list, select or type the time format used by the widget to display the current time value. The available time formats are as follows:
   - **S** — 16545
   - **SSS** — 16545
   - **S.ZZZ** — 16545.765
   - **SSS.ZZZ** — 16545.765
   - **HH:NN** — 04:35
   - **HH:NN:SS** — 04:35:40
   - **HH:NN:SS.ZZZ** — 04:35:40.765
   - **NN:SS** — 35:40
   - **NN:SS.ZZZ** — 35:40.765

10. Use the **Start** list to select the method used to start the timer. The available methods are as follows:
    - **Manual** — in the Widget window, click the Start button associated with the timer widget to start the timer.
    - **When Online** — start the timer when the scene goes online.
    - **Ctrl + 1** — press the Ctrl and 1 key at the same time to start the timer.
    - **Ctrl + 2** — press the Ctrl and 2 key at the same time to start the timer.
    - **Ctrl + 3** — press the Ctrl and 3 key at the same time to start the timer.
    - **Ctrl + 4** — press the Ctrl and 4 key at the same time to start the timer.
    - **Ctrl + 5** — press the Ctrl and 5 key at the same time to start the timer.
    - **Ctrl + 6** — press the Ctrl and 6 key at the same time to start the timer.
    - **Ctrl + 7** — press the Ctrl and 7 key at the same time to start the timer.
    - **Ctrl + 8** — press the Ctrl and 8 key at the same time to start the timer.
    - **Ctrl + 9** — press the Ctrl and 9 key at the same time to start the timer.

11. Use the **Stop** list to select the method used to stop the timer. The available methods are as follows:
    - **Manual** — in the Widget window, click the Stop button associated with the timer widget to stop the timer.
    - **When Offline** — stop the timer when the scene goes offline.
    - **Ctrl + 1** — press the Ctrl and 1 key at the same time to stop the timer.
    - **Ctrl + 2** — press the Ctrl and 2 key at the same time to stop the timer.
• Ctrl + 3 — press the Ctrl and 3 key at the same time to stop the timer.
• Ctrl + 4 — press the Ctrl and 4 key at the same time to stop the timer.
• Ctrl + 5 — press the Ctrl and 5 key at the same time to stop the timer.
• Ctrl + 6 — press the Ctrl and 6 key at the same time to stop the timer.
• Ctrl + 7 — press the Ctrl and 7 key at the same time to stop the timer.
• Ctrl + 8 — press the Ctrl and 8 key at the same time to stop the timer.
• Ctrl + 9 — press the Ctrl and 9 key at the same time to stop the timer.

12. Use the Reset list to select the method used to reset the timer. The available methods are as follows:
   • Manual — in the Widget window, click the Reset button associated with the timer widget to reset the timer to the start time set for the timer widget.
   • When Online — reset the timer when the scene goes online.
   • When Offline — reset the timer when the scene goes offline.
   • Ctrl + 1 — press the Ctrl and 1 key at the same time to reset the timer.
   • Ctrl + 2 — press the Ctrl and 2 key at the same time to reset the timer.
   • Ctrl + 3 — press the Ctrl and 3 key at the same time to reset the timer.
   • Ctrl + 4 — press the Ctrl and 4 key at the same time to reset the timer.
   • Ctrl + 5 — press the Ctrl and 5 key at the same time to reset the timer.
   • Ctrl + 6 — press the Ctrl and 6 key at the same time to reset the timer.
   • Ctrl + 7 — press the Ctrl and 7 key at the same time to reset the timer.
   • Ctrl + 8 — press the Ctrl and 8 key at the same time to reset the timer.
   • Ctrl + 9 — press the Ctrl and 9 key at the same time to reset the timer.

13. Click OK.

   The new settings are saved, and the updated widget is displayed in the Widget window.

   To edit the timer widget value manually, enter a value in the time box and then click Set.

14. Add a text object to a scene.

15. In the Object Manager window, select the text object for the clock timer widget.
16. Click the **Data Source** tab in the **Object Inspector - Text Object** window.

The **Data Source** tab opens.

![Object Inspector - Text Object window](image)

17. Select the **Widget** option.

A **Widget** list is displayed below the options.

18. Use the **Widget** list to select a timer widget, for example **ClockTimer2**. Since widget names can be modified, the names of timer widgets vary between XPression systems.

A **Warning** dialog box opens.

19. Click **Yes**.

The text in the selected text object is replaced with a time generated by the selected timer widget.

20. Double-click the scene containing the text object linked to the timer widget.

The selected scene is sent to the default output, and the linked text object displays the timer.

21. Use the start method set in step 10 to start the timer.

For **More Information on...**

- adding a text object to a scene, refer to the procedure “**Create a Text Object**” on page 5–2.
Add a Counter Display to a Scene

1. In XPression, use the Display menu to select Widgets.
   The Widgets window opens.

   ![Widgets window](image)

2. In the Widgets window, select New Widget > Counter.
   A counter widget is added to the Widgets window.

   ![Widgets window with counter](image)

3. In the Value box, enter or select the number at which to start the counter.
4. Add a text object to a scene.
5. In the Object Manager window, select the text object for the counter widget.

   ![Object Manager window](image)

6. Click the Data Source tab in the Object Inspector - Text Object window.
   The Data Source tab opens.

   ![Object Inspector - Text Object window](image)

7. Select the Widget option.
   A Widget list is displayed below the options.
8. Use the **Widget** list to select a counter widget, for example **Counter1**. Since widget names can be modified, the names of counter widgets vary between XPression systems.

   A **Warning** dialog box opens.

9. Click **Yes**.

   The text in the selected text object is replaced with the starting number set for the counter in step 3.

10. Double-click the scene containing the text object linked to the counter widget.

    The selected scene is sent to the default output, and the linked text object displays the counter starting number.

11. In the **Widget** window, click the **Up** button associated with the timer widget to increase the counter value. To decrease the counter value, click the **Down** button associated with the timer widget.

**For More Information on...**

* adding a text object to a scene, refer to the procedure “**Create a Text Object**” on page 5–2.

* customizing the counter displayed by a widget, refer to the procedure “**Customize the Time Format of a Widget**” on page 17–4.
Customize the Counter Format of a Widget

1. In a scene, select a text object that is associated with a counter widget.
2. Click the Data Source tab in the Object Inspector - Text Object window.
   The Data Source tab opens.
3. In the Select Data Source section, note the name of the widget associated with the selected text object.
4. From the Display menu, select Widgets.
   The Widgets window opens.
5. In the Widgets window, right-click the widget associated with the selected text object.
   The shortcut menu opens.
6. Select Properties from the shortcut menu.
   The Widget Properties (Counter) dialog box opens.
7. Use the Count Up list to select the method used to increase the counter value. The available methods are as follows:
   • Manual — in the Widget window, click the Up button associated with the counter widget to increase the counter value.
   • When Online — increase the counter value when the scene goes online.
   • Ctrl + 1 — press the Ctrl and 1 key at the same time to increase the counter value.
   • Ctrl + 2 — press the Ctrl and 2 key at the same time to increase the counter value.
   • Ctrl + 3 — press the Ctrl and 3 key at the same time to increase the counter value.
   • Ctrl + 4 — press the Ctrl and 4 key at the same time to increase the counter value.
   • Ctrl + 5 — press the Ctrl and 5 key at the same time to increase the counter value.
   • Ctrl + 6 — press the Ctrl and 6 key at the same time to increase the counter value.
   • Ctrl + 7 — press the Ctrl and 7 key at the same time to increase the counter value.
   • Ctrl + 8 — press the Ctrl and 8 key at the same time to increase the counter value.
   • Ctrl + 9 — press the Ctrl and 9 key at the same time to increase the counter value.

8. Use the Count Down list to select the method used to decrease the counter value. The available methods are as follows:
   • Manual — in the Widget window, click the Down button associated with the counter widget to decrease the counter value.
   • When Offline — decrease the counter value when the scene goes offline.
   • Ctrl + 1 — press the Ctrl and 1 key at the same time to decrease the counter value.
   • Ctrl + 2 — press the Ctrl and 2 key at the same time to decrease the counter value.
   • Ctrl + 3 — press the Ctrl and 3 key at the same time to decrease the counter value.
   • Ctrl + 4 — press the Ctrl and 4 key at the same time to decrease the counter value.
   • Ctrl + 5 — press the Ctrl and 5 key at the same time to decrease the counter value.
   • Ctrl + 6 — press the Ctrl and 6 key at the same time to decrease the counter value.
   • Ctrl + 7 — press the Ctrl and 7 key at the same time to decrease the counter value.
   • Ctrl + 8 — press the Ctrl and 8 key at the same time to decrease the counter value.
   • Ctrl + 9 — press the Ctrl and 9 key at the same time to decrease the counter value.

9. Use the Reset list to select the method used to reset the counter. The available methods are as follows:
   • Manual — in the Widget window, click the Reset button associated with the counter widget to reset the counter to the set starting value.
   • When Online — reset the counter when the scene goes online.
   • When Offline — reset the counter when the scene goes offline.
   • Ctrl + 1 — press the Ctrl and 1 key at the same time to reset the counter.
   • Ctrl + 2 — press the Ctrl and 2 key at the same time to reset the counter.
   • Ctrl + 3 — press the Ctrl and 3 key at the same time to reset the counter.
   • Ctrl + 4 — press the Ctrl and 4 key at the same time to reset the counter.
   • Ctrl + 5 — press the Ctrl and 5 key at the same time to reset the counter.
   • Ctrl + 6 — press the Ctrl and 6 key at the same time to reset the counter.
   • Ctrl + 7 — press the Ctrl and 7 key at the same time to reset the counter.
   • Ctrl + 8 — press the Ctrl and 8 key at the same time to reset the counter.
   • Ctrl + 9 — press the Ctrl and 9 key at the same time to reset the counter.

10. In the Value Increment box, enter or select the amount to change the counter value when the counter value is increased or decreased.

11. In the Max Value box, enter or select the number at which the counter stops increasing the counter value.
12. In the **Min Value** box, enter or select the number at which the counter stops decreasing the counter value.

13. Click **OK**.
   
   The new settings are saved, and the **Widget Properties** dialog box closes.

14. Double-click the scene containing the text object linked to the counter widget.
   
   The selected scene is sent to the default output, and the linked text object displays the counter starting number.

15. Use the increment methods set in steps 7 and 8 to change the counter value.
Add a Text List to a Scene

1. In XPression, use the Display menu to select Widgets.
   The Widgets window opens.

2. In the Widgets window, select New Widget > Text List.
   A text list widget is added to the Widgets window.

3. Add a text object to a scene.
4. In the Object Manager window, select the text object for the text list widget.

5. Click the Data Source tab in the Object Inspector - Text Object window.
   The Data Source tab opens.

6. Select the Widget option.
   A Widget list is displayed below the options.
7. Use the **Widget** list to select a text list widget, for example **TextList1**. Since widget names can be modified, the names of text list widgets vary between XPression systems.

   A **Warning** dialog box opens.

8. Click **Yes**.

   The selected scene is sent to the default output.

**For More Information on...**

- adding a text object to a scene, refer to the procedure “**Create a Text Object**” on page 5–2.
Effects

XPression effects are used to add various post-effects to individual objects and entire scenes. The following topics are discussed in this section:

• Add an Effect or Transition to an Object or Scene
Add an Effect or Transition to an Object or Scene

1. In XPression, create or select a scene.
2. In the Object Manager window, select an object for the effect or transition.

3. Use the Display menu to select Effects.
   The Effects window opens.

4. In the Effects window, use the folders to browse and select an effect or transition for the selected object.

5. Add the effect or transition to the Object Inspector or add the effect to the Scene Director.
   ✷ Some effects can only be used for specific objects. For example, Depth of Field is only applicable to Scene Objects.
   ✷ Transitions are only useable in the Scene Director.
Object Inspector

a. Drag and drop the selected effect or transition into the **Effects** tab in the **Object Inspector**. The effect or transition is added to the **Effects** tab.

b. In the **Effects** tab list, double-click on the effect. The **Effect Properties** dialog box opens.

c. Use the **Effect Properties** dialog box to configure the properties for the effect or transition.

d. Click **OK**. The **Effect Properties** dialog box closes.

Scene Director

a. Use the **Animation** menu to select **Scene Director**. The **Scene Director** window opens.
Multiple scene directors can be added to a scene and managed using the **Scene Directors** window.

b. Drag and drop the selected effect or transition onto the object track in the **Scene Director**.

   A controller for the effect or transition is added to the object track.

c. In the controller for the effect or transition, double-click the object controller.

   The **Effect Properties** dialog box opens.

d. Use the **Effect Properties** dialog box to configure the properties for the effect or transition.

e. Click **OK**.

   The **Effect Properties** dialog box closes.

6. Repeat steps 2 to 5 to add other effects or transitions to an object.

For More Information on...

- adding animations, refer to the section “**Animations**” on page 15–1.
DataLinq™

DataLinq enables live templates to be automatically filled with external data from XML files, RSS feeds, SMS servers, Text files, or any ODBC data source; like Access, MS SQL, Interbase, Firebird, or MySQL.

The XPression DataLinq Server software runs on either the XPression system itself, or one or more other computer systems to gather data from external sources and make it available to XPression systems. XPression systems use the XPression DataLinq Manager to connect to one or more DataLinq Servers (Figure 19.1). The XPression DataLinq Manager enables objects in an XPression project to link to any of the external data sources gathered by the connected DataLinq Servers.

The following topics are discussed in this section:

- Start the DataLinq Server
- Connect XPression to a DataLinq Server
- Link a Text Object to a DataLinq Data Source
- Link a Quad Object to a DataLinq Source
- Link a Cube Object to a DataLinq Source
- Using DataLinq Keys with an ADODB DataLinq
- Using DataLinq Keys with an XML DataLinq
- Using SQL Queries
- Using a Macro with a DataLinq Key
- Create a Data Page

Figure 19.1 DataLinq Connections to External Data Sources
Start the DataLinq Server

1. Use one of the following methods to start the DataLinq Server.
   - Double-click the **XPression DataLinq Server** icon on the desktop.
   - Use the **Start** menu to select **All Programs > XPression > XPression DataLinq Server**.
   
   The **XPression DataLinq Server** window opens.

   ![DataLinq Server window](image)

   The port number used by the DataLinq Server to communicate with other XPression clients is displayed in the window title bar.

2. Click **Add New**.

   The **Add DataLinq Source** dialog box opens.

   ![Add DataLinq Source dialog](image)

3. From the list of DataLinq sources, select the type of external data source to access. The available types of DataLinq sources are as follows:
   - **ADODB DataLinq Source** — access data contained in OLEDB, ODBC, Access, and other database sources.
   - **ANC DataLinq Source** — access data contained in ANC database sources.
   - **ASCII DataLinq Source** — access data contained in a stream of ASCII data (serial, TCP, or UDP) and extract fixed length fields from the messages. This can be used to parse some generic protocols and other devices such as radar gun data.
   - **Daktronics DataLinq Source** — access data from the Daktronics sports feed database.
   - **DashBoard DataLinq Source** — access data from a DashBoard server (DashBoard version 6.1 or higher).
   - **Excel DataLinq Source** — access data contained in Excel files stored on disk.
   - **GSIS DataLinq Source** — access data from the NFL Game Statistics & Information System.
   - **OES Scoreboards DataLinq Source** — access data from the OES Football, Lacrosse, Baseball Model7929, or Basketball feeds.
   - **RSS Feed DataLinq Source** — access data through a RSS (Really Simple Syndication) feed. RSS feeds use a standard format to publish frequently updated works; such as, news headlines, blog entries, audio, and video.
• **Text DataLinq Source** — access data contained in delimited text files stored on disk.
• **White Way DataLinq Source** — access data from White Way databases for basketball.
• **XML DataLinq Source** — access data contained in XML files stored on disk.

4. Click **OK**.
   The dialog box that opens to define data source settings depends on the selected data source.

5. Configure the selected DataLinq source.

   **ADODB DataLinq Source**
   The ADODB DataLinq Configuration dialog box opens.

   ![ADODB DataLinq Configuration dialog box](image)

   a. In the **Connection** tab, use the **Connection String** box to enter the connection string of the DataLinq Source, or click **Select Template** to select an existing connection string.

   b. Click **Test Connection** to view the status of the connection string.

   c. Enter or select a time in seconds in the **Refresh Every** box to update the data retrieved from the database.

   d. Select the **Wrap Indices** check box to wrap the indices above the record count within record count limits. This check box should be selected when using looping queries.

   ![Wrap Indices](image)

   e. In the **Fields** table, use the **Fields table** to add a sort field for a table within a database (some databases, such as Access and MySQL, require a specified sort order or the data could be returned in random order):

      - **Table Name** — use the list to select a table for the DataLinq.
      - **Sort Field** — use the list to select the sort field for the data.
      - **Order** — use the list to select the sorting order for the data. The options are:
        - **ASC** — sort the data in ascending order.
        - **DESC** — sort the data in descending order.
      - **Add** — click this button to add a field row to the Fields table.
      - **Delete** — click this button to delete a selected row from the table.
      - **Move Up** — click this button to move a selected row up in the table.
      - **Move Down** — click this button to move a selected row down in the table.

   ![Fields table](image)

   f. In the **Fixed Tables** tab, select the **Force DataLinq to use a fixed table** check box to use fixed tables.

   ![Fixed Tables](image)

   g. Choose one of the following options:

      - Select the **Table** option and use the list to select a table from the connected database.

        ![Table option](image)

      - **Click Refresh** to update the data retrieved from the database.

      - Select the **SQL Query** option and modify the string to query the database.
h. In the Advanced tab, use the Record Limiting list to optimize the speed for accessing data by limiting the amount of records from the selected database by selecting one of the following options:
   - Database supports TOP clause (e.g. Access/Excel)
   - Database supports LIMIT clause (e.g. MySQL)
   Select Not supported if not using Record Limiting.

i. Click OK.

The ADODB DataLinq Configuration dialog box closes and the new DataLinq Source is added to the DataLinq Sources section of the XPression DataLinq Server window.

ANC DataLinq Source

The ANC Linq - Configuration dialog box opens.

a. Enter in the Host box the IP address of the ANC DataLinq database.

b. Enter in the Port box the port number for the ANC DataLinq database.

c. Click OK.

The ANC DataLinq Configuration dialog box closes and the new DataLinq Source is added to the DataLinq Sources section of the XPression DataLinq Server window.

ASCII DataLinq Source

The ASCII DataLinq Setup dialog box opens.

a. In the Settings section, use the Mode radio buttons to select the ASCII DataLinq connection type. The options are:

   - Serial RS232 — select this option to use an RS232 serial GPI port as the connection type.
   - TCP — select this option to use a TCP port as the connection type.
   - UDP — select this option to use a UDP port as the connection type.
b. Do one of the following:
   • If Serial RS232 is selected in the **Settings** section, use the **RS232 Settings** section to configure the GPI settings for the RS232 serial connection:
     › **Port** — enter or select the serial port number for the connection to the ASCII DataLinq.
     › **Baudrate** — use this list to select the communication speed for the signals.
     › **Data Bits** — use this list to select the number of bits used to represent one character of data for the signals.
     › **Parity** — use this list to select the method used to check for lost data in a signal.
     › **Stop Bits** — use this list to select the number of bits used to indicate the end of a byte in a signal.
     › **Flow Control** — use this list to select the data transmission rate controller for a signal.
   • If TCP or UDP is selected in the **Settings** section, use the **Network Settings** section to configure the port settings for the connection:
     › **TCP** — if TCP has been selected in the **Settings** section, enter or select the **TCP Port** number for the connection to the ASCII DataLinq.
     › **UDP** — if UDP has been selected in the **Settings** section, enter or select the **UDP Port** number for the connection to the ASCII DataLinq.

c. Use the **Fields** table to define a region of the incoming ASCII data stream to locate specific information (for example, Home Score, Visitor Score, Period, etc.):
   • **Name** — click inside a row to enter or edit a name for the field.
   • **Start Byte** — click inside a row to enter or edit the location where the field begins in the data stream.
   • **Length** — click inside a row to enter or edit the amount of bytes the field uses.
   • **Trim** — click inside a row and then select the check box to remove extra spaces from the data.
   • **Add** — click this button to add a field to the table.
   • **Delete** — click this button to delete a selected field from the table.

d. In the **Protocol Settings** section, use the **Start of Packet** list to select a start of packet control code. The available options are:
   • `<none>` — do not use a control code for the start of packet.
   • **STX** — use the start of text control code.
   • **SOH** — use the start of heading control code.
   • **Custom** — use a custom start of packet value. In the **ASCII Value** box, enter or select a custom start of packet value.

e. Use the **End of Packet** list to select a start of packet control code. The available options are:
   • **CR** — use the carriage return control code.
   • **LF** — use the line feed control code.
   • **ETX** — use the end of text control code.
   • **EOT** — use the end of transmission control code.
   • **Custom** — use a custom end of packet value. In the **ASCII Value** box, enter or select a custom end of packet value.

f. Click **OK**.

The **ASCII DataLinq Setup** dialog box closes and the new DataLinq Source is added to the **DataLinq Sources** section of the **XPression DataLinq Server** window.
**Daktronics DataLinq Source**

The **Daktronics Linq - Configuration** dialog box opens.

![Daktronics Linq - Configuration dialog box](image)

a. Use the **Game Feed** list to select a Daktronics sports feed. The available sports feeds are as follows:
   - Baseball
   - Basketball
   - Football
   - Hockey
   - Soccer
   - Volleyball

b. Select the **Trim Text** check box to trim the text.

c. In the **Connection Options** section, use the **Connection Type** options to select the connection to the Daktronics device:
   - **UDP** — select this option to use a UDP port as the connection type and configure the following:
     - **Port** — enter or select the UDP port number for the Daktronics device.
   - **Serial** — select this option to use a serial port as the connection type and configure the following:
     - **Port** — enter or select the serial port number for the Daktronics device.
     - **Baudrate** — use the list to select the communication speed for the signals.
     - **Data Bits** — use the list to select the number of bits used to represent one character of data for the signals.
     - **Parity** — use the list to select the method used to check for lost data in a signal.
     - **Stop Bits** — use the list to select the number of bits used to indicate the end of a byte in a signal.
     - **Flow Control** — use the list to select the data transmission rate controller for a signal.

d. Click **OK**.

   The **Daktronics Linq - Configuration** dialog box closes and the new DataLinq Source is added to the **DataLinq Sources** section of the **XPression DataLinq Server** window.

**DashBoard DataLinq Source**

The **DashBoard Linq - Configuration** dialog box opens.

![DashBoard Linq - Configuration dialog box](image)
a. Enter in the **Host** box the IP address of the DashBoard DataLinq database.

b. Enter in the **Port** box the port number for the DashBoard DataLinq database.

c. Click **OK**.

The **DashBoard Linq - Configuration** dialog box closes and the new DataLinq Source is added to the **DataLinq Sources** section of the **XPression DataLinq Server** window.

**Excel DataLinq Source**

The **Excel Linq - Configuration** dialog box opens.

![Excel Linq Configuration Dialog Box]

**a.** Enter in the **Filename** box the full pathname of the Excel file that contains the data for the DataLinq source, or click **Browse (...)** to use the **Open** dialog box to locate and open the Excel file.

**b.** Use the **Open Mode** setting to select the method used by the DataLinq server to open the selected Excel file for data access. The available modes are as follows:

- **Open in background** — select this option to open the Excel file in the background, without starting an instance of the Excel program.
- **Open in new Excel instance** — select this option to open the Excel file in a new instance of the Excel program.
- **Open in existing Excel instance** — select this option to open the Excel file in an existing instance of the Excel program. A new instance of the Excel program is started when there is no existing instance of the Excel program.

**c.** Use the **Worksheet** list to select the worksheet in the Excel file that contains the data for the DataLinq source.

**d.** Click **OK**.

The **Excel Linq - Configuration** dialog box closes and the new DataLinq Source is added to the **DataLinq Sources** section of the **XPression DataLinq Server** window.

**GSIS DataLinq Source**

The **GSIS Linq - Configuration** dialog box opens.

![GSIS Linq Configuration Dialog Box]

**a.** In the **Message Queue Path** box, enter the full pathname of the message queue folder.

- **It is essential that the Message Queue Path matches the information sent from GSIS**
b. In the **Message Label** box, enter a name for the message queue.

c. Select the **Wrap Indices** check box to wrap the indices above the record count within record count limits. This check box should be selected when using looping queries.

The **Wrap Indices** check box is selected by default.

d. Select the **Cache Results To Disk** check box to cache query results to disk. This check box should be selected when using looping queries.

e. Click OK.

The **GSIS Linq - Configuration** dialog box closes and the new DataLinq Source is added to the **DataLinq Sources** section of the **XPression DataLinq Server** window.

**OES Scoreboards DataLinq Source**

The **OES Linq - Configuration** dialog box opens.

![OES Linq - Configuration dialog box]

a. Use the **Game Feed** list to select a sports feed. The available feeds are:

- Football
- Lacrosse
- Baseball Model7929
- Basketball
- Hockey

b. Select the **Trim Text** check box to remove extra spaces from the feed.

c. In the **Connection Options** section, use the **Connection Type** options to select the connection to the OES device:

- **UDP** — select this option to use a UDP port as the connection type and configure the following:
  - **Port** — enter or select the UDP port number for the OES device.
- **Serial** — select this option to use a serial port as the connection type and configure the following:
  - **Port** — enter or select the serial port number for the OES device.
  - **Baudrate** — use the list to select the communication speed for the signals.
  - **Data Bits** — use the list to select the number of bits used to represent one character of data for the signals.
  - **Parity** — use the list to select the method used to check for lost data in a signal.
  - **Stop Bits** — use the list to select the number of bits used to indicate the end of a byte in a signal.
  - **Flow Control** — use the list to select the data transmission rate controller for a signal.
d. Click OK.

The **OES Linq - Configuration** dialog box closes and the new DataLinq Source is added to the **DataLinq Sources** section of the **XPression DataLinq Server** window.

**RSS Feed DataLinq Source**

The **RSS Linq - Configuration** dialog box opens.

![RSS Feed DataLinq Source Configuration dialog box](image)

a. In the **URL** box, enter the URL used to access the RSS feed.

b. In the **Update Interval** box, enter or select the number of milliseconds to wait between RSS feed update checks.

c. Select the **Wrap Indices** check box to wrap the indices above the record count within record count limits. This check box should be selected when using looping queries.

The **Wrap Indices** check box is selected by default.

d. Select the **Use Basic Authentication** check box to set a username and password for the DataLinq Source.

e. In the **User Name** box, enter a username for the basic authentication.

f. In the **Password** box, enter a password for the basic authentication.

g. Click OK.

The **RSS Linq - Configuration** dialog box closes and the new DataLinq Source is added the **DataLinq Sources** section of the **XPression DataLinq Server** window.

**Text DataLinq Source**

The **Text Source - Setup** dialog box opens.

![Text DataLinq Source Configuration dialog box](image)
a. Enter in the Filename box the full pathname of the text file that contains the data for the Datalinq source, or click Browse (...) to use the Open dialog box to locate and open the text file.

b. In the Options section, select one of the following radio buttons to determine when to check for text source file changes:
   - Wait for file change events — update the text when the text file source is updated. This is not recommended for network drives.
   - Poll every — select this radio button and then enter or select a time interval in seconds to poll the text source for any updates or changes.

c. Select the Wrap Indices check box to wrap the indices above the record count within record count limits. This check box should be selected when using looping queries.

   The Wrap Indices check box is selected by default.

d. Select the Strip blank lines from file check box to remove blank lines of text from the text source.

e. In the Format section, use the Delimiter list to select the character used to divide the data values on each line in the text file. The available delimiters are as follows:

   - Comma (,)
   - Colon (;)
   - Semicolon (;)
   - Tab
   - None
   - Other

   When Other is the selected delimiter, enter the delimiter character to use in the box to the right of this list.

f. Use the New Line list to select the character used in the text file to start a new line. The available characters are as follows:

   - None
   - Break tag “<br>”
   - Paragraph “¶”
   - Carriage Return Line Feed “CrLf”
   - Slash n “\n”
   - Carat p “^p”
   - Other

   When Other is the selected new line, enter the new line character to use in the box to the right of this list.

g. Use the Text Quotation list to select the character used in the text file to enclose quotations. The available characters are as follows:

   - Normal Quotation Mark (‘“’)
   - Apostrophe (‘’)

h. Use the Escape Quotes in Text Using setting to select the method used to treat quotation marks in the text file as regular characters. The available modes are as follows:

   - Two Quotation Marks — select this option to treat two quotation marks (""") as a single quotation mark (‘”) character with no special meaning.
   - Backslash Prefix — select this option to treat backslash character followed by a quotation mark (‘") as a single quotation mark (‘") character with no special meaning.

   HTML character entity references are converted to the correct symbol, such as &copy (©) and &reg (®).
i. Click OK.

The Text Linq - Configuration dialog box closes and the new DataLinq Source is added the DataLinq Sources section of the XPression DataLinq Server window.

White Way DataLinq Source

The White Way Linq - Configuration dialog box opens.

![Game Feed options](image)

a. Use the Game Feed list to select a sports feed. The only available sports feed is Basketball.

b. Select the Trim Text check box to trim the text.

c. In the Connection Options section, use the Connection Type options to select the connection to the White Way device:

- UDP — select this option to use a UDP port as the connection type and configure the following:
  - Port — enter or select the UDP port number for the White Way device.
- Serial — select this option to use a serial port as the connection type and configure the following:
  - Port — enter or select the serial port number for the White Way device.
  - Baudrate — use the list to select the communication speed for the signals.
  - Data Bits — use the list to select the number of bits used to represent one character of data for the signals.
  - Parity — use the list to select the method used to check for lost data in a signal.
  - Stop Bits — use the list to select the number of bits used to indicate the end of a byte in a signal.
  - Flow Control — use the list to select the data transmission rate controller for a signal.

d. Click OK.

The White Way Linq - Configuration dialog box closes and the new DataLinq Source is added to the DataLinq Sources section of the XPression DataLinq Server window.

XML DataLinq Source

The XML Linq - Configuration dialog box opens.
a. Enter in the Filename box the full pathname of the XML file that contains the data for the Datalinq source, or click Browse (...) to use the Open dialog box to locate and open the XML file.

b. Select the Wrap Indices check box to wrap the indices above the record count within record count limits. This check box should be selected when using looping queries.

   The Wrap Indices check box is selected by default.

c. In the Options section, select one of the following radio buttons to determine when to check for XML source file changes:

   • Wait for file change events — update when the XML source file is updated. This is not recommended for network drives.
   • Poll every — select this radio button and then enter or select a time interval in seconds to poll the XML source file for any updates or changes.

d. Click OK.

   The XML Linq - Configuration dialog box closes and the new DataLinq Source is added the DataLinq Sources section of the XPression DataLinq Server window.

6. In the Name column of the XPression DataLinq Server window, click a DataLinq Source name to select the DataLinq name.

7. Enter a new name for the selected DataLinq source.

For More Information on...

   • connecting to a DataLinq Server from XPress, refer to the procedure “Connect XPression to a DataLinq Server” on page 19–13.
   • creating a text object from a DataLinq source, refer to the procedure “Link a Text Object to a DataLinq Data Source” on page 19–14.
Connect XPression to a DataLinq Server

1. In the Editor window, select Project > DataLinq Manager.

   The XPression DataLinq Manager dialog box opens.

   ![DataLinq Manager dialog box]

2. Click Add.

   The DataLinq Server - Properties dialog box opens.

   ![DataLinq Server - Properties dialog box]

3. In the Name box, enter a name for the new DataLinq server connection.

4. In the Host Address box, enter the IP address of the computer running the DataLinq server to which to connect. Enter localhost when the DataLinq server is running on the same computer as XPression.

5. In the Port box, enter or select the port number used to communicate with the computer running the DataLinq server. The default port number is 8888.

6. Click OK.

   The defined DataLinq server connection is added to the DataLinq Servers section of the XPression DataLinq Manager dialog box. The DataLinq sources made available by the new DataLinq server connection are listed in the Available DataLinq Sources section.

7. To connect to additional DataLinq servers, follow steps 2 to 6.

For More Information on...
- running a DataLinq server and configuring DataLinq sources, refer to the procedure “Start the DataLinq Server” on page 19–2
- creating a text object from a DataLinq source, refer to the procedure “Link a Text Object to a DataLinq Data Source” on page 19–14.
Link a Text Object to a DataLinq Data Source

1. Add a text object to a scene.
2. In the **Object Manager** window, select the text object for the DataLinq.

![Object Manager Window](image)

3. Click the **Data Source** tab in the **Object Inspector - Text Object** window. The **Data Source** tab opens.

![Object Inspector - Text Object](image)

4. Select the **DataLinq** option. DataLinq information and a **Set** button are displayed below the options.

5. Click **Set**. The **Set DataLinq Properties** dialog box opens.

![Set DataLinq Properties](image)

6. Select the **Enabled** check box to enable DataLinq property configuration for the text object.
7. Use the **DataLinq** list to select the DataLinq source that contains the data for the text object to display.
8. Click **Browse** to use the **Select DataLinq Field** dialog box to select the column and row, or table, that contains the text object data, or use the **Column**, **Row**, and **Table** boxes to enter the names of the column and row, or table, that contain the text object data.
9. Use the **<n> Increment** box to select or enter a value other than 0 when the **<n>** increment differs from the number of templates.
10. Select the **Live Update** check box to immediately update an online text object with changes from the associated DataLinq source changes when the scene is on-air.
11. Select the **Entity Decoding** check box to translate HTML character entity reference codes into the correct corresponding characters.

   For example, the HTML character entity reference code `&copy;` is translated into the © character for a text object.

12. Select the **Return Empty on Failure** check box to leave the object empty if the DataLinq fails.

13. Select the **Disable Font Tag Parser** check box to disable the parsing of {font} tags from the DataLinq source.

14. Click OK.

   Data from the selected DataLinq source is displayed by the selected text object.

For More Information on...

- adding a text object to a scene, refer to the procedure “Create a Text Object” on page 5–2.
- running a DataLinq server and configuring DataLinq sources, refer to the procedure “Start the DataLinq Server” on page 19–2.
- connecting to a DataLinq Server from XPression, refer to the procedure “Connect XPression to a DataLinq Server” on page 19–13.
Link a Quad Object to a DataLinq Source

1. Add a quad object to a scene.
2. In the Object Manager window, select the quad object for the DataLinq.

3. Click the DataLinq tab in the Object Inspector - Quad Object window.
   The DataLinq tab opens.

4. Select the DataLinq option.
   The DataLinq Properties section is displayed.

5. Select the Enabled check box to enable DataLinq property configuration for the quad object.
6. Use the DataLinq list to select the DataLinq source that contains the data for the quad object to display.
7. Click Browse to use the Select DataLinq Field dialog box to select the column and row, or table, that contain the quad object data, or use the Column, Row, and Table boxes to enter the names of the column and row, or table, that contain the quad object data.
   This data could be formatted as a file path or a material name from the currently loaded project.
8. Select the Live Update check box to immediately update an online quad object with changes from the associated DataLinq source changes when the scene is on-air.
9. Select the Entity Decoding check box to translate HTML character entity reference codes into the correct corresponding materials.
10. Select the **Clear Image on Failure or Empty Data** check box to clear the image if the value returned from the DataLinq is empty.

11. Use the `<n>` **Increment** box to select or enter a value other than 0 when the `<n>` increment differs from the number of templates.

**For More Information on...**

- adding a quad object to a scene, refer to the procedure “**Create a Quad Object**” on page 7–2.
- running a DataLinq server and configuring DataLinq sources, refer to the procedure “**Start the DataLinq Server**” on page 19–2.
- connecting to a DataLinq Server from XPression, refer to the procedure “**Connect XPression to a DataLinq Server**” on page 19–13.
Link a Cube Object to a DataLinq Source

1. Add a cube object to a scene.
2. In the **Object Manager** window, select the cube object for the DataLinq.

3. Click the **DataLinq** tab in the **Object Inspector - Cube Object** window.

   The **DataLinq** tab opens.

4. Select the side of the cube object from the **Face** list to which the material is to be applied.
5. Select the **DataLinq** option.

   The **DataLinq Properties** section is displayed.

6. Select the **Enabled** check box to enable DataLinq property configuration for the cube object face.
7. Use the **DataLinq** list to select the DataLinq source that contains the data for the cube object face to display.
8. Click **Browse** to use the **Select DataLinq Field** dialog box to select the column and row, or table, that contain the cube object face data, or use the **Column**, **Row**, and **Table** boxes to enter the names of the column and row, or table, that contain the cube object face data.
9. Select the **Live Update** check box to immediately update an online cube object face with changes from the associated DataLinq source changes when the scene is on-air.
10. Select the **Entity Decoding** check box to translate HTML character entity reference codes into the correct corresponding materials.
11. Select the **Return Empty on Failure** check box to leave the object face empty if the DataLinq fails.
12. Repeat steps 4 to 11 for all other cube object faces that a material from a DataLinq source is to be applied.

For More Information on...

- adding a cube object to a scene, refer to the procedure “Create a Cube Object” on page 7–8.
- running a DataLinq server and configuring DataLinq sources, refer to the procedure “Start the DataLinq Server” on page 19–2.
- connecting to a DataLinq Server from XPression, refer to the procedure “Connect XPression to a DataLinq Server” on page 19–13.
Using DataLinq Keys with an ADODB DataLinq

A DataLinq Key is a value that can be set up to globally increment the data field within a specific DataLinq template.

1. Open or create a project in XPression that uses an ADODB DataLinq.
2. Select a Scene or Scene Group in the Object Manager window.

3. Click the DataLinq Keys tab in the Object Inspector - Scene Object window.

   The DataLinq Keys tab opens.

4. Click Add.

   A new DataLinq Key is added to the Keys list.

5. In the Name column, enter a name for the DataLinq Key.

   It is important to give the key a meaningful name in regards to the scene or scene group; for example ‘Jersey Number’.

6. Select an object in the scene or scene group that uses DataLinq as its data source and is to be linked with the DataLinq Key.

   For example, a text object that has a player name or a quad object that contains a player headshot.
7. Depending on the selected object, click the **Data Source** or **DataLinq** tab in the **Object Inspector** window of the object.

   The **Data Source** or **DataLinq** tab opens.

   ![Data Source Tab](image)

8. Click **Set**.

   The **Set DataLinq Properties** dialog box opens.

   ![Set DataLinq Properties Dialog](image)

9. In the **Row** box, enter the name of the DataLinq Key. For example, for the ‘Jersey Number’ example, enter `%Jersey Number%`.

10. Click **OK**.

    The **Set DataLinq Properties** dialog box closes.

11. Repeat steps 6 to 10 to link the DataLinq Key with other objects.

12. In the **Object Manager** window, select the **Scene** or **Scene Group** that contains the DataLinq Key.

13. Click the **DataLinq Keys** tab in the **Object Inspector - Scene Object** window.

    The **DataLinq Keys** tab opens.

14. Configure the value:

    **Layout**

    a. In the **Object Manager** window, select the **Scene** or **Scene Group** object that contains the DataLinq Key.

    b. Click the **DataLinq Keys** tab in the **Object Inspector - Scene Object** window.

        The **DataLinq Keys** tab opens.

    c. Enter a value (for example, a player jersey number) or a macro in the **Value** column of the DataLinq Key and press **Enter**.

        The objects linked to the DataLinq Key are updated in the Main Viewport with the data from the DataLinq source.

    **Sequencer**

    a. In the **Sequencer**, select the take item that contains the objects linked to the DataLinq Key.
b. Click the **Template Data** tab in the **Take Inspector - Item** window.

The **Template Data** tab opens.

![Take Inspector - Item window with Template Data tab](image)

c. Use the Template Data editor next to the Object List to enter a value for the DataLinq Key.

The changes to the DataLinq Key value for the take item are reflected in the Preview window.

**For More Information on...**

- running a DataLinq server and configuring DataLinq sources, refer to the procedure “**Start the DataLinq Server**” on page 19–2.
- connecting to a DataLinq Server from XPression, refer to the procedure “**Connect XPression to a DataLinq Server**” on page 19–13.
- using a macro with a DataLinq Key, refer to the procedure “**Using a Macro with a DataLinq Key**” on page 19–29.
Using DataLinq Keys with an XML DataLinq

A DataLinq Key is a value that can be set up to globally increment the data field within a specific DataLinq template.

1. Open or create a project in XPression that uses an XML DataLinq source.
2. In the Object Manager window, select an object for the DataLinq.

3. Click the Data Source tab in the Object Inspector - Object window.
   
   The Data Source tab opens.

4. Select the DataLinq option.
   
   DataLinq information and a Set button are displayed below the options.

5. Click Set.
   
   The Set DataLinq Properties dialog box opens.

6. Select the Enabled check box to enable DataLinq property configuration for the object.

7. Use the DataLinq list to select the XML DataLinq source that contains the data for the object to display.

8. Click Browse.
   
   The Select DataLinq Field dialog box opens.
9. In the **Data** section, select a data attribute to use for the object. For example, if using a DataLinq for a sporting event, select a player uniform number as the attribute.

ær It is often easier to use a second record as the data attribute because it automatically enters the brace brackets required to enter the data increment format.

10. Click **OK**.

   The **Select DataLinq Field** dialog box closes and the **Set DataLinq Properties** dialog box is updated with the selected DataLinq settings.

[Image of DataLinq settings dialog box]

11. Click **OK**.

   The **Set DataLinq Properties** dialog box closes.

12. Repeat steps 2 to 11 to configure other objects in the scene or scene group that are to use DataLinq Keys. For example, if using a DataLinq for a sporting event, select the player name from the **Data** section in the **Select DataLinq Field** dialog box.

13. In the **Object Manager**, select the **Scene** or **Scene Group** that contains the DataLinq objects.

[Image of Object Manager]

14. Click the **DataLinq Keys** tab in the **Object Inspector - Scene Object** window.

   The **DataLinq Keys** tab opens.

[Image of DataLinq Keys tab]
15. Click Add.
   A new DataLinq Key is added to the Keys list.

16. In the Name column, enter a name for the DataLinq Key.
   It is important to give the key a meaningful name in regards to the scene or scene group; for example ‘jersey’.

17. In the Value column, enter a default value for the DataLinq Key.
   For example, a jersey number.

18. Select the object in the scene or scene group that uses the DataLinq as its data source and is to be linked with the DataLinq Key.

19. Click the Data Source tab in the Object Inspector - Object window.

20. Click Set.
   The Set DataLinq Properties dialog box opens.

21. In the Column box, between the brace brackets, set up the data increments for the DataLinq Key value. For example, for the jersey number in this procedure, the data increment format would be `<uni=%jersey%>`.
   * DataLinq Keys must always be wrapped in ‘%’ characters.

22. Click OK.
   The objects in the scene are updated with the DataLinq Key values and the DataLinq settings are updated in the Data Source tab of the object.

23. Repeat steps 13 to 22 for any other objects in the scene or scene group that use DataLinq.

For More Information on...
- running a DataLinq server and configuring DataLinq sources, refer to the procedure “Start the DataLinq Server” on page 19–2.
- connecting to a DataLinq Server from XPression, refer to the procedure “Connect XPression to a DataLinq Server” on page 19–13.
Using SQL Queries

Use SQL queries to sort and filter data in templates.

1. Open or create a project in XPression that uses an ADODB DataLinq source.
2. In the Object Manager window, select an object for the DataLinq.

3. Click the Data Source tab in the Object Inspector - Object window.
   The Data Source tab opens.

4. Select the DataLinq option.
   DataLinq information and a Set button are displayed below the options.
5. Click Set.
   The Set DataLinq Properties dialog box opens.

6. Select the Enabled check box to enable DataLinq property configuration for the object.
7. Use the DataLinq list to select the ADODB DataLinq source that contains the data for the object to display.
8. Click Browse.
   The Select DataLinq Field dialog box opens.
9. Use the Table box to enter the query. For example, SELECT * FROM ROSTER ORDER BY PTS DESC.
10. Click OK.
   The Select DataLinq Field dialog box closes and the Set DataLinq Properties dialog box is updated with the query.
   
   ![Select DataLinq Field dialog box]

11. Click OK.
   The Set DataLinq Properties dialog box closes.

12. In the Data Source tab in the Object Inspector - Object window, right-click inside the Select Data Source section and select Copy DataLinq from the shortcut menu.

   ![Object Inspector - Object window]

13. In the Object Manager, select a different object to be used for the DataLinq query.

14. Click the Data Source tab in the Object Inspector - Object window.
   The Data Source tab opens.

15. Select the DataLinq option.

16. Right-click inside the Select Data Source section and select Paste DataLinq from the shortcut menu.
   The DataLinq source information is added to the Select Data Source tab.

   ![Object Inspector - Object window with Data Source tab open]
17. Right-click inside the **Select Data Source** section and select **Increment Row** to increase the row number.

The **Row** number increases by one.

18. Repeat steps 13 to 17 for other objects to be used for the DataLinq query.

**For More Information on...**

- running a DataLinq server and configuring DataLinq sources, refer to the procedure “**Start the DataLinq Server**” on page 19–2.
- connecting to a DataLinq Server from XPression, refer to the procedure “**Connect XPression to a DataLinq Server**” on page 19–13.
Using a Macro with a DataLinq Key

1. Open or create a project in XPression that uses DataLinq.
2. Create a DataLinq Key.
3. Use the Sequencer or Layout to apply a macro to the DataLinq Key.

   **Sequencer**
   
a. In the Sequencer, select the take item that contains the objects linked to the DataLinq Key.

b. Click the Template Data tab in the Take Inspector - Item window.

   The Template Data tab opens.

   ![Template Data Tab](image)

   c. In the Template Data editor next to the Object List, right-click and select a macro. The options are as follows:

      - **Insert Macro > takeid** — select this macro to generate a DataLinq Key based on the Take ID number.
        
        This macro can be used as an equation. For example, if you have a Take ID number of 101 and want to access record 1 in the DataLinq, the takeid macro with an equation would be entered as `<%takeid% - 100>`.

      - **Insert Macro > groupid** — select this macro to generate a DataLinq Key based on the Group ID number.
        
        This macro can be used as an equation. For example, if you have a Group ID number of 101 and want to access record 1 in the DataLinq, the groupid macro with an equation would be entered as `<%groupid% - 100>`.

      - **Insert Macro > relid** — select this macro to generate a DataLinq Key value based on the Take ID value relative to the Group ID value.

      - **Insert Macro > DataLinq Keys > DataLinq Key** — select this option to select a DataLinq Key and its value as the macro.
        
        This macro can be used as an equation. For example, if you have a DataLinq Key with a value of 20 and want to access record 30 in the DataLinq, the `<DataLinq Key>` macro with an equation would be entered as `<%DataLinq Key% + 10>`.

   **Layout**
   
a. In the Layout, select the scene that contains the objects linked to the DataLinq Key.

b. In the Object Manager window, select the Scene or Scene Group object that contains the DataLinq Key.

c. Click the DataLinq Keys tab in the Object Inspector - Scene Object window.
The **DataLinq Keys** tab opens.

![DataLinq Keys Tab](image)

**d.** In the **Value** column, enter a macro for the DataLinq Key. The options are as follows:

- **%takeid%** — enter this macro to generate a DataLinq Key based on the Take ID number. This macro can be used as an equation. For example, if you have a Take ID number of 101 and want to access record 1 in the DataLinq, the takeid macro with an equation would be entered as `<%takeid% - 100>`.

- **%groupid%** — enter this macro to generate a DataLinq Key based on the Group ID number. This macro can be used as an equation. For example, if you have a Group ID number of 101 and want to access record 1 in the DataLinq, the groupid macro with an equation would be entered as `<%groupid% - 100>`.

- **%relid%** — enter this macro to generate a DataLinq Key value based on the Take ID value relative to the Group ID value.

- **%DataLinq Key%** — enter a value to use as a macro. This macro can be used as an equation. For example, if you have a DataLinq Key with a value of 20 and want to access record 30 in the DataLinq, the `<DataLinq Key>` macro with an equation would be entered as `<%DataLinq Key% + 10>`.

**For More Information on...**

- running a DataLinq server and configuring DataLinq sources, refer to the procedure “Start the DataLinq Server” on page 19–2.

- connecting to a DataLinq Server from XPression, refer to the procedure “Connect XPression to a DataLinq Server” on page 19–13.

- creating a DataLinq Key, refer to the procedure “Using DataLinq Keys with an ADODB DataLinq” on page 19–20.
Create a Data Page

Create Data Pages to use text/materials in an on-air scene to be updated via another take item in the Sequencer. Data Pages function as a holder for information. The Data Page can be cued prior to the original scene or taken after the original scene is already on the air.

1. Open a project in XPression.

2. Ensure that objects in the selected scene that are to be used with the Data Page are published to the Sequencer in the Template Links tab in the Object Inspector.

3. Create a Category in the Project Manager for storing the Data Pages. It is recommended that the category be given a meaningful name. For example, ‘Data Pages’.

   The new category appears in the Scene Manager.

4. Create a new scene in the newly created category.

5. In the new scene, create a text object or an object that uses a material, such as a quad or cube object.

6. In the Object Manager, enter a name for the new object that is the same as the object in the on-air scene that will use the Data Page.

   For example, if the object in the on-air scene is named ‘DATA’, name the object in the Data Page scene ‘DATA’.

7. Publish the object to the Sequencer using the Template Links tab in the Object Inspector.
8. In the **Sequencer**, create a new **Group** in the Take Item list and give it a meaningful name. For example, if the project is for a sports broadcast, the new Group could be named ‘Roster’.

![Group in Take Item list](image1)

9. Add scenes to the new **Group** in the Take Item list that are to be used with the Data Page.

10. Create a new **Group** in the Take Item list for storing Data Pages and give it a meaningful name. For example, ‘Data Pages’.

11. In the **Group** tab in the **Take Inspector - Group** window, select **Data Pages** from the **Playout Mode** list.

![Take Inspector - Group window](image2)

12. Drag the scene from the Data Pages **Category** in the **Scene Manager** and drop it in the **Group** item in the Take Item list used for the Data Pages.

* Ensure that the Data Page and the scene to which the data is being added are outputting on the same Layer and Framebuffer.

13. In the **Template Data** tab in the **Take Inspector - Item** window for the Data Page scene, use the **Template Data Editor** box to enter text for the Data Page. For example, ‘WIDE RECEIVER’.

![Template Data window](image3)


The **State** displays as **data cued**.

15. Take online the scene that uses the Data Page scene.

The text from the Data Page scene is displayed in the text object associated with the Data Page.

**For More Information on...**

- creating a category, refer to the procedure “Create a Category” on page 24–2.
- publishing objects to the Sequencer, refer to the procedure “Modify Template Content” on page 20–3.
Sequences

XPression uses the Sequencer to playout the scenes in a project.

The following topics are discussed in this section:

• Create a Sequence
• Modify Template Content
• Control Sequence Playout
• Playout a Sequence in Manual Mode
• Playout a Sequence in Automatic Mode
• Create a Roll/Crawl from a Take Item Group
• Customize a Take Item Group Roll/Crawl
Create a Sequence

1. Use XPression to create a number of scenes or scene groups from which to build a sequence.

2. Click **Sequence** at the top of the window to use the **Sequencer** to place scenes or scene groups on a sequence timeline for playout.

3. In the **Scene Manager**, click and drag the scenes or scene groups to playout into the **Sequencer**. Each scene or scene group added to the Sequencer list is given a Take ID and becomes a take item.

4. To reorder take items in the Sequencer list, click and drag a take item to a new position in the list.Toolbar tools, shortcut menu commands, and keyboard shortcuts can also be used to reorder take items.

5. Organize take items by adding a take item group to the Sequencer list. A group can be configured to automatically playout the take items contained in the group.

   a. Click the **Create a New Group** button in the toolbar.
      A take item group is added to the Sequencer.

   b. Click in the **Name** column for the group to enter a new name for the group.

   c. Click and drag take items from the Sequencer list into the new group.

6. Highlight take items by adding color to the Sequencer list.

   a. Select one or more take items and/or take item groups to highlight with a colored background.

   b. Right-click and select the **Color** command.

      The **Color** menu opens.

   c. Select a highlight color from the **Color** menu.

      The background of the selected take items in the Sequencer list is shaded with the selected color. Coloring the background of a take item group also colors each take item in the group.

7. Adjust the font size of the take items by clicking the **Increase the size of the sequencer font** button to make the font size larger or the **Decrease the size of the sequencer font** button to make the font size smaller.

For More Information on...

- creating scenes, refer to the procedure “Create a Scene” on page 4–4.
- controlling sequence playout, refer to the procedure “Control Sequence Playout” on page 20–6.
Modify Template Content

1. In XPression, use the **Scene Manager** window to select a scene or scene group that contains objects to use as a template in a sequence.
   
   The objects contained in the selected scene or scene group are listed in the **Object Manager** window.

2. In the **Object Manager**, select an object to use as a template.

3. Click the **Template Links** tab in the **Object Inspector** window.
   
   The **Template Links** tab opens.

4. In the **Template Links** section, select the **Publish Object** check box.
   
   The table in the **Template Links** section lists the attributes of the selected object that can be published to the **Sequencer**. The values of published attributes can be changed for playout through the **Sequencer**.

5. In the **Published** column, select the check boxes associated with the object attributes to publish.
   
   Text objects are published by default with the text attributed selected as replaceable.

6. Note the name of the template object.

7. Click **Sequence** at the window to use the **Sequencer** to place the scene or scene group containing the template object on a sequence timeline for playout.

8. Add the template object scene or scene group to the **Sequencer**.

9. In the **Sequencer**, select the take item created for the template object scene or scene group.

10. Click the **Template Data** tab in the **Take Inspector - Item** window.
The Template Data tab opens.

11. In the Objects column, expand the template object.

   The attributes published for the template object are displayed.

12. Select the attribute to set a value for playout.

   If the template object is a text object, the text box to the right in the Static tab displays the value of the selected attribute. For other template objects, the Materials tab, Image Files tab, or Video Files tab displays the value of the selected attribute.

Text Objects

a. In the Static tab:
   - use the text box to enter a new font for the text by entering a tag (e.g. `{xx}`) that represents the name or ID of the font to be used or,
   - click the Insert Font Change Macro button to select a font thumbnail to apply to the attribute. The tag for the selected font is automatically placed at the current cursor location.

b. To open a saved text file in the template, click the File menu and select Import to open the Import Text File dialog box.

c. Adjust the font size of the text by clicking the Increase Font Size button to make the font size larger or the Decrease Font Size button to make the font size smaller.

Other Objects

a. Select the Materials tab to open the list of material thumbnails.

b. Double-click a material thumbnail to apply the material as the value of the attribute.

c. Select the Image Files tab to open the list of image file thumbnails.

d. Double-click an image file thumbnail to apply the image as the value of the object attribute. Use the browser above the image file thumbnails to open a different image file location.

e. Select the Video Files tab to open the list of video material thumbnails.

f. Double-click a video file thumbnail to apply the video file as the value of the object attribute. If the object had originally been assigned a video file, the properties of that video will be applied to the newly assigned video. Use the browser above the video file thumbnails to open a different video file location.

13. In the Sequencer, double-click the template object take item.

   The selected take item plays out through the default output using the entered attribute values.

14. To stop playout, right-click the template object take item and select Take Offline from the shortcut menu.
For More Information on...

- creating sequences, refer to the procedure “Create a Sequence” on page 20–2.
- controlling sequence playout, refer to the procedure “Control Sequence Playout” on page 20–6.
Control Sequence Playout

1. In the **Sequencer**, click the **Create a New Group** button in the toolbar to create a take item group to contain the scenes or scene groups to playout.

2. In the **Scene Manager**, click and drag the scenes or scene groups to playout into the new take item group in the **Sequencer**.

   The selected scene or scene groups are added to the take item group as take items.

3. To reorder a take item in a take item group, click and drag a take item to a new position in the group.

4. Select the take item group that contains the take items to playout.

5. In the **Take Inspector - Group** window, select **Manual** from the **Playout Mode** list.

6. In the **Sequencer**, double-click a take item to playout the selected take item.

   The selected take item plays out through the default output, and the **State** changes to **online** for take items or **Active** for take item groups.
7. To stop playout of an online or Active take item, right-click the take item and select **Take Offline** from the shortcut menu.

---

**Keyboard Control**

The keyboard number pad can also be used to control the playout of a sequence. The following keyboard shortcuts are available in the Sequencer:

- **Cursor Up Arrow** — select the previous take item in the sequence.
- **Cursor Down Arrow** — select the next take item in the sequence.
- **Ctrl-Home** — select the first take item in the sequence.
- **Ctrl-End** — select the last take item in the sequence.
- **Number Pad +** — playout the selected take item and select the next take item in the sequence.
- **Number Pad -** — skip the currently selected item and select next take item in the sequence.
- **Number Pad Enter** — playout the selected take item. This shortcut requires the **Fast Recall** button to be enabled.
- **+/-** — increase (+) or decrease (-) the speed of a roll/crawl while it is online.
Playout a Sequence in Manual Mode

1. In the Sequencer, select the take item group that contains the take items to playout.

2. In the Take Inspector - Group window, select Manual from the Playout Mode list.

3. In the Sequencer, double-click the take item group that contains the take items to playout. The selected take item group plays out through the default output, and the State changes to Active.

4. To stop playout of an Active take item, right-click the take item and select Take Offline from the shortcut menu.

For More Information on...

- creating sequences, refer to the procedure “Create a Sequence” on page 20–2.
- controlling sequence playout, refer to the procedure “Control Sequence Playout” on page 20–6.
Playout a Sequence in Automatic Mode

1. In the **Sequencer**, select the take item group that contains the take items to playout.

2. In the **Take Inspector - Group** window, select **Timed** from the **Playout Mode** list.

3. Use the **Start At** list to set the playout start time for the take item group. The available options are as follows:
   - **Immediate** — start playout immediately upon selecting a take item group for playout.
   - **Clock Time** — start playout at the time set in the **Start Time** box after selecting a take item group for playout.

4. Use the **Item Timing** list to select the item level on which to base playout duration. The available options are as follows:
   - **Per Item** — use the playout durations set for the items in the item group. The playout duration for the item group equals the total of all the item durations.
   - **Per Group** — set a playout duration for the entire item group. The duration is set in the **Group Duration** box.
   - **Per Item (Fixed)** — use a fixed playout duration for each of the items in the item group regardless of the durations of the individual take items. The duration for each item is set in the **Item Duration** box.

5. Use the **Repeat** list to set the number of times to repeatedly playout the item group. The available options are as follows:
   - **Never** — do not repeat playout, only playout the item group once.
   - **When Done** — repeat the playout of an item group when the playout ends. With this option, playout continually repeats until it is manually stopped.
   - **After** — repeat the playout of an item group after the time set using the **Time Value** box and **Time Unit** list. With this option, playout continually repeats until it is manually stopped.
   - **Every** — repeat the playout of an item group at a time interval set using the **Time Value** box and **Time Unit** list.
6. Use the **When Finished** list to set the action to complete after finishing the playout of the take item group. The available options are as follows:

   • **Keep Online** — leave the take item group status as Active, making the group available for immediate playout.
   • **Take Offline** — change the take item group status to Offline.

7. In the **Sequencer**, double-click the take item group that contains the take items to playout.

   The selected take item group plays out through the default output, and the **State** changes to **Active**.

**For More Information on...**

   • creating sequences, refer to the procedure “**Create a Sequence**” on page 20–2.
   • controlling sequence playout, refer to the procedure “**Control Sequence Playout**” on page 20–6.
Create a Roll/Crawl from a Take Item Group

1. Create a new XPression project or open an existing project to add a roll/crawl effect.
2. Create one or more scenes or scene groups to contain the objects displayed by the roll/crawl effect.
3. Select a scene and scene objects to it that are to move as part of the roll/crawl effect.
   For example, add a text object to a scene to represent the first line of text for a set of credits to be played by the roll/crawl effect.
4. Add objects to additional scenes as required.
   For example, each scene contains a text object that represents one line of text in a set of credits played by the roll/crawl effect.
5. Click Sequence at the top of the window to use the Sequencer to place scenes or scene groups on a sequence timeline for playout.
6. In the Sequencer, click the Create a New Group button in the toolbar to create a take item group to contain the scenes or scene groups that comprise the roll/crawl effect.
7. In the Scene Manager, click and drag the scenes or scene groups for the roll/crawl effect into the new take item group in the Sequencer.
8. To reorder take items in the roll/crawl effect, click and drag a take item to a new position in the take item group.
9. Select the take item group that contains the roll/crawl effect.
10. In the Take Inspector - Group window, select Roll/Crawl from the Playout Mode list.

11. In the Sequencer, double-click the take item group that contains the roll/crawl effect to playout the defined roll/crawl effect.

   The selected take item group plays out through the default output, and the State changes to Active.

For More Information on...

- customizing a sequence roll/crawl effect, refer to the procedure “Customize a Take Item Group Roll/Crawl” on page 20–13.
- controlling sequence playout, refer to the procedure “Control Sequence Playout” on page 20–6.
Customize a Take Item Group Roll/Crawl

1. In the **Sequencer**, select the take item group the contains the roll/crawl effect to customize.

The properties of the selected take item group are displayed in the **Take Inspector - Group** window.

2. Use the properties in the **Group** section to set roll/crawl effect properties for a take item group.

   **Properties**

   - **Effect** — use this list to select the roll/crawl effect with which to playout take items in a take item group. The available effects are as follows:
     - **Roll** — move take items vertically.
     - **Crawl** — move take items horizontally.

   - **Direction** — use this list to select the direction for the selected roll/crawl effect. The available directions depend on the selected **Effect**, and are as follows:

     | Roll Effect          | Crawl Effect       |
     |----------------------|--------------------|
     | Bottom To Top        | Right To Left      |
     | Top To Bottom        | Left To Right      |

3. Use the properties in the **Duration** section to set the playout duration for the selected roll/crawl effect.

   **Properties**

   - **Speed** — select this option to define the roll/crawl effect playout duration in pixels per second. Use the box to the right of this option to enter or select the number of pixels per second to playout a roll/crawl effect.

   - **Seconds** — select this option to define the roll/crawl effect playout duration in seconds. Use the box to the right of this option to enter or select the number of seconds in which to playout a roll/crawl effect.

   - **Frames** — select this option to define the roll/crawl effect playout duration in frames. Use the box to the right of this option to enter or select the number of frames in which to playout a roll/crawl effect.
4. Use the properties in the **Global Margins** section to set the spacing between take items displayed in a roll/crawl effect.

   **Properties**

   **Top** — in this box, enter or select the size in pixels of the margin placed above take items. This margin is used to control vertical spacing between consecutive take items played out in a roll effect.

   **Bottom** — in this box, enter or select the size in pixels of the margin placed below take items. This margin is used to control vertical spacing between consecutive take items played out in a roll effect.

   **Left** — in this box, enter or select the size in pixels of the margin placed to the left of take items. This margin is used to control horizontal spacing between consecutive take items played out in a crawl effect.

   **Right** — in this box, enter or select the size in pixels of the margin placed to the right of take items. This margin is used to control horizontal spacing between consecutive take items played out in a crawl effect.

5. Use the properties in the **Loop** section to set the number of times to playout a roll/crawl effect.

   **Properties**

   **Enable Looping** — select this check box to loop the playout of a roll/crawl effect. Clear this check box to only playout the roll/crawl effect one time.

   **Number of Shows Per Scene** — in this box, enter or select the number of times to loop the playout of a roll/crawl effect. Enter 0 to infinitely loop the playout.

   This box is only available when the Enable Looping check box is selected.

6. Use the properties in the **Header/Footer** section to set the type of page with which to start and end a roll/crawl effect.

   **Properties**

   **Blank Page on Start** — select this check box to start the roll/crawl effect with a blank page before displaying the take items in the roll/crawl effect. Clear this check box to start the roll/crawl effect with the first take item in the take item group.

   **Blank Page on End** — select this check box to end the roll/crawl effect with a blank page after displaying the take items in the roll/crawl effect. Clear this check box to end the roll/crawl effect with the last take item in the take item group.

   **Treat Last Page as Full** — select this check box to display the last take item in a roll/crawl effect as a full page.

7. Use the properties in the **Start/Stop** section to control the start and end playout speed of a roll/crawl effect.

   **Properties**

   **Ease In** — select this check box to slow the playout speed at the start of a roll/crawl effect.

   **Frames** — in this box, enter or select the number of frames at which to return a roll/crawl effect to normal playout speed.

   **Ease Out** — select this check box to slow the playout speed at the end of a roll/crawl effect.

   **Frames** — in this box, enter or select the number of frames from the end of a roll/crawl effect at which to slow the playout speed.

8. Use the property in the **Rendering** section to control lighting for a roll/crawl effect.

   **Property**

   **Per Scene Lighting** — select this check box to use a different lighting source for each take item in a roll/crawl effect. Clear this check box to use the lighting source in the first take item of the take item group for all of the other take items in the roll/crawl effect.

9. Double-click the take item group to playout the customized roll/crawl effect.

   The selected take item group is sent to the default output.
Output

The output of an XPression project can be sent to various locations, including being saved in an Audio Video Interleave format (.AVI) video file.

The following topic is discussed in this section:

- Preview Output in a Virtual Output
- Render Output to an AVI File
Preview Output in a Virtual Output

1. Use the Hardware Setup dialog box to configure an XPression Virtual Output.

![Hardware Setup dialog box]

2. Use XPression to create a scene or scene group.

3. Click Sequence at the top of the window to use the Sequencer to place the new scene or group on a sequence timeline for playout.

4. In the Scene Manager, click and drag the scene or scene group to output into the Sequencer.

![Scene Manager]

5. In the Output Monitors window, note the framebuffer number of the Virtual Output output monitor.

![Output Monitors]

6. Use the list in the Output column of the Sequencer to select the framebuffer number of the Virtual Output for the scene or scene group to output.

7. Double-click the scene or scene group in the Sequencer to take it “online”.

The XPression Virtual Output window opens to display the output of the selected scene or scene group.

Right-click the output in the XPression Virtual Output window and select Full Screen to use full screen display.

For More Information on...

- configuring an XPression Virtual Output, refer to the procedure “Configure an XPression Virtual Output” on page 3–30.
- creating scenes, refer to the procedure “Create a Scene” on page 4–4.
Render Output to an AVI File

1. Use the **Hardware Setup** dialog box to configure an XPression AVI Recorder.

![Hardware Setup dialog box](image1.png)

2. Use the XPression to create a scene or scene group to output to an Audio Video Interleave format (.AVI) video file.

3. Click **Sequence** at the top of the window to use the **Sequencer** to place the new scene or group on a sequence timeline for playout.

4. In the **Scene Manager**, click and drag the scene or scene group to output to an AVI file into the **Sequencer**.

![Scene Manager](image2.png)

5. In the **Output Monitors** window, note the framebuffer number of the **AVI Output** output monitor.

![Output Monitors](image3.png)

6. Use the list in the **Output** column of the **Sequencer** to select the framebuffer number of the **AVI Output** for the scene or scene group to output.

7. Double-click the scene or scene group in the **Sequencer** to take it “online”.

   The **Export AVI As** dialog box opens.

8. Locate and select a folder in which to save the AVI file, then enter a name for the AVI file in the **File Name** box.
9. Click Save.
   The Video Compression dialog box opens.

![](image)

10. Use the Compressor list to select the video compressor with which to output the AVI file.

11. Based on the selected video compressor, use the available controls to configure video compression settings.

12. Click OK.
   The AVI Recorder - Preview window opens to display the output being rendered to the selected AVI file.
   Depending on the selected scene or scene group, rendering an AVI file may take some time to complete.

For More Information on...
- configuring an XPression AVI Recorder, refer to the procedure “Configure an XPression AVI Recorder” on page 3–23.
- creating scenes, refer to the procedure “Create a Scene” on page 4–4.
Project Server

The Project Server allows XPression projects to be published and deployed using a server.

The following topics are discussed in this section:

• Setup Project Server
• Publish a Project to Project Server
• Deploy a Project from Project Server
Setup Project Server

1. In XPression, use the File menu to select Project Server > Setup.
   The Project Servers Setup dialog box opens.

2. Click Add to add a new project server or click Edit to edit an existing project server.
   The Edit Project Server dialog box opens.

3. Use the Edit Project Server dialog box to enter or edit the project server information.
   a. In the Name box, enter or edit a name for the project server.
   b. In the Host box, enter or edit the host IP address.
   c. In the Port box, enter or edit the host port number.

4. Click OK.
   The added or edited project server appears in the list in the Project Servers Setup dialog box.

5. Click Close.
   The Project Servers Setup dialog box closes.
Publish a Project to Project Server

1. Open a project in XPression.
2. Save the project.

* Saving the project is required before publishing it to the project server.

3. In XPression, use the File menu to select Project Server > Publish.
   The Log on to project server dialog box opens.

4. In the Log on to project server section, use the Name dropdown list to select the project server.
   * For a project server to appear in the Name list, a project server needs to be configured.

5. In the Login section, use the Login box to enter the project server login.
   The default login is admin.

6. Enter the project server login password in the Password box.
   The default password is admin.
   Select the Save Password check box to save the password.

7. Click Next.
8. Use the Show selection dialog box to create a new show or to revise an existing show.

Create a New Show

a. Click New Show.

The New show dialog box opens.

b. Use the New show dialog box to enter the following information for the new show:
   - Name — in this box, enter the name of the new show.
   - Season — in this box, enter the season of the show.
   - Client — in this box, enter the intended recipient of the show.
   - Description — in this box, enter a brief descriptor.
   - Air Date — from the dropdown calendar, select the air date of the show.
   - Note — in this box, enter a note for the show.
Revise a Show

a. If revising an existing show, select the show from the list or use the Search box to find and select a show.

9. Click Next.

The Set project revision information dialog box opens.

10. In the Set project revision information dialog box, use the New Project Revision Information section to revise the following project information:
   - **Project Name** — in this box, enter a revised name for the project.
   - **Author** — from the dropdown list, select a revised author for the project.
   - **Description** — from the dropdown list, select a revised description for the project.
   - **Air Date** — from the dropdown calendar, select a revised air date for the project.
   - **Note** — in this box, enter a revised note for the project.

11. Click Next.

The next Set project revision information dialog box opens.
a. In the **Options** section, select the **Include unused files in the project’s default folders** check box to include unused files for the project in the default folders.

b. Click **Add** to create a new folder.

12. Click **Next**.

The **Ready to publish** dialog box opens.

13. Use the **Ready to publish** dialog box to review the project information before publishing.

14. Click the **Publish** button to publish the project to the project server.

15. Click **Close**.

For More Information on...
- configuring a project server, see *XPression Project Server User Guide*. 
Deploy a Project from Project Server

1. Open a project in XPression.

2. In XPression, use the File menu to select Project Server > Deploy.
   The Log on to project server dialog box opens.

3. In the Project Server section, use the Name dropdown list to select the project server.

4. In the Login section, use the Login box to enter the project server login.
   The default login is admin.

5. Enter the project server login password in the Password box.
   The default password is admin.
   Select the Save Password check box to save the password.

6. Click Next.
   The Select show to deploy from dialog box opens.
7. Use the **Select show to deploy from** dialog box to select a show from the list or use the **Search** box to find and select a show.

8. Click **Next**.

   The **Select revision to deploy** dialog box opens.

   ![Select revision to deploy dialog box]

9. In the **Select revision to deploy** dialog box, select the revision number to deploy from the project server.

10. Click **Next**.

   The **Select target folder for deployment** dialog box opens.

   ![Select target folder for deployment dialog box]

11. In the **Select target folder for deployment** dialog box, use the **Local Folder** box to type a filepath to a folder or click the **Browse** button to select a folder.

12. Select the **Open project after deployment** check box to open the project after deploying.

13. Click the **Deploy** button to deploy the project from the project server.

14. Click **Close**.
Keyboard and GPI Mapping

Keyboard and GPI mapping enables many of the XPression functions to be assigned to keyboard shortcuts or GPI input triggers. Many of XPression’s existing default keyboard shortcuts can also be customized.

The following topics are discussed in this section:

• Create a Custom Keyboard Map
• Assign a Project Shortcut
• Assign a Global Shortcut
• Assign a Local Shortcut
• Create a Custom GPI Map
• Use the Quick Menu
Create a Custom Keyboard Map

1. In XPression, use the Edit menu to select Keyboard / GPI Mapping.

   The Keyboard / GPI Mapping dialog box opens.

2. Click the Save Keyboard Mapping button to create a new custom keyboard mapping.

   The Save Keyboard Mapping dialog box opens.

3. In the Save Keyboard Mapping dialog box, enter a name for the new custom keyboard mapping.

4. Click OK.

   The added custom keyboard mapping appears in the Current Keyboard Map list.

For More Information on...
- assigning a Global Shortcut, refer to “Assign a Global Shortcut” on page 23–4.
- assigning a Local Shortcut, refer to “Assign a Local Shortcut” on page 23–8.
Assign a Project Shortcut

Project shortcuts represent keyboard hotkeys that apply to a specific XPression project.

1. In XPression, use the Edit menu to select Keyboard / GPI Mapping.
   The Keyboard / GPI Mapping dialog box opens.

   ![Keyboard / GPI Mapping dialog box](image)

2. Select a a keyboard map from the Current Keyboard Map list or create a custom keyboard map.

3. Drag an item from the Global Functions list into the Project Shortcuts table as necessary.

4. In the Project Shortcuts table, right-click on an item in the shortcuts tree and select Assign Shortcut to assign a custom keyboard control to the selected item.

5. In the Shortcut Details section, perform the following:
   a. In the Name box, edit the name of the selected item if necessary.
   b. In the Shortcut box, enter a keyboard shortcut to assign to the selected item by entering the command on the keyboard.

      The assigned keyboard shortcut appears in the Shortcut box and in the row for the selected item under the Direct Access Shortcut column in the Project Shortcuts table.

      If the assigned keyboard shortcut is already in use by another function, a hazard icon [!] will appear next to the command in the Direct Access Shortcut column. Place the cursor over the hazard icon to view where the conflict occurs.

6. Click OK.

For More Information on...
- creating a custom keyboard map, refer to “Create a Custom Keyboard Map” on page 23–2.
Assign a Global Shortcut

Global Shortcuts represent functions that can be assigned to keyboard hotkeys that are active at any time while XPression is running.

1. In XPression, use the Edit menu to select Keyboard / GPI Mapping. The Keyboard / GPI Mapping dialog box opens.

2. Select a a keyboard map from the Current Keyboard Map list or create a custom keyboard map.

3. In the Available Global Functions list, drag and drop the Group function or click the Add Group button in the toolbar to create a group branch in the Global Shortcuts tree.

4. In the Available Global Functions list, select a function and drag and drop it into the desired spot in the Global Shortcuts tree to add the function.

   Entering a function in the Filter box lets you search the Available Global Functions list for a specific function.
5. In the **Global Shortcuts** table, right-click on an item in the shortcuts tree and select **Assign Shortcut** to assign a custom keyboard control to the selected item.

6. In the **Shortcut Details** section, perform the following:
   
   a. In the **Name** box, edit the name of the selected item if necessary.
   
   b. In the **Shortcut** box, enter a keyboard shortcut to assign to the selected item by entering the command on the keyboard.

      The assigned keyboard shortcut appears in the **Shortcut** box and in the row for the selected item under the **Direct Access Shortcut** column in the **Global Shortcuts** table.

      If the assigned keyboard shortcut is already in use by another item, a hazard icon \(\text{⚠️}\) will appear next to the command in the **Direct Access Shortcut** column. Place the cursor over the hazard icon to view where the conflict occurs.

   c. Select the **Include In Quick Menu** check box to include the keyboard shortcut in a Quick Menu.

      Quick Menus are shortcut menus that appear when a Quick Key for a Global Shortcut is entered. The keyboard shortcuts available for the selected Global Shortcut are listed in the Quick Menu that appears. This feature only applies to Global Shortcut branches that contain children nodes.

      In the **Quick Key** box, enter a letter or number as the Quick Menu command.

7. In the options section located to the right of the **Shortcut Details** section, configure the shortcut options of various functions:

   **Assign Material Options**
   - Select **Current Selected Material** to assign the selected material to an object, or select **Name** and enter a material in the box to assign that material to an object. Select **Name** and leave the box blank to remove the material from an object.

   **Clear Layer Options**
   - **Framebuffer** — use the list to select a framebuffer for clearing the layer.
   - **Layer** — in this box, enter or select a layer.

   **Clear Single Channel Options**
   - **Framebuffer** — use the list to select a framebuffer for clearing the channel.
Group Options

- **Run all children actions when group triggered** — select this check box to run all of the keyboard shortcuts of the children attached to the group branch when the Quick Key assigned to the group is triggered.

Script Action Options

a. Click the **Edit Script Action** button.

   The **Script Editor - Script Shortcut** dialog box opens.

b. In the **OnKeyPress** tab, enter the .net scripting.

Select Font Options

- Select **By Name** and enter a font style name to assign a font to a text object, or select **By ID** and enter or select the font ID to assign the font to a text object.

Set Framebuffer Options

- **Framebuffer** — use the list to select a framebuffer or select **<none>**.

Set Layer Options

- **Layer** — in this box, enter or select a layer.

Set Transform Options

- **Position** — use this section to set the placement of an object in a project:
  - **X** — in this box, enter or select the X coordinate for the object location.
  - **Y** — in this box, enter or select the Y coordinate for the object location.
  - **Z** — in this box, enter or select the Z coordinate for the object location.
  - **Center in Viewport** — select this check box to center the object in the viewport.

- **Rotation** — use this section to set the rotation of an object:
  - **X** — in this box, enter or select the degrees to rotate an object around the X axis.
  - **Y** — in this box, enter or select the degrees to rotate an object around the Y axis.
  - **Z** — in this box, enter or select the degrees to rotate an object around the Z axis.
• **Scale** — use this section to scale an object:
  • **X** — in this box, enter or select the scale factor to apply to an object along the X (horizontal) axis.
  • **Y** — in this box, enter or select the scale factor to apply to an object along the Y (vertical) axis.
  • **Z** — in this box, enter or select the scale factor to apply to an object along the Z (depth) axis.

**Take Options**

• Select **Current Sequence Item** to apply the shortcut to the current item in a sequence, or select **Take ID** and enter or select a Take ID number in the box to apply the shortcut to the specific Take ID.

• **Move Sequencer Focus to Item** — check this box to set sequencer focus to the selected Take ID.

• **Framebuffer** — use the list to select a framebuffer for the Take Item.

• **Advance Sequence After Take** — check this box to advance to the next Take Item in the sequence after the current or selected Take Item has finished playing.

**Take Offline Options**

• Select **Current Sequence Item** to apply the shortcut to the current item in a sequence, or select **Take ID** and enter or select a Take ID number in the box to apply the shortcut to the specific Take ID.

8. Click **OK**.

**For More Information on...**

• creating a custom keyboard map, refer to "Create a Custom Keyboard Map" on page 23–2.

• using a Quick Menu, refer to “Use the Quick Menu” on page 23–12
Assign a Local Shortcut

Local shortcuts represent keyboard hotkeys that apply to one particular component of XPression, such as the Material Manager, and are only active when the particular component of XPression has keyboard/mouse focus.

1. In XPression, use the Edit menu to select Keyboard / GPI Mapping.

The Keyboard / GPI Mapping dialog box opens.

```
<table>
<thead>
<tr>
<th>Function</th>
<th>Quick Menu</th>
<th>Direct Access Shortcut</th>
<th>GPI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Shortcuts</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quick Menu</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Global Shortcuts</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quick Menu</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>+ Clear Channels</td>
<td>C</td>
<td>Custom Key: Clear Channel</td>
<td></td>
</tr>
<tr>
<td>+ Points</td>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+ Materials</td>
<td>M</td>
<td>CTRL +SHIFT +P</td>
<td></td>
</tr>
<tr>
<td>+ Printives</td>
<td>P</td>
<td>Custom Key: Printives</td>
<td></td>
</tr>
<tr>
<td>+ Sequence</td>
<td>S</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+ Object</td>
<td>D</td>
<td>Custom Key: Set Transform</td>
<td></td>
</tr>
<tr>
<td>+ Custom Keyboard</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

```

2. Select a keyboard map from the Current Keyboard Map list or create a custom keyboard map.

3. In the Local Shortcuts table, right-click on an item in the shortcuts tree and select Assign Shortcut to assign a custom keyboard control to the selected item.

4. In the Shortcut Details section, perform the following:
   a. In the Name box, edit the name of the selected item if necessary.
   b. In the Shortcut box, enter a keyboard shortcut to assign to the selected item by entering the command on the keyboard.

   The assigned keyboard shortcut appears in the Shortcut box and in the row for the selected item under the Direct Access Shortcut column in the Local Shortcuts table.

   If the assigned keyboard shortcut is already in use by another function, a hazard icon will appear next to the command in the Direct Access Shortcut column. Place the cursor over the hazard icon to view where the conflict occurs.

5. Click OK.

For More Information on...
- creating a custom keyboard map, refer to “Create a Custom Keyboard Map” on page 23–2.
Create a Custom GPI Map

1. Use the **Hardware Setup** dialog box to configure a GPI board for XPression.
2. In XPression, use the **Edit** menu to select **Keyboard / GPI Mapping**. The **Keyboard / GPI Mapping** dialog box opens.

3. Create a custom keyboard mapping that includes global shortcuts.

4. In the **Global Shortcuts** tree, right-click on a global shortcut and select **Edit GPI Assignment**.
The same GPI trigger can be assigned to multiple global functions to execute them in order.

5. In the GPI column of the Global Shortcuts table, perform the following to the selected global shortcut:

   **Steps**

   a. Select a GPI board from the list.

   b. In the GPI box, enter or select a GPI input to assign to the selected global shortcut.
If the assigned GPI input is already in use by another item, a hazard icon will appear next to the GPI details in the GPI column. Place the cursor over the hazard icon to view where the conflict occurs.

6. Click OK.

For More Information on...
• adding an Adrienne TC/GPIO card, refer to “Configure a 25-Pin GPIO Port” on page 3–40.
• adding a Serial GPI board, refer to “Configure RS232 CTS/DSR GPI for Contact Closures” on page 3–38.
• adding a Smart GPI/RossTalk board, refer to “Configure Smart GPI / RossTalk” on page 3–42.
• creating a custom keyboard, refer to “Create a Custom Keyboard Map” on page 23–2.
• configuring and working with GPIs, refer to the GPI White Paper available from Ross Video.
Use the Quick Menu

1. Create a custom keyboard mapping that includes Global Shortcuts.
2. In XPression, enter the keyboard shortcut for a Global Shortcut branch.
   The Quick Menu for the Global Shortcut branch opens.

3. In the Quick Menu perform one of the following:
   • Use the Quick Keys to select an item from the Quick Menu, or
   • Use the keyboard arrows to select an item and press Enter.
   The selected Quick Menu item action is triggered.
   • Press Esc at any time in a Quick Menu to close the Quick Menu.

For More Information on...
• creating a custom keyboard, refer to “Create a Custom Keyboard Map” on page 23–2.
• assigning a Global Shortcut, refer to “Assign a Global Shortcut” on page 23–4.
Project Manager

The Project Manager window is used to create and organize category folders to organize XPression project scenes and scene groups.

The following topics are discussed in this section:

• Create a Category
• Add a Scene or Scene Group to a Category
• Delete a Category
• Open Multiple Projects in the Project Manager
• Activate a Project from a Project Group
• Remove a Project from a Project Group
Create a Category

1. Open or create a new project in XPression.

   The project appears in the Project Manager window under the Project Group node.

2. In the Project Manager window, right-click on the Categories node of the project.

   The shortcut menu opens.

   ![Project Manager window with Categories node selected](image)

3. Select Add Category Ins.

   A New Category node is added to the Categories node.

   ![Project Manager window with new category added](image)

   The New Category also appears at the bottom of the Scene Manager window.

4. In the Project Manager window, enter a new name for the category.

5. Press the Return key to save the new category name.

   For More Information on...
   - adding a scene or scene group to a category, refer to the procedure “Add a Scene or Scene Group to a Category” on page 24–3.
   - creating a new project in XPression, refer to the procedure “Create a Project” on page 4–2.
Add a Scene or Scene Group to a Category

1. Create a category in the Project Manager window.
2. Add scenes and scene groups to the category.

Add an Existing Scene or Scene Group

a. In the Scene Manager window, click and hold on the scene or scene group to be added to the category.

b. Drag the scene or scene group and drop it in the new category.

The scene or scene group appears in the category.
Add a New Scene or Scene Group to a Category

a. In the Scene Manager window, right-click on the category.
   The shortcut menu opens.

b. Choose one of the following paths from the shortcut menu:
   • New > Scene
   • New > Scene Group
   The new scene or scene group appears in the category.

For More Information on...
• creating a category, refer to the procedure “Create a Category” on page 24–2.
Delete a Category

1. Open a project in XPression.

   The project appears in the Project Manager window under the Project Group node.

2. Right-click on the Category node to be deleted.

   The shortcut menu opens.

3. Select Delete.

   The category is deleted from the Project Manager window and the Scene Manager window.
Open Multiple Projects in the Project Manager

1. In the Project Manager window, right-click on the Project Group node. The Project Group shortcut menu opens.

2. Select one of the following options:
   - Add New Project — select to open the New Project dialog box and create a new project to add to the Project Group.
   - Add Existing Project — select to open the browser and select an existing project to open in the Project Group.

   The new or existing project displays as a project node in the Project Group and opens in XPression.

3. Repeat step 1 to 2 for individual projects as needed.

For More Information on...
   - creating a new project in XPression, refer to the procedure “Create a Project” on page 4–2.
Activate a Project from a Project Group

1. Open multiple projects in XPression.
   The projects appear in the Project Manager.

2. In the Project Manager window, right-click on the Project node of the project to be activated.
   The Project shortcut menu opens.

3. Select Activate from the shortcut menu.
   The selected project is activated in the XPression Editor and Sequencer.

For More Information on...
- opening multiple projects in XPression, refer to the procedure “Open Multiple Projects in the Project Manager” on page 24–6
- creating a new project in XPression, refer to the procedure “Create a Project” on page 4–2.
Remove a Project from a Project Group

1. In the Project Manager window, right-click on the Project node of the project to be removed from the project group.
   
   The Project shortcut menu opens.

2. Select Remove Project from the shortcut menu.

   The selected project is removed from the Project Group in the Project Manager.

For More Information on...

- opening multiple projects in XPression, refer to the procedure “Open Multiple Projects in the Project Manager” on page 24–6.
Appendix A: Keyboard Shortcuts

Use the keyboard shortcuts to perform various functions in XPression.

The following topics are discussed in this section:

- Menu Shortcuts
- Toolbar Shortcuts
- Scene Manager Shortcuts
- Object Manager Shortcuts
- Text Objects Shortcuts
- Keyframe Editor Shortcuts
- Sequencer Shortcuts
- Material Manager Shortcuts
## Menu Shortcuts

<table>
<thead>
<tr>
<th>Menu</th>
<th>Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>CTRL + ALT + N</td>
<td>New project</td>
</tr>
<tr>
<td></td>
<td>CTRL + O</td>
<td>Open project</td>
</tr>
<tr>
<td></td>
<td>F9</td>
<td>Revert project</td>
</tr>
<tr>
<td></td>
<td>CTRL + S</td>
<td>Save project</td>
</tr>
<tr>
<td></td>
<td>CTRL + ALT + S</td>
<td>Save project as...</td>
</tr>
<tr>
<td></td>
<td>CTRL + SHIFT + ALT + S</td>
<td>Increment and save project</td>
</tr>
<tr>
<td>Edit</td>
<td>CTRL + Z</td>
<td>Undo</td>
</tr>
<tr>
<td></td>
<td>CTRL + SHIFT + Z</td>
<td>Redo</td>
</tr>
<tr>
<td></td>
<td>CTRL + Q</td>
<td>Select object tool</td>
</tr>
<tr>
<td></td>
<td>CTRL + W</td>
<td>Move object tool</td>
</tr>
<tr>
<td></td>
<td>CTRL + E</td>
<td>Rotate object tool</td>
</tr>
<tr>
<td></td>
<td>CTRL + R</td>
<td>Scale object tool</td>
</tr>
<tr>
<td></td>
<td>CTRL + T</td>
<td>Pivot object tool</td>
</tr>
<tr>
<td>Windows</td>
<td>F12</td>
<td>Set main viewport as active</td>
</tr>
<tr>
<td>Project</td>
<td>CTRL + ALT + E</td>
<td>Display project path in Windows Explorer</td>
</tr>
<tr>
<td>Animation</td>
<td>CTRL + SHIFT + C</td>
<td>Open Animation Controller</td>
</tr>
<tr>
<td></td>
<td>CTRL + D</td>
<td>Open Scene Director</td>
</tr>
<tr>
<td></td>
<td>CTRL + SHIFT + K</td>
<td>Open Keyframe Editor</td>
</tr>
<tr>
<td></td>
<td>CTRL + ALT + L</td>
<td>Open Clip Info window</td>
</tr>
<tr>
<td></td>
<td>CTRL + K</td>
<td>Open Set Keyframe window</td>
</tr>
<tr>
<td>Display</td>
<td>CTRL + M</td>
<td>Display Material Manager</td>
</tr>
<tr>
<td></td>
<td>CTRL + ALT + W</td>
<td>Display Widgets pane</td>
</tr>
<tr>
<td></td>
<td>CTRL + ALT + O</td>
<td>Display Object Library</td>
</tr>
<tr>
<td></td>
<td>CTRL + ALT + A</td>
<td>Display Audio Files pane</td>
</tr>
<tr>
<td></td>
<td>CTRL + ALT + B</td>
<td>Display Object toolbar</td>
</tr>
<tr>
<td>Tools</td>
<td>CTRL + SHIFT + U</td>
<td>Force engine unlock</td>
</tr>
<tr>
<td></td>
<td>CTRL + ALT + I</td>
<td>Display Input Grabber</td>
</tr>
<tr>
<td>Help</td>
<td>F1</td>
<td>Display Online Help</td>
</tr>
</tbody>
</table>

## Toolbar Shortcuts

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL + ALT + M</td>
<td>Display DataLinq Manager</td>
</tr>
</tbody>
</table>

## Scene Manager Shortcuts

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL + N</td>
<td>Create new scene</td>
</tr>
</tbody>
</table>
# Object Manager Shortcuts

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL + SHIFT + E</td>
<td>Edit script events</td>
</tr>
<tr>
<td>CTRL + SHIFT + G</td>
<td>Insert new group object</td>
</tr>
<tr>
<td>CTRL + UP ARROW</td>
<td>Move object up in object tree</td>
</tr>
<tr>
<td>CTRL + DOWN ARROW</td>
<td>Move object down in object tree</td>
</tr>
<tr>
<td>CTRL + LEFT ARROW</td>
<td>Move object left in object tree</td>
</tr>
<tr>
<td>CTRL + RIGHT ARROW</td>
<td>Move object right in object tree</td>
</tr>
<tr>
<td>CTRL + I</td>
<td>Toggle object visibility</td>
</tr>
<tr>
<td>CTRL + L</td>
<td>Lock object</td>
</tr>
<tr>
<td>F2</td>
<td>Rename object</td>
</tr>
<tr>
<td>DEL</td>
<td>Delete object</td>
</tr>
</tbody>
</table>

# Text Objects Shortcuts

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL + ALT + W</td>
<td>Word wrap</td>
</tr>
<tr>
<td>CTRL + ALT + L</td>
<td>Locked lines</td>
</tr>
<tr>
<td>CTRL + ALT + V</td>
<td>Vertical text layout</td>
</tr>
<tr>
<td>CTRL + NUMPAD +/-</td>
<td>Adjust character spacing</td>
</tr>
<tr>
<td></td>
<td>(adjusts kerning when characters are selected)</td>
</tr>
<tr>
<td>CTRL + NUMPAD +/-</td>
<td>Adjust kerning for selected characters</td>
</tr>
<tr>
<td>CTRL + ALT + UP ARROW</td>
<td>Move line up (moves single character if one is selected)</td>
</tr>
<tr>
<td>CTRL + ALT + DOWN ARROW</td>
<td>Move line down (moves single character if one is selected)</td>
</tr>
<tr>
<td>CTRL + ALT + LEFT ARROW</td>
<td>Move line left (moves single character if one is selected)</td>
</tr>
<tr>
<td>CTRL + ALT + RIGHT ARROW</td>
<td>Move line right (moves single character if one is selected)</td>
</tr>
<tr>
<td>CTRL + HOME</td>
<td>Move cursor to first character of text object</td>
</tr>
<tr>
<td>CTRL + END</td>
<td>Move cursor past last character of text object</td>
</tr>
<tr>
<td>CTRL + LEFT ARROW</td>
<td>Move cursor to previous word</td>
</tr>
<tr>
<td>CTRL + RIGHT ARROW</td>
<td>Move cursor to next word</td>
</tr>
<tr>
<td>CTRL + SHIFT + LEFT ARROW</td>
<td>Select previous word</td>
</tr>
<tr>
<td>CTRL + SHIFT + RIGHT ARROW</td>
<td>Select next word</td>
</tr>
<tr>
<td>SHIFT + HOME</td>
<td>Select to beginning of line</td>
</tr>
<tr>
<td>CTRL + SHIFT + HOME</td>
<td>Select to beginning of text object</td>
</tr>
<tr>
<td>SHIFT + END</td>
<td>Select to end of line</td>
</tr>
<tr>
<td>CTRL + SHIFT + END</td>
<td>Select to end of text object</td>
</tr>
</tbody>
</table>
### Keyframe Editor Shortcuts

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPACE</td>
<td>Play animation</td>
</tr>
<tr>
<td>CTRL + A</td>
<td>Select all keyframes</td>
</tr>
<tr>
<td>RIGHT ARROW</td>
<td>Move Time Locator forwards</td>
</tr>
<tr>
<td>LEFT ARROW</td>
<td>Move Time Locator backwards</td>
</tr>
<tr>
<td>HOME</td>
<td>Jump to first keyframe</td>
</tr>
<tr>
<td>END</td>
<td>Jump to end of animation</td>
</tr>
<tr>
<td>CTRL + RIGHT ARROW</td>
<td>Jump to next keyframe</td>
</tr>
<tr>
<td>CTRL + LEFT ARROW</td>
<td>Jump to previous keyframe</td>
</tr>
<tr>
<td>CTRL + HOME</td>
<td>Jump to first keyframe</td>
</tr>
<tr>
<td>CTRL + END</td>
<td>Jump to last keyframe</td>
</tr>
</tbody>
</table>

### Sequencer Shortcuts

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>UP ARROW</td>
<td>Select previous take item</td>
</tr>
<tr>
<td>DOWN ARROW</td>
<td>Select next take item</td>
</tr>
<tr>
<td>CTRL + UP ARROW</td>
<td>Move selected take item up the list</td>
</tr>
<tr>
<td>CTRL + DOWN ARROW</td>
<td>Move selected take item down the list</td>
</tr>
<tr>
<td>HOME</td>
<td>Select first take item</td>
</tr>
<tr>
<td>END</td>
<td>Select last take item</td>
</tr>
<tr>
<td>CTRL + PAGE UP</td>
<td>Select previous take item</td>
</tr>
<tr>
<td>CTRL + PAGE DOWN</td>
<td>Select next take item</td>
</tr>
<tr>
<td>CTRL + SHIFT + PAGE UP</td>
<td>Select previous template data field</td>
</tr>
<tr>
<td>CTRL + SHIFT + PAGE DOWN</td>
<td>Select next template data field</td>
</tr>
<tr>
<td>ALT + PAGE UP</td>
<td>Select previous scene template</td>
</tr>
<tr>
<td>ALT + PAGE DOWN</td>
<td>Select next scene template</td>
</tr>
<tr>
<td>ALT + INSERT</td>
<td>Transfers scene from take item list</td>
</tr>
<tr>
<td>ALT + DELETE</td>
<td>Removes scene from take item list</td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT + Fn KEY</td>
<td>Set selected take item online to framebuffer represented by the F{n} key</td>
</tr>
<tr>
<td>CTRL + Fn KEY</td>
<td>Remove selected take item from the framebuffer represented by the F{n} key</td>
</tr>
<tr>
<td>CTRL + SHIFT + X</td>
<td>Export selected take items to XML to be imported later</td>
</tr>
<tr>
<td>NUMPAD *</td>
<td>Scroll the Sequencer list to the currently focused item and, if applicable, expand the group containing the focused item</td>
</tr>
<tr>
<td>CTRL + I</td>
<td>Open the Insert New Take Item dialog box and create new take items based on the scene ID of the template</td>
</tr>
</tbody>
</table>

**Material Manager Shortcuts**

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL + M</td>
<td>Open Material Manager</td>
</tr>
<tr>
<td>ENTER</td>
<td>Open selected material in the Material Editor</td>
</tr>
</tbody>
</table>